Esov Software User Manual

PE-SW-ESA-GS-154 2.7.1

21 April 2025



Esov Software User Manual

Copyright © 2008 - 2025 ESA

Esov, Esov NG, ESA and the ESA logo are trademarks of the European Space Agency. Java is a trademark of Sun Microsystems,
Inc. JIDE is a trademark of JIDE Software, Inc. All other trademarks are acknowledged as the property of their respective owners.

Copyright 2006 - 2025 by the European Space Agency. All Rights Reserved. This document is subject to copyright protection.
No portion may be copied without prior written consent from the European Space Agency.

Esov utilises the JIDE Docking Framework Technology which is copyright of JIDE Software, Inc.

Copyright © 2008 - 2025 ESA



Esov Software User Manual

] COLLABORATORS
TITLE : REFERENCE
Esov Software User Manual PE-SW-ESA-GS-154
2.71
ACTION NAME DATE SIGNATURE
WRITTEN BY Ivo Carvalho 21 April 2025
REVISION HISTORY
NUMBER DATE DESCRIPTION NAME
2.71 21/04/25 Esov 2.7.1, Updates from Evolutive Maintenance |. Carvalho
Actions.
2.7.0 30/07/24 Esov 2.7.0, Updates from Evolutive Maintenance |. Carvalho
Actions.
2.6.6 04/10/23 Esov 2.6.6, Updates from Evolutive Maintenance R. Esteves, I.
Actions (CCN#20) Carvalho
2.6.5 11/05/22 Esov 2.6.5, Updates from Evolutive Maintenance H. Rosado, R.
Actions (CCN#17) Esteves, I. Carvalho
2.6.4 17/11/20 Esov 2.6.4, Updates from Evolutive Maintenance S. Saraiva, E. Lopes,
Actions (CCN#14) B. Pefia
2.6.2 15/09/20 Esov 2.6.2, Updates from Evolutive Maintenance | S. Saraiva, E. Lopes,
Actions (CCN#11) B. Pefa
253 24/05/19 Esov 2.5.3, Updates from Evolutive Maintenance J. Oliveira, E. Lopes
Actions (CCN#8)
252 31/10/18 Esov 2.5.2, Updates from Evolutive Maintenance J. Oliveira, E. Lopes
Actions (CCN#8)
25 26/09/18 Esov 2.5, Update and corrections related to final J. Oliveira, E. Lopes
delivery of Esov v2.5.0

Copyright © 2008 - 2025 ESA



Esov Software User Manual

REVISION HISTORY

NUMBER DATE DESCRIPTION NAME

2.4 11/12/16 Esov 2.4, Updates from Evolutive Maintenance R. Mestre
Actions (CCN#5)

2.3 11/12/15 Esov 2.3, Updates from Evolutive Maintenance R. Mestre
Actions (CCN#3)

2.2 20/04/15 Esov 2.2, Updates from Evolutive Maintenance R. Mestre
Actions.

2.1 30/05/14 Esov 2.1, Updates from Corrective Maintenance R. Mestre
Actions.

2.0 19/11/10 Minor corrections, version adjusted to snapshot O. Danne
version (Esov 2.0).

1.7 05/11/10 Updates and corrections related to snapshot O. Danne
delivery of Esov 2.0 from 05 Nov 2010.

1.6 17/12/09 Updates and corrections related to delivery of O. Kock
Esov 1.6.1.

1.4 28/05/09 Updates and corrections related to delivery of O. Danne
Esov 1.5.

1.3 24/10/08 Updates and corrections related to Esov 1.1. O. Danne

1.2 18/04/08 Minor updates and corrections. O. Danne

1.1 28/02/08 Minor updates and corrections after Esov FAT. O. Danne

1.0 31/01/08 Initial release. O. Danne

Copyright © 2008 - 2025 ESA



Esov Software User Manual

Contents

1 Introduction

L1 Scope . . o o e e
1.2 Acronyms and Nomenclature . . . . . . . . . . . oL L e e e e e
121 ACIONYMS . . . o o o oo e e e
122 Nomenclature . . . . . . . .. . e
1.3 Applicable Documents . . . . . . . . . L e e
1.4 Reference Documents . . . . . . . . . . .. e e e e e

2 Software Installation

2.1 Usage Requirements . . . . . . . . . . . . i it e e e e
2.1.1 General Requirements . . . . . . . . . . . . e e e e e e e e

2.1.2 Windows 7/8/10 . . . . . L e e

2.1.3  MacOS X . . o

2,14 LINUX . . .o e e e

2.2 Howto getthe Software . . . . . . . . . . e e e e
2.3 Esov Installation / Uninstall Process . . . . . . . . . . . o e
2.3.1  Windows 7/8/10 Installation . . . . . . . . . . . L

232 MacOS X Installation . . . . . . . . oL e

233 LinuxInstallation . . . . . . . . 0L e e e e

2.4 Uninstalling the Installed Software . . . . . . . . . . . . . . e
24.1 Windows 7/8/10 Uninstall . . . . . . . . . ..

242 MacOS X Uninstall . . . . . . 00 e

243 Linux Uninstall . . . . . . 0 0L 0 e e e

2.5 Overview of Files and Folder Structure . . . . . . . . . . . . . . e
2.5.1 Installation DIirectory . . . . . . . . . o i e e e e e e e e e e e e e

2.5.2  Application Directory . . . . . . . ... e e e

253 Esovdatafiletypes . . . . . . . . e
2.5.3.1 Scenario Files . . . . . . . .

2.5.3.2  Satellite Identification Files . . . . . . . . . . . . .. o

2533 SwathControl Files . . . . . . . . . o e

Copyright © 2008 - 2025 ESA



Esov Software User Manual vi
2534 Swath Definition Files . . . . . . . . . .. . . 7

2.53.5 OrbitScenario Files . . . . . . . . . . o e 7

2.5.3.6  Predicted/Restituted Orbit Files (POF/ROF) . . . . . . . . ... .. ... ... ........ 7

2.5.3.7 ZoneDatabase Files . . . . . . . . . .. 7

2.5.3.8 Station Database Files . . . . . . . . . . ... 7

2539 ZoneListFiles . . . . . . . . 7

2.5.3.10 StationListFiles . . . . . . . . o e 8

2.5.3.11 LLFFiles . . . . . e 8

2.5.3.12 UTFFiles . . . . . o 8

2.6 Getting Further Information . . . . . . . . .. Lo e 8

3 Starting Esov 9
3.1 Windows XP, Vista, 7,8, 10 . . . . . . . e 9
3.1.1 Starting the Esovexecutable . . . . . . . . . . ... 9

32 MacOS X . . o 9
3.2.1 Starting the Esov application . . . . . . . . . ... e 9

33 LANUX . . . o e e e e e 9
3.3.1 Starting the Esov application . . . . . . . . . . .. e 9

4 Basic Concepts 10
4.1 Scenario . ...l e e 10
4.2 User Interface OVerview . . . . . . . . . o . L e e 10
421 Main WIndow . . . . . . . e e 10

422 MENUS . . o v vttt e e e 11

4221 FileMenu . .. . ... 11

4222 EditMenu . . . . ... e 13

4223 ToolsMenu . . . . . . . e e e 13

4224 Window Menu . . . . . . L e e e e 14

4225 HelpMenu . . . . . . . e e e 16

423 MainToolbar . . . . . . . . e e 16

424 Toolwindows . . . . . . . e e 18

425 MapS . .. e 18

42,6 Layers. . . . ..o 19

5 Scenarios 20
5.1 Creatinga New Scenario . . . . . . . . . . o i i e e e 20
5.2 Changing a SCenario . . . . . . . . . i L e e e e 21
5.2.1 Orbit Toolwindow . . . . . . . . o L e e 21

5.2.1.1 Toolbar Elements . . . . . . . . . . . . e e 21

5.2.1.2  Orbit Panel ("Use orbit parameters’ inputmode) . . . . . . . . .. ... ... .. ....... 21

Copyright © 2008 - 2025 ESA



Esov Software User Manual vii

53
54
5.5
5.6
5.7
5.8

5.2.1.3  OSFSelection . . . . . . . . e 22
5.2.1.4 OSFFile Selection Panel . . . . . . ... ... ... 22
5.2.1.5 OSFOrbit Settings Panel . . . . . . . ... .. .. 23
5.2.1.6  POF/ROF Selection . . . . . . . . . ittt e s e e 23
5.2.1.7 POF/ROF File Selection Panel . . . . . ... ... ... ... . ... ... . ...... 23
5.2.1.8 TLE Selection . . . . . . . . . e e e e e e 23
5.2.1.9 TLEFile Selection Panel . . . . . . . ... .. . ... 23
5.2.1.10 InfoPanel . . . . . . . . . . e 23
5.2.1.11 Graphical Settings Panel . . . . . . . . .. ... 23
5.2.1.12 Orbit Validation . . . . . . . . . o L 24
5.2.2 Instruments Toolwindow . . . . . . . . . . L e e 26
5.22.1 Toolbar Elements . . . . . . . . . . .. e e e e 26
5222 SCFFile Selection . . . . . . . . e e 26
5.2.2.3 Instrument Scope Selection . . . . . . .. ... Lo e 26
5224 Apply SZA . . . 27
5.2.2.5 Apply SC Eclipse or Apply SC Daylight . . . . . ... ... ... ... ... . ....... 27
523 Zones Toolwindow . . . . . . . . . L e 27
5.23.1 Toolbar Elements . . . . . . . . . . . .. e e e 27
5232 ZoneList. . . . . .o e e 28
524 CAddZones’ Dialog . . . ... e 28
5.24.1 Toolbar Elements . . . . . . . . . . . .. e 29
5242 ZoneList. . . . . . . 29
5243 BUttonS. . . . . .o e e e 30
5.2.5 Stations Toolwindow . . . . . . . . L e e 30
5.25.1 Toolbar Elements . . . . . . . . . . .. e e e 30
5.25.2 Station List. . . . . . L e 31
5.2.6  ’Add Stations’ Dialog . . . . . .. e 31
5.2.6.1 Toolbar Elements . . . . . . . . . . e e e e 31
5.2.62 Station List. . . . . . ... e 32
5.2.63 Buttons. . . . . ..o e 32
5.2.7 Sub-Satellite Point Toolwindow . . . . . . . . . . . ... e 32
5.277.1 Toolbar Elements . . . . . . . . . . . . e e 32
5.27.2  SSPSelection . . . . . . . . e e 33
5.277.3 SSPTime Selection . . . . . . . .. . .. 33
Opening a SCeNArio . . . . . . . . o v v e e e e 33
Saving a Scenario . . . . . ..o e e e e e 34
Closing a Scenario . . . . . . . . i i e e e e e e e e e e e 35
Merging SCENATIOS . . . . o o v v it e e e e e e e e e e e e e e e 36
SCF Logical Operations . . . . . . . . v v v v v e e e e e e e e e e e e e e e e e e e 36
Shapefile to Zones . . . . . . . . . . . L e 36

Copyright © 2008 - 2025 ESA



Esov Software User Manual viii
6 Maps 37
6.1 ChangingaMap . . . . . . . . o e e e e e 37
6.1.1 Map Toolwindow . . . . . . . . o e 37
6.1.1.1 Toolbar Elements . . . . . . . . . . . . .. . e 38

6.1.1.2  Rectangular Projection . . . . . . . . .. .. 38

6.1.1.3  Azimuthal Projection . . . . . . . . .. ... 39

6.1.1.4 Gnomonic Projection . . . . . . . . . L. e e e 40

6.1.1.5 Map Settings Validation . . . . . . . . ... 41

6.1.1.6 Map Legend Settings Panel . . . . . . .. ... ... 42

6.1.2  MapToolS . . . . o e 43
6.1.2.1  ZoomTool . . . . . . . . e 43

6.1.2.1.1  Rectangular Projection . . . . . . .. .. .. ... .. ... e 43

6.1.2.1.2  Azimuthal/Gnomonic Projection . . . . . . . .. .. ... ... ... 45

6.1.2.2  Rotation . . . . . . . .. e e 45

6.1.2.3  Center . . . . ... e e e 46

6.1.2.4 WorldDisplay . . . . . . . .. 46

6.1.2.5 Compute Distance . . . . . . . . . . e e e e e e e 46

6.2 Opening Multiple Maps . . . . . . . . . . e e 47
6.3 PrintingaMap . . . . . . L e e e e e 47
7 Layer Management 48
7.1 The Layer Manager Toolwindow . . . . . . . . . . . . . . e 48
7.1.1 Toolbar Elements . . . . . . . . . . . . e e e e e e 48

7.1.2  Layer Manager Tree . . . . . . . . o i it e e e e e e e e e e e e e e e 49
7.1.2.1 Geographical Layers Tree . . . . . . . . . . . . .. . 49

7.1.22 Instruments Tree . . . . . . . . . L e 52

7.1.23  UserShapes Tree . . . . . . . . o o o i e e 53

7.1.2.4  User Background Images Tree . . . . . . . .. .. ... ... . ... .. ... 53

7.2 The Segments Toolwindow . . . . . . . . . . . e e e e e e e e e e 54
7.2.1  Segments Table . . . . . . . .. 55

7.3 The Style Toolwindow . . . . . . . . o L e e e e e e e e e 56
7.3.1 Toolbar Elements . . . . . . . . . . e e 56

7.3.2 Style EAitors . . . . . . L e e e e 57
7.3.2.1 Default Style Editor . . . . . . . .. L 57

7.3.2.2  Shoreline Style Editor . . . . . . . . ... 57

7.3.23 GridStyle Editor. . . . . ... 58

7.324 Zone Style Editor . . . . . .. 59

7.3.2.5 Station Style Editor . . . . . . . .. e 60

7.3.2.6  Station Perimeter Style Editor . . . . . . . . ... L o 61

7.3.277 Swath Style Editor . . . . . . . .. 62

Copyright © 2008 - 2025 ESA



Esov Software User Manual

8 Tools

8.1 Azimuth / Elevation 2D Plot

8.1.1

8.1.2

8.2 Merging scenarios

8.2.1

8.2.2

8.3 SCF Logical Operations

8.4  Shapefile to Zone transformation

The Location Selectiondialog . . . . . ... ... ... ... ........

8.1.1.1 Toolbar Elements . . ... ... ..................
8.1.1.2  Location Selection Panel . . . .. ... ... .. ... ......
The Azimuth / Elevation 2D Plotdialog . . . . . .. ... ... ... ....
8.1.2.1 Toolbar Elements . . . ... ... ... .. ... .. ......
8.1.2.2 GraphicsPanel . . . . .. ... ... oo
8.1.2.3 NavigationPanel . . . . . ... .. ... ... .. ...

8.1.24 Segmentsresultstable . . . . .. ... ... ... 0oL L.
8.1.2.5 ExportSegments . . . . . . .. .. .. ...

The Scenario Selection dialog . . . . . . . ... .. ... ... .......

8.2.1.1 ToolbarElements . . . . . ... .. .. ... .. ... ......
8.2.1.2  Scenario SelectionPanel . . . ... ... ... ... .......
The Time Control Toolwindow . . . . . . . . .. . ... . ... .......

8.2.2.1 Toolbar Elements . . . . ... ... ... ... ... ......
8.2.2.2 Time Interval Settings Panel . . . . . . ... ... ... ......

9 Zone Databases

9.1 What is a Zone Database?
9.2 Zone Database Editor

9.2.1
922
9.23
9.24
9.2.5
9.2.6

Database Selection Panel . . . . . ... ... ... ... .. L.
Zone ListPanel . . . . . . ... ...
Zone Definition Panel . . . . . .. ... oL oo
Editor Elements . . . . . . . . . . . ...
Zone Validation . . . . . . . ...

ButtonPanel . . . ... ... . ... ...

10 Station Databases

10.1 What is a Station Database?
10.2 Station Database Editor

10.2.1
10.2.2
10.2.3
10.2.4
10.2.5
10.2.6

Database Selection Panel . . . . . ... ... ... ... ... ... ... ..
Station List Panel . . . . . . .. ... ..
Station Definition Panel . . . . . . .. ... .. ... 0oL
Editor Elements . . . . . . . . . . ...
Station Validation . . . . . . . . . . ...

Button Panel . . . . . . . .. ...

65
65
65
66
66
68
69
69
71
72
73
73
74
74
74
75
76
76
76
77

79
79
79
80
81
82
85
86
89

Copyright © 2008 - 2025 ESA



Esov Software User Manual

11 Data Export/Import
11.1 Export of Segments . . . . . . ..
11.1.1 SCFExport . . ... ...
11.1.2 LLFExport . . ... ...
11.1.3 UTFExport . . . . .. ..
11.1.4 KML Export . ... ...

11.1.5 Importing CSVdatato Excel . . . . . . . . . . . . e

11.2 Export of Map Images . . . . ..
11.2.1 PDFExport . . ... ...
11.2.2 GIFExport . .. ... ..
11.2.3 PNGExport. . . ... ..

11.3 Import of datafiles . . ... ...
11.3.1 Shapefiles Import . . . . .

11.3.2 Points of Interest Files Import . . . . . . . . . . . . e

11.3.3 Sub Satellite Points File Import . . . . . . . . . . ..

12 User Preferences
12.1 Toolbar Elements . . . . ... ..
12.2 Scenario File Settings . . . . . . .
12.3 Swath Export Settings . . . . . . .
12.4 Zoom Settings . . . . . . ... ..

13 An Example for a ’Common Use Case’

14 Application Layout

14.1 Toolwindow Arrangement . . . .
14.1.1 Toolwindow Modes . . . .
14.1.1.1 Autohide Mode

14.1.1.2 Docked Mode .

14.1.1.3 Floating Mode .

14.1.1.4 Closed Mode . .

14.2 Loading and saving Layouts . . .
14.2.1 Default Layout . . . . ..
14.2.2 Saving aLayout . .. ..
14.2.3 Loading a Layout . . . . .
143 LookandFeel . . . . . ... ...

15 Help System
15.1 OnlineHelp . . ... ... ....
15.2 About’ Dialog . . ... ... ..

98

98

98

99
100
101
102
102
102
103
104
105
105
106
107

108
108
108
109
109

110

113
113
113
113
114
115
116
116
116
117
118
119

Copyright © 2008 - 2025 ESA



Esov Software User Manual Xi

16 Stopping Esov 123
17 Updating Esov 124
17.1 Update OptionS . . . . . . o o vt it e e e e e e e e e e e e e e 124
17.1.1 Updating when starting Esov . . . . . . . . . . . oL 124

17.1.2 Updating from Helpmenu . . . . . . . . . . .. e 127

17.1.3 Updating from Helpmenu . . . . . . . . ... 0 L 127

18 Hints and Tips 128
18.1 General ESoVNG Tips . . . . . . . . . . 128

19 Appendix 129
19.1 Adding anew spacecraft to Esov . . . . . . . . ... o e 129
19.2 Command Line Interface . . . . . . . . . . . . . 129
19.3 Examples of standard filesused by Esov . . . . . . . . . .. e 130
193.1 ScenarioFile . . . . . . . . . . o e 130

19.3.2 Satellite Identification File . . . . . . . . . . . . oL 132

19.3.3 SwathControl File . . . . . . . . . . . 133

19.34 SwathDefinitionFile . . . . . . . . ... 135

19.3.5 Orbit Scenario File . . . . . . . . . . . e 135

19.3.6 Predicted Orbit File (POF) . . . . . . . . . . . e 135

19.3.7 Restituted Orbit File (ROF) . . . . . . . . . . 135

193.8 Zone Database File . . . . . . . . . . . ... e 135

1939 Station Database File . . . . . . . . . . . . 135
19.3.10Zone ListFile . . . . . . . . o 0 135

19311 Station List File . . . . . . . . 0000 136
193.12LLF File . . . . o o e e e 137
193.13UTFFile . . . . . o 142

19.4 Software used in ESOV-NG . . . . . . . . ... e 144

Copyright © 2008 - 2025 ESA



Esov Software User Manual Xii

List of Figures

4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8
4.9

5.1
52
53
54
55
5.6
5.7
5.8
59
5.10
5.11
5.12
5.13
5.14
5.15
5.16
5.17
5.18
5.19
5.20

Main Window . . . . . . L e e e 11
File Menu . . . . . . . o e 11
Exit Dialog . . . . . . e e e e e e 13
EditMenu . . . . . . . . e e 13
Tools Menu . . . . . . . L e e e e e 13
Window Menu . . . . . .. e 14
HelpMenu . . . . . . e e e 16
Main Toolbar . . . . . . . o e e 16
Toolwindows arranged as dockable components (example) . . . . . . . . .. .. ... Lo 18
’Create New Scenario’ dialog for spacecraft selection . . . . . . . . ... ... . ... ... 20
New scenario in default layout . . . . . . . . . . . .. 21
Orbit Toolwindow . . . . . . . . L L e e 22
Invalid orbit definitions . . . . . . . . . L e 25
Orbit Settings Validation Dialog . . . . . . . . . . . . e 25
Instruments Toolwindow . . . . . . . . . 26
Zones Toolwindow . . . . . . .. e e e 27
Zones Toolwindow Toolbar . . . . . . . . . . . L e e e 28
AddZones Dialog . . . . . . . . 29
Add Zones Dialog Toolbar . . . . . . . . . . . e e e e e 29
Stations Toolwindow . . . . . . . . . L e 30
Stations Toolwindow Toolbar . . . . . . . . . . . . . e 30
Add Stations Dialog . . . . . . . L e 31
Add Stations Dialog Toolbar . . . . . . . . . . . . e e e e e e 32
SSP Toolwindow . . . . . . . o e e e e e e 32
Openscenariodialog . . . . . . . . . 33
Opened scenario TAEOLUS’ . . . . . . . L . e e e e e 34
Save scenario dialog . . . . . L L L e e e e e 35
Save scenario confirmation dialog . . . . . . . . L. L e 35
Close scenario confirmation dialog . . . . . . . . . . . . L 35

Copyright © 2008 - 2025 ESA



Esov Software User Manual xiii

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8
6.9
6.10
6.11
6.12
6.13

7.1
7.2
7.3
7.4
7.5
7.6
1.7
7.8
7.9
7.10
7.11
7.12
7.13
7.14
7.15
7.16
7.17
7.18
7.19
7.20
7.21
7.22
7.23
7.24
7.25

Map Toolwindow . . . . . . . . . L e 38
Rectangular Projection Panel in the Map Toolwindow . . . . . . . . . . .. .. ... ... ... ... ..... 39
Azimuthal Projection with default settings . . . . . . . . . . . . ... 40
Azimuthal and Gnomonic Projection Panel in the Map Toolwindow . . . . . . ... ... ... ... ...... 40
Gnomonic Projection with default settings . . . . . . . . . . . . L e e 41
Invalid map definitions . . . . . . . . . 42
Map Legend Settings Panel . . . . . . . . . ... e 42
Zoomed map after clicking lat/lon point (0,0) in the initial map. . . . . . . . . ... ... ... oL 44
Dragged areatobe zoomed in. . . . . . . . . ... L e 44
Zoomed map after the drag shown in the figure above. . . . . . . . . . ... L L L L 45
Azimuthal projection after clockwise rotation by 60deg. . . . . . . . . . ... L 46
Create a new map within the same scenario . . . . . . . . . . . . . ... 47
The currently active map is shown in the Map View ("Map 2" in thisexample) . . . . . . . ... ... ... ... 47
Layer Manager Toolwindow . . . . . . . . . . o L e e e e e 48
Layer Manager Toolwindow Toolbar . . . . . . . . . . . .. e 49
Layer Manager Toolwindow with collapsed Layer Manager Tree . . . . . . . . ... . ... ... ........ 49
Esov map with *Background Image’ layer shown, all other layers hidden. . . . . .. ... ... ... .. .... 50
As first figure, but *Shore Lines / Political Borders’ layer also shown. . . . . . . ... .. ... ... .. .... 50
As previous figure, but *Grid’ layer alsoshown. . . . . . . .. ... oo oo 51
As previous figure, but 'Zones’ layer also shown (’Africa’ asexample). . . ... ... ... ... ... ..... 51
As previous figure, but *Stations’ layer also shown ("Hyderabad’ as example). . . . . . .. ... ... .. .... 52
Esov map with all layers shown. See text for details. . . . . . . ... ... ... ... ... . ... 53
Segments Toolwindow. No instrument selected. . . . . . . . . . . . . . . . . e 54
Segments Toolwindow with filled table (instrument MERIS selected). . . . . . . ... . ... ... ... .... 55
Segments Toolwindow: Visibility toggle - second segment hidden. . . . . .. . . ... ... ... ... ..... 56
Style Toolwindow . . . . . . . . o L e e e 56
Style Toolwindow Toolbar . . . . . . . . . . .. e 56
Style Toolwindow: Color Editor . . . . . . . . . . . . e e e e e 57
Style Toolwindow: Color Editor with option to define more colors . . . . . . . . ... ... .. ... .. .... 58
Style Editor for Shorelines / Political Borders . . . . . . . . . . .. . ... L 58
Grid Style Editor: Resolution Selection . . . . . . . . . . . . . e e e 59
Grid Style Editor: Style Selection . . . . . . . . .. L 59
Grid Style Editor: Label Option Selection . . . . . . . . . . . . . . e 59
Grid Style Editor . . . . . . . . e 59
Zone Style Editor . . . . . . . L L e 60
Station Style Editor: Style Selection . . . . . . . . . . .. e e 61
Station Style Editor . . . . . . . . L e 61
Station Perimeter Style Editor . . . . . . . . . L e 62

Copyright © 2008 - 2025 ESA



Esov Software User Manual Xiv

7.26
7.27
7.28
7.29
7.30
7.31

8.1
8.2
8.3
8.4
8.5
8.6
8.7
8.8
8.9
8.10
8.11
8.12
8.13
8.14
8.15
8.16
8.17
8.18
8.19
8.20

9.1
9.2
9.3
94
9.5
9.6
9.7
9.8
9.9
9.10
9.11

Showing a station’s topocentric elevation in steps of 30deg. . . . . . . . . . . ... 62
Station Style Editor: Style Selection . . . . . . . . . ... 63
Station Style Editor: Style Selection . . . . . . . ... ... 63
Swath Style Editor . . . . . . . . e e e 63
Segments Toolwindow: Individual Color Selection . . . . . . . . . . . ... ... 63
MERIS Swaths with individual colors . . . . . . . . . . . e 64
’Azimuth / Elevation 2D Plot...” entry in *Tools’ menu . . . . . . . . ... .. L 65
Selection dialog for the location for azimuth/elevation plot . . . . . . . . ... ... ... L. 66
Selection dialog for the location for azimuth/elevation plot: graphical editing mode active . . . . . . .. ... .. 67
Selection dialog for the location for azimuth/elevation plot: Invalid longitude coordinate . . . . . ... ... .. 67
Selection for the location for azimuth/elevation plot: Validation Info dialog . . . . . . ... .. ... ... ... 68
Azimuth / Elevation 2D Plotdialog . . . . . . . . . . . . . e 68
Plotcustomize menu . . . . . . . L e e e e e 69
Dragged zoom selection rectangle . . . . . . . ... .o 70
Zoomselectionresult . . . . ... e e 70
*Chart Properties” dialog . . . . . . . . . L e e 71
Zoom options submenu in Plot settings menu . . . . . ... ... Lo 71
Colour editor for azimuth/elevation curves . . . . . . . . .. ... Lo o 72
No segments to be displayed in Azimuth / Elevation2DPlot . . . . . . ... . ... ... . ... ... ..... 73
’Merge Scenarios’ in Toolsmenu . . . . . . . . . oL 74
Selection dialog for merging SCeNarios . . . . . . . . . . . ..t e i e e e e e e e e e e 74
Info dialog: scenarios to be merged not selected . . . . . . . . . ... L 75
Window displaying a merged scenario for the spacecrafts ENVISAT, CRYOSAT and ADM . . . . ... ... .. 75
Time Control Toolwindow . . . . . . . . . . . . L 76
SCF logical operations dialog . . . . . . . . . . . o L e e e e 77
Shapefile to Zones tool dialog . . . . . . . . . L e e e e e 77
Zone Database Editor . . . . . . . . . . 80
Zone Database Selection Panel . . . . . . . .. .. L 81
Error dialog: Wrong database type . . . . . . . . . .. 81
Zone List Panel . . . . . . . . . e 81
Zone Definition Panel . . . . . . . ..o 82
Creating a circular zone in ’graphical editing’ mode. . . . . . . . . . .. ... o Lo o 83
Circular zone created in "graphical editing’ mode. . . . . . . . . . . ... 84
Polygon zone created in ’graphical editing’ mode. . . . . . . ... ..o 85
Delete Zone Confirmation Dialog . . . . . . . . . . . . e e 86
Buttons 'Insert New Zone’, ’Delete Selected Zone’ and ’Edit Selected Zone’ (from left toright) . . . . ... .. 86
Buttons "Clear Zone Fields’, ’Save Zone Changes’ and ’Cancel Zone Changes’ (from left toright) . . . . . . .. 86

Copyright © 2008 - 2025 ESA



Esov Software User Manual XV

9.12 Invalid zone definition: ID and Description missing, polygon has less than 3 points . . . . . . . ... ... ... 87
9.13 Zone validation dialog . . . . . . .. L. e e 87
9.14 Invalid circular zone definition: Center Longitude and Diameter outofrange . . . . . . . . . . . ... ... ... 88
9.15 Zone validation dialog . . . . . . . ... e 88
9.16 Polygon pointinvalid (outofrange) . . . . . . . . . . . L e 88
9.17 Invalid degree value dialog . . . . . . . . . . . . e e e e e 88
9.18 Invalid polygon (self-intersecting due to the latitude value inpoint4) . . . . . . . . . .. ... ... ... .... 89
9.19 Zone validation dialog . . . . . . . .. e 89
9.20 Zone Database Editor Button Panel . . . . . . . . . . ... 89
10.1 Station Database Editor . . . . . . . . . . . L e 91
10.2 Station Database Selection Panel . . . . . . . . . . .. L 91
10.3 Error dialog: Wrong database type . . . . . . . . . o i e e e e e e e e e 92
10.4 Station List Panel . . . . . . . . . . o e 92
10.5 Station Perimeters: Example for setting ’AOS/LOS with Mask’™ . . . . . . . ... ... . . ... .. .. ... 93
10.6 Station Perimeters: Example for setting "Mask only’” . . . . . . . . . ... .. e 93
10.7 Station Definition Panel . . . . . . . . . . . o e 94
10.8 Delete Station Confirmation Dialog . . . . . . . . . . . . e 95
10.9 Buttons 'Delete Selected Station’ and "Edit Selected Station’ (from lefttoright) . . . . . . ... ... ... ... 95
10.10Buttons ’Clear Station Fields’, *Save Station Changes’ and ’Cancel Station Changes’ (from left to right) . . . . . 95
10.111Invalid station definition: ID and Description missing . . . . . . . . . . . . oo vt i e e e 95
10.12Station validation dialog . . . . . . . . . L e 96
10.13Invalid AOS/LOS definitions: AOS >90deg., LOSempty . . . . . . . . . . . .. ... 96
10.14Station validation dialog . . . . . . . ... e e e e 96
10.15Invalid: LOS > AOS . . . . . L 96
10.16Station validation dialog . . . . . . . .. L e e e 97
10.17Station Database Editor Button Panel . . . . . . . . . . .. . L 97
11.1 Save SCEDialog . . . . . . . o o e 99
11.2 Save SCF Confirmation Dialog . . . . . . . . . . . . . . e 99
11.3 Save LLE Dialog . . . . . . . . . o e e 100
11.4 Save LLF Confirmation Dialog . . . . . . . . . . . . . . e 100
11.5 Save UTEDIalog . . . . . . o o e e e e e e e e e e e e e e e e 101
11.6 Save UTF Confirmation Dialog . . . . . . . . . . . . . . e e e e 101
11.7 Save KML Dialog . . . . . . . . . . e 102
11.8 Save PDF File Dialog . . . . . . . . . . . . e e 103
11.9 Save PDF File Confirmation Dialog . . . . . . . . . . . . e e e e 103
11.10Save GIF File Dialog . . . . . . . . . . e 104
11.11Save GIF File Confirmation Dialog . . . . . . . . . . . . . e 104

Copyright © 2008 - 2025 ESA



Esov Software User Manual XVi

11.12Save PNG File Dialog . . . . . . . . . . . e 105
11.13Save PNG File Confirmation Dialog . . . . . . . . . . .. o e 105
11.14Import Shapefile chooser Dialog . . . . . . . . . . . . . e 106
11.15Import Points of Interest chooser Dialog . . . . . . . . . . . ... .. L 106
11.16Sub-Satellite Points File chooser Dialog . . . . . . . . . . . . . e 107
12.1 User Preferences Dialog . . . . . . . . . . . . . L e 108
12.2 Zoom with crosshair cursor: purple lines are the crosshaircursor . . . . . . .. ... ... ... . ... ... 109
13.1 ’Common Use Case’ scenario. See text fordetails. . . . . . . . . . . ... .. 112
14.1 Toolwindows in Autohide mode on left main frameedge. . . . . . . . . . . .. .. ... ... . ... ... 114
14.2 Layer Manager Toolwindow shown in Autohide mode. . . . . . . . . . . . ... . ... ... ... ....... 114
14.3 Title bar buttons of a toolwindow shown in autohidemode. . . . . . . ... ... ... ... .. ......... 114
14.4 Layer Manager Toolwindow shown in docked mode. . . . . . . . . . ... .. ... ... . ... ... 115
14.5 Title bar buttons of a toolwindow shown indocked mode. . . . . . . . ... ... . ... ... ... ... ... 115
14.6 Layer Manager Toolwindow shown in floating mode. . . . . . . . . . . . ... ... ... ... 115
14.7 Title bar buttons of a toolwindow shown in floatingmode. . . . . . . . . . .. ... ... ... . ... ..., 116
14.8 Esov with default layout . . . . . . . . . . e e e e 117
14.9 Savelayoutdialog . . . . . . . . . .. 118
14.10Save layout confirmation dialog . . . . . . . . . L. e e 118
14.110pen scenario dialog . . . . . . . . . L e e e e e e e 119
14.12Look and Feel Submenu . . . . . . . . . . o e 120
15.1 EsovOnline Help . . . . . . . . 0 e e 121
15.2 About’ Dialog . . . . . .. e e e 122
16.1 Exitconfirmation dialog . . . . . . . . . . L e e e 123
17.1 Esov version check dialog . . . . . . . . . . . . e e e e 124
17.2 Esovupdater dialog . . . . . . . . .. e e e e e 125
17.3 Esov update: new version available . . . . . . . . . .. L L 125
17.4 Esov update: downloading new Version . . . . . . . . . . . ottt e e e e e 126
17.5 Esov update: download finished . . . . . . . . . . . . e 126
17.6 Esov update: latest versionisused . . . . . . . . ... L. L e 127
17.7 Listof missions tobe updated. . . . . . . . . . .. L 127
17.8 Listof missions tobe updated. . . . . . . . . . .. L 127

Copyright © 2008 - 2025 ESA



Esov Software User Manual

1/145

Chapter 1

Introduction

1.1 Scope

This document is the software user manual (SUM) for the Esov software.

1.2 Acronyms and Nomenclature

1.2.1 Acronyms

e ADD - Architecture Design Document
* CFI - Customer Furnished Item

* DME - Deimos Engenharia

* EOCFI - Earth Observation CFI

* ESA - European Space Agency

* ESTEC - European Space Technology and Research Centre
¢ IDF - (Satellite) Identification File

* KML - Keyhole Markup Language

* OSF - Orbit Scenario File

* POF - Predicted Orbit File

* ROF - Restituted Orbit File

* TLE - Two-line element

* SCF - Swath Control File

* SDF - Swath Definition File

* SLF - Station List File

* STP - Software Test Plan

e SUM - Software User Manual

e ZLF - Zone List File
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1.2.2 Nomenclature

1.3 Applicable Documents

* [ADD] Esov Architectural Design Document. Issue 1.0, 02/21/2008.
e [STP] Esov Software Test Plan. Issue 1.0, 02/21/2008.

1.4 Reference Documents

* [CFI] EO CFI SW Data Handling User Manual (Ref. EO-MA-DMS-GS-0007). Issue 4.22.
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Chapter 2

Software Installation

This section describes how to get, install and start the EsovNG software. It also describes the folder structure and files available

after a successful installation.

2.1 Usage Requirements

The software is a Java program. Currently, it will run on the platforms Windows 7/8/10, Mac OS X and Linux for 64-bit.

2.1.1 General Requirements

The software requires:

* a 1.7 version of the Java Development Kit (JDK) (included in the Esov software for Windows and Mac OS X).

* 150+ Mb of hard disk space
* 512+ Mb RAM

2.1.2 Windows 7/8/10

The software requirements are:

* Microsoft Windows 7/8/10

The display hardware requirements are:

 at least 1024 X 786 resolution is advised

e at least 16-bits colours are advised

213 Mac OS X

The software requirements are:

* Mac OS X 10.7 or above

The display hardware requirements are:

e at least 1024 X 786 resolution is advised
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2.1.4 Linux

The software will run on common Linux distributions fulfilling the general requirements listed above.

The display hardware requirements are:

e at least 1024 X 786 resolution is advised

2.2 How to get the Software

The EsovNG software is distributed by ESA through the World Wide Web (WWW). Using a web browser go to the page:
http://eop-cfi.esa.int/index.php/applications/esov/

Following the instructions given on the page, and you will be able to save the distribution file on your local disk.

An EsovNG distribution consists of one single installer file for the specific operating system:

¢ Windows 64-bit: EsovNG_windows-x64_X_X.exe
* Mac OS X 64-bit: EsovNG_macintel64_X_X.dmg
e Linux 64-bit: EsovNG_linux64_X_X.sh

These installers contain all files as described later on in Section 2.5.

2.3 Esov Installation / Uninstall Process

The installation and uninstall of Esov is very simple. Installation and uninstall will basically be guided through an Install4j
installation wizard.

2.3.1 Windows 7/8/10 Installation

On Windows, simply run the executable installer ’EsovNG_windows-x64_X_X.exe’. An installation wizard will then guide you
through the rest of the installation process.

2.3.2 Mac OS X Installation
On Mac OS X, first unpack the dmg package ’EsovNG_macintel64_X_X.dmg’ by double-clicking it in a Finder window. A new

Finder window will be opened, showing the installer ’Esov Installer’. Double-click this installer. An installation wizard will then
guide you through the rest of the installation process.

2.3.3 Linux Installation

On Linux, simply run the shell script ’EsovNG_linux64_X_X.sh’. An installation wizard will then guide you through the rest of
the installation process.

2.4 Uninstalling the Installed Software

2.4.1 Windows 7/8/10 Uninstall

On Windows, simply run the executable ’uninstall.exe’ in the directory Esov was formerly installed. An installation wizard will
then guide you through the rest of the uninstall process.
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2.4.2 Mac OS X Uninstall

On Mac OS X, double-click the file ’Esov Uninstaller’ in a Finder window in the directory Esov was formerly installed. An
installation wizard will then guide you through the rest of the uninstall process.

2.4.3 Linux Uninstall

On Linux, simply run the shell script *uninstall.sh’ in the directory Esov was formerly installed. An installation wizard will then
guide you through the rest of the uninstall process.

2.5 Overview of Files and Folder Structure

2.5.1 Installation Directory

The Esov installation directory (chosen during the installation process) consists of the following files and subfolders:

* ’instrument_swath’ : subfolder containing one further subfolder per defined spacecraft. These spacecraft-specific sub-subfolders
each contain a satellite identification file (.idf), and a swath definition file per instrument.

Note that this subfolder (as all the other ones in the installation directory) is removed and re-installed every time the Esov
application is re-installed or updated. This means that new spacecrafts (satellite identification and swath definition files) should
not be added manually to this folder by the user (although possible in principie). For this purpose, a dedicated subfolder in the
Application directory is foreseen (see below).

* ’orbit_scenario_files’ : subfolder containing one further subfolder per defined spacecraft. These spacecraft-specific sub-
subfolders each contain default orbit files (pre-loadable by the application).

Note that this subfolder (as all the other ones in the installation directory) is removed and re-installed every time the Esov
application is re-installed or updated. This means that new spacecrafts (satellite identification and swath definition files) should
not be added manually to this folder by the user (although possible in principie).

* ’lib’ : subfolder with all jar archives used by the application.

* ’resources/geodata/background’ : subfolder containing background image files (one .jpg with an image itself, and a world file
(-wld) with image information).

* ’resources/geodata/shapes’ : subfolder containing shape files to build up a layer with shorelines and political borders.
* application executable : file to start the application:

— Windows: ’esovng.exe’
— Mac OS X: ’esovng.app’

— Linux: ’esovng.sh’
* uninstaller file : file to uninstall the application:

— Windows: ’esovng.exe’
— Mac OS X: ’esovng.app’

— Linux: ’esovng.sh’
e "LICENSE.TXT" : file containing license information.
* ‘readme.html’ : a readme file.

* ’.install4j’ : folder created by the installer (not used by Esov).
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2.5.2 Application Directory

The Esov application directory is meant to contain specific data wich is maintained and created by the application (e.g., zone/s-
tation databases, layout data, scenario files or swath control files). The location of this directory is platform dependent:

* Windows 7/8/10: *C:/Users/username/AppData/Roaming/Esov’
* Mac OS X: ’/Users/username/Library/Application Support/Esov’

e Linux: ’/home/username/.esovng’

After Esov has been launched for the first time, this folder contains a subfolder 'user_instrument_swath’, in which new space-
crafts can be added by the user, following the file conventions as for the subfolder *instrument_swath’ in the installation directory.
At startup, Esov will automatically search for spacecrafts in this folder as well. In this way, user-defined spacecrafts will not be
lost if Esov is re-installed or updated.

Furthermore, this folder contains a subfolder "tmp’ in which internal data used by the application is stored. This folder is deleted
and re-created every time the application is started, therefore, the user should not store relevant data there. However, the user is
free to create own subfolders in the application directory to structure his data as he/she likes.

NOTE: in Mac OS X and Windows the above listed folders are by default hidden to the users. To make these folders visible:

e Mac OS X 10.7 (Lion) and 10.8 (Mountain Lion): Make the user Library folder permanently visible by changing the hidden’
flag’ using Terminal:
1. Launch Terminal.app (from User account)
2. 2. Type the command: chflags nohidden ~/Library
3. Press return
* Mac OS X 10.9 (Mavericks) and 10.10 (Yosemite): Make the user Library folder permanently visible by changing the settings
using Finder:
1. Open the user home folder (/Users/username) in the Finder
2. Select View --> Show View Options
3. Enable the option Show Library Folder

4. Close the View Options window
* Windows 7, 8, 10 : Make the AppData folder visible by changing the settings using Windows Explorer:

Go to Windows Explorer to open a window showing the file system

Select Computer --> OSDisk (C:)

Click ’Organize’ on the window menu bar

Select *Folder and search options’

Select the *View’ tab

Under Hidden files and folders, select the option Show hidden files, folders, and drives’
Click ’Apply’ and "OK’

NNk » =

2.5.3 Esov data file types

2.5.3.1 Scenario Files

A Scenario File is the physical instance of an Esov scenario (see Chapter 5). This file follows ESA’s Earth Observation File XML
standard. It has the extension ’.xml’. An example listing for a Scenario File can be found in Section 19.3.1
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2.5.3.2 Satellite Identification Files

A Satellite Identification File contains the default settings to identify a satellite. This file follows ESA’s Earth Observation File
XML standard. It has the extension ’.idf’. An example listing for a Satellite Identification can be found in Section 19.3.2

2.5.3.3 Swath Control Files
A Swath Control File (also known as a Mission Timelines File) contains time segments which allow to recompute spatial satellite

swaths with Esov. This file follows ESA’s Earth Observation File XML standard. It has the extension *.scf’. An example listing
for a Swath Control File can be found in Section 19.3.3, see also Section 11.1.1

2.5.3.4 Swath Definition Files
A Swath Definition File contains the information for the instrument-specific definition of a swath (e.g., ’point swath’ type, ’line

swath’ type etc.). This file follows ESA’s Earth Observation File XML standard. The file extension is mission-dependent (set in
the IDF). An example listing for a Swath Definition File can be found in Section 19.3.4

2.5.3.5 Orbit Scenario Files

A Orbit Scenario File contains information about the specific orbit of a satellite (i.e., orbit changes). This file follows ESA’s
Earth Observation File XML standard. An example listing for a Orbit Scenario File can be found in Section 19.3.5

2.5.3.6 Predicted/Restituted Orbit Files (POF/ROF)

Predicted/Restituted Orbit Files (POF/ROF) provide orbit information in a different way. From the point of view of the imple-
mentation in Esov, the main differences between the OSF and POF/ROF are the following:

 the POF/ROF have limited validity while the OSF is valid from a given time onwards

* in the case of a POF/ROF, the relevant information to be displayed in the Info panel of the Orbit toolwindow will be the
start/stop validity times and their corresponding start/stop orbit numbers

These files also follow ESA’s Earth Observation File XML standard. Example listings for a POF and a ROF can be found in
Section 19.3.6 and Section 19.3.7, respectively.

2.5.3.7 Zone Database Files

A Zone Database File contains information on zones (e.g., their polygon points) which can be used by Esov. This file follows
ESA’s Earth Observation File XML standard. An example listing for a Zone Database File can be found in Section 19.3.8

2.5.3.8 Station Database Files

A Station Database File contains information on stations (e.g., their location) which can be used by Esov. This file follows ESA’s
Earth Observation File XML standard. An example listing for a Station Database File can be found in Section 19.3.9

2.5.3.9 Zone List Files

A Zone List File contains a simple list of zones represented by their ID. This list can be used by Esov to restore a set of zones
formerly defined by the user. This file follows ESA’s Earth Observation File XML standard. It has the extension ’.zIf’. An
example listing for a Zone List File can be found in Section 19.3.10
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2.5.3.10 Station List Files

A Station List File contains a simple list of stations represented by their ID. This list can be used by Esov to restore a set of
stations formerly defined by the user. This file follows ESA’s Earth Observation File XML standard. It has the extension ’.slf’.
An example listing for a Station List File can be found in Section 19.3.11

2.5.3.11 LLF Files

A latitude/longitude file (LLF) contains the latitude/longitude information for all distinct points of a segment (start/stop as well
as intermediate points). LLF files can be stored in the three formats XML, CSV and ASCII. Example listings for LLF Files in all
these formats can be found in Section 19.3.12, see also Section 11.1.2

2.5.3.12 UTF Files

A UTF file contains the time information (time_from_anx and UTC) for the start and stop points of a segment. UTF files can
be stored in the three formats XML, CSV and ASCII. Example listings for UTF Files in all these formats can be found in
Section 19.3.13, see also Section 11.1.3

2.6 Getting Further Information

For more information, please contact:

* esov@eopp.esa.int
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Chapter 3

Starting Esov

General remark: The screen shots in this manual have been taken from Esov running on a Windows system. Single GUI
components may look slightly different on other platforms (i.e., depending on the specific 'Look and Feel’), but there is no
functional difference between them.

3.1 Windows XP, Vista, 7, 8, 10

3.1.1 Starting the Esov executable
To start Esov, select Esov in the Windows Start menu or double click on the Esov icon on the Windows desktop, if configured

during the installation. If not, open a Windows Explorer and go to the Esov installation folder and double click on esovng.exe.
A splash screen appears, followed by the Esov initial frame (Figure 4.1).

3.2 Mac OS X

3.2.1 Starting the Esov application
To start Esov, double click on the Esov icon on the desktop, if configured during the installation. If not, open a Finder window

and go to the Esov installation folder and double click on esovng.app. A splash screen appears, followed by the Esov initial
frame (Figure 4.1).

3.3 Linux

3.3.1 Starting the Esov application

To start Esov, double click on the Esov icon on the desktop, if configured during the installation. If not, open an Explorer window
and go to the Esov installation folder and double click on esovng. A splash screen appears, followed by the Esov initial frame
(Figure 4.1).
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Chapter 4

Basic Concepts

4.1 Scenario

The basic component in Esov is referred as Scenario. A Scenario resembles a set of settings for a spacecraft. These settings con-
tain orbital, instrumental and geographical settings as well as regional (in Esov referred as zones) and ground station definitions.
These settings together describe all necessary elements for calculating orbital swaths and intersection points (e.g. instrument
swaths intersecting reception areas of ground stations).

Furthermore, a Scenario stores information related to the presentation of its data. It holds an Esov Map, which contains visibility,
boundaries and projectional information. Thus an Esov Map provides a certain view or perspective onto a Scenario. Style
information for all presentable elements is also held within the Scenario.

The physical representation of a Scenario is given by a Scenario File, which holds the information as mentioned above in an
XML file. Scenario Files can be imported into or exported from the Esov application. Scenarios are explained in Chapter 5.

4.2 User Interface Overview

4.2.1 Main Window

Esov usually starts up with an almost empty Main Window (Figure 4.1). The only user interface components presented are the
Main Menu Bar and the Main Toolbar, both located right below the top Main Window border, as well as the Application Status
Bar with the usual progress, cursor position, insert/overwrite and memory status elements. Note that most elements of the Main
Toolbar are not active. The only active elements are for creating or opening Scenarios, and for invoking the Help System. In
order to start using Esov, first create a new scenario or open a scenario stored on the file system.
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4.2.2 Menus

4.2.2.1 File Menu

=g satellite Selected= - Esov NG 2.9

Figure 4.1: Main Window

Eile| Edit Window T

New Scenario
New Map
Open...
Close

Save
Save As...

Print...

Export Segments... »

Export Image... 4
Import ... 4
Exit

Figure 4.2: File Menu

The File Menu (Figure 4.2) exhibits the following items:

&M of 309M T

New

Selecting this menu item creates a new scenario, see Section 5.1 for further explanations.

New Map I
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Selecting this menu item creates a new map view within the current scenario, see Section 6.2 for further explanations. This
command is only available when a scenario is open.

Open I

Selecting this menu item opens a scenario file stored on the file system, see Section 5.3 for further explanations.

Close '

Selecting this menu item closes the current scenario, see Section 5.5 for further explanations.

Save '

Selecting this menu item saves the current scenario to a file on the file system, see Section 5.4 for further explanations. Note that
no new file is created when the current scenario is already associated with a file.

Save As '

Selecting this menu item saves the current scenario to a file on the file system, see Section 5.4 for further explanations. Note that
a new file is created even when the current scenario is already associated with a file.

Print '

Selecting this menue item prints the current map view.

Export Segments I

Selecting this menu item exports the current segments to the file system, see Section 11.1 for further explanations.

Export Image I

Selecting this menu item exports an image of the current map view to the file system, see Section 11.2 for further explanations.

Import... I

Selecting this menu item imports data in several different formats: Shapefiles, Points of Interest, Sub-Satellite points, , see
Section 11.3 for further explanations.

Exit '
Selecting this menu item exits Esov. Note that the user is ask to confirm the exit unless the Do not ask again option has been
selected in the Exit Dialog (see Figure 4.3).

Please note: On Mac OS X platforms, the File menu does not contain this "Exit’ entry. Here, the exit functionality is provided
through the *Quit Esov’ entry in the specific "Esov’ application menu (provided automatically, as for any application on Mac OS
X).
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Figure 4.3: Exit Dialog

4.2.2.2 Edit Menu

Edit | Window Help

Zone Database. ..

Skation Database. ..

&
&’ User Preferances, ..

Figure 4.4: Edit Menu

The Edit Menu (Figure 4.4) exhibits the following items:

Zone Database '

Selecting this menu item opens the Zone Database Editor, see Section 9.2 for further explanations.

Station Database '

Selectiing this menu item opens the Sation Database Editor, see Section 10.2 for further explanations.

User Preferences '

Selecting this menu item opens the User Preferences Dialog, see Chapter 12 for further explanations.

4.2.2.3 Tools Menu

Tools| Help
=2 Azimuth / Elevation 2D Plot ... ctril-2

= Merge Scenarios ... Ctrl-m
= scf Logical Operations... Ctrl-L
=¥ shapefile to Zones... Ctrl-5

Figure 4.5: Tools Menu

The Tools Menu (Figure 4.5) exhibits the following items:

Azimuth / Elevation 2D Plot... '
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Selecting this menu item opens the location selection dialog for the Azimuth / Elevation 2D Plot, see Section 8.1.1 for further
explanations.

Merge Scenarios I

Selecting this menu item opens the selection dialog for merging scenarios, see Section 5.6 for further explanations.

SCF Logical Operations I

Selecting this menu item opens the selection dialog for performing logical operations on SCF files, see Section 5.7 for further
explanations.

Shapefiles to Zones I

Selecting this menu item opens the selection dialog for transforming a shapefile to a zone database file, see Section 5.8 for further
explanations.

4.2.2.4 Window Menu

Window | Tools Help

= Layer Manager Ctrl-L
=¥ Segments Ctrl-G
=2 Style Ctrl-T
= Map Ctrl-M
= orbit Ctrl-0
=¥ Instruments Ctrl-

=¥ Zones Ctrl-2
=2 Stations Ctrl-5

=2 Map Overview Ctrl-V

Load Layout
Save Layout
Reset Layout

Show/Hide Docked Toolwindows
Look and Feel »

Figure 4.6: Window Menu

The Window (Figure 4.6) exhibits the following items:

Layer Manager I

Selecting this menu item displays the Layer Manager, see Section 7.1 for further explanations. Note that this menue item is
activate only when a scenario has been opened or created.

Segments I

Selecting this menu item displays the Segments Toolwindow, see Section 7.2 for further explanations. Note that this menu item
is activate only when a scenario has been opened or created.
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Style I

Selecting this menu item displays the Style Editor Window. The Style Editor allows to change the rendering style for entities
displayed in the current map. Note that this menu item is activate only when a scenario has been opened or created.

Map

Selecting this menu item displays the Map Toolwindow, see Section 6.1.1 for further explanations. Note that this menu item is
activate only when a scenario has been opened or created.

Orbit '

Selecting this menu item displays the Orbit Toolwindow, see Section 5.2.1 for further explanations. Note that this menu item is
activate only when a scenario has been opened or created.

Instruments '

Selecting this menu item displays the Instruments Toolwindow, see Section 5.2.2 for further explanations. Note that this menu
item is activate only when a scenario has been opened or created.

Zones '

Selecting this menu item displays the Zones Toolwindow, see Section 5.2.3 for further explanations. Note that this menu item is
activate only when a scenario has been opened or created.

Stations '

Selecting this menu item displays the Stations Toolwindow, see Section 5.2.5 for further explanations. Note that this menu item
is activate only when a scenario has been opened or created.

Map Overview I

Selecting this menu item displays the Map Overview Toolwindow with a thumbnail of the map current viee location. Note that
this menu item is activate only when a scenario has been opened or created.

Sub Satellite Position '

Selecting this menu item displays the Sub-Satellite Position Toolwindow, see Section 5.2.7 for further explanations. Note that
this menu item is activate only when a scenario has been opened or created.

Load Layout I

Selecting this menu item loads a toolwindow layout from the File Sytem. Note that this menu item is activate only when a
scenario has been opened or created.

Save Layout I

Selecting this menu item saves the current toolwindow layout to the File Sytem. Note that this menu item is activate only when
a scenario has been opened or created.

Copyright © 2008 - 2025 ESA



Esov Software User Manual 16/ 145

Reset Layout I

Selecting this menu item resets the current toolwindow layout to the default layout. Note that this menu item is activate only
when a scenario has been opened or created.

Show / Hide Docked Toolwindows '

Selecting this menu item toogles the visibility of docked Toolwindows. Note that this menu item is activate only when a scenario
has been opened or created.

Look and Feel '

Selecting this menu item allows to select a graphical user interface look and feel other than the default.

4.2.2.5 Help Menu

Help

Help...

12 Check for new ESOV NG versions...
Check for new missions files...
About...

Figure 4.7: Help Menu

The Help Menu exhibits the following items:

Help... I

Selecting this menu item opens the Help System, see Chapter 15 for further explanations.

Check for new Esov versions... '

Selecting this menu item opens the Esov Online Update Dialog, see Chapter 17 for further explanations.

About... '

Selecting this menu item displays the Esov version and license information.

4.2.3 Main Toolbar

Figure 4.8: Main Toolbar

[ —
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Selecting this toolbar element creates a new scenario, see Section 5.1 for further explanations.

Selecting this toolbar element opens a scenario file stored on the file system, see Section 5.3 for further explanations.

5 |

Selecting this toolbar element saves the current scenario to a file on the file system, see Section 5.4 for further explanations.

)

o,

Selecting this toolbar element enables/disables the zoom mechanism for the current map view. If the zoom mechanism is enabled,
the center mechanism (see below) is disabled (and vice versa).

Selecting this toolbar element zooms out of the current map view.

I

Selecting this toolbar element enables/disables the center mechanism for the current map view. If the center mechanism is
enabled, the zoom mechanism (see above) is disabled (and vice versa).

)
[
!

Selecting this toolbar element displays the whole world in the current map view.

Selecting this toolbar element to rotate the current map view clockwise by 30 degrees. Note that this item only applies to the
azimuthal and gnomonic projections.

& I

Selecting this toolbar element rotates the current map view counter-clockwise by 30 degrees. Note that this item only applies to
the azimuthal and gnomonic projections.

L —

Selecting this toolbar element activates the distance calculator. To compute the geodetic distance between two point first double
click on the initial point (marked by a pin) then click on the second point (marked by a different coloured pin). The distance label
is shown next to the target point.

L
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Selecting this toolbar element opens the Software User Manual.

4.2.4 Toolwindows

In Esov, the major subcomponents of a Scenario are administrated in Toolwindows. There are distinct toolwindows for the
instruments of a spacecraft and their current scope, for the orbital settings underlying the computation of swaths, zones and
groundstations to be considered, layering and style information, and finally for a tabular summary of the computed swath seg-
ments. With the JIDE Docking Framework which comes with Esov, toolwindows can be arranged very flexible (shown/hidden,
docked, moved etc.). This will be explained in more detail in Chapter 14.

AEOLUS - Orbit [ I = 53|

@

@ Use orbit parameters
i) Use Orbit Scenario File
() Use Predicted / Restituted Orhit File | |

) Use TLE

Orbit

Repeat Cycle: 7 Cycle Length:

Abs. Reference Orbit: |19661 MLST: 17:56:08 Drift: 0.0

Longitude Anx.: 20 Offset: 0.0 Linear Term: |0.0

Date: 20220113 : |

Info
Orhital Period [s]: 5448.65 Equatorial Separation [km]: 361.03
Orbits per day: 15.86 Altitude (max/min/avg) [km]: 340/316/320
Anx. Date: 2022-01-13T17:48:10.272398

Orbit / UTC Time Interval

@ Orbit

Start Orbit: 19661
# of Orbits: 1

) Dates

Graphical Settings

Points per Orbit: |1pp | » Show Orbits: |pyp —

Apply

Figure 4.9: Toolwindows arranged as dockable components (example)

4.2.5 Maps

The key component for all graphical representation of a scenario is the Map. The map is held in a distinct pane which is, in
opposite to toolwindows (see below), always visible in Esov. Basically, the map shows a map of the Earth, represented by a layer
of shorelines/political border and/or a satellite background image. On this map, the computed instrument swaths are drawn. The
map can be viewn under different projections and provides tools (such as zooming, rotation) to offer to the user an optimal view
of the scenario which is currently analyzed. Maps are explained in Chapter 6.
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4.2.6 Layers

The representation of a scenario and the current view on it is provided by a concept of different Layers, which are administrated
(i.e., shown or hidden) with a special toolwindow, the Layer Manager. This concept distinguishes between pure view layers
which can always be shown/hidden independent of swaths being calculated (such as zones, groundstations, background image),
and layers depending on the current spacecraft and its orbit/instruments settings. All layers are clearly arranged in a tree view
within the Layer Manager toolwindow.
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Chapter 5

Scenarios

5.1 Creating a New Scenario

To create a new scenario, click "New’ in the File menu, or the button ’New Scenario’ in the main toolbar. A dialog ’Create
New Scenario’ appears (Figure 5.1.)., which contains a drop-down list with available spacecrafts. Select the spacecraft you want
to work with, and click OK. The dialog ’Create New Scenario’ is closed, and a new, unnamed scenario is opened in the main
frame. The arrangement of the toolwindows will be the same as in other open frames or, if no other frames are open, as it was
when the previous session was left. When the application is launched the first time after installation, a default layout will be used
(Figure 5.2.).

u Create New Scenario

@ Select Spacecraft

|AEOLUS |v|

| OK H Cancel‘

Figure 5.1: *Create New Scenario’ dialog for spacecraft selection
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__ PRl

Raady 1MM ot 62004 W

Figure 5.2: New scenario in default layout

5.2 Changing a Scenario

Basically, a scenario will be changed every time if scenario-relevant parameters are changed by the toolwindows, and if these
changes are manually or automatically (depending on the distincs toolwindow) applied. This will be explained in detail in
the following sections. A scenario will not be changed by actions which purely affect the visibility of layers (e.g., show/hide
latitude/longitude grid lines).

5.2.1 Orbit Toolwindow

The Orbit toolwindow is the GUI component in which the orbit settings of a scenario can be defined.

5.2.1.1 Toolbar Elements

In the Orbit Panel Toolbar the user can find two elements:

» Help Button: Invokes the Online Help for this toolwindow.

* "Apply’ button: Invokes a validation of format and consistence of the toolwindow input elements. If the input is valid, a swath
computation based on this input is performed.

5.2.1.2 Orbit Panel ('Use orbit parameters’ input mode)

In the Orbit Panel (see Figure 5.3.) the user can change the repeat cycle of the satellites orbit, the cycle length, drift, absolute
reference orbit, MLST (Mean Local Solar Time), longitude ascending node crossing, and date. For these orbit parameters, there
are generally four input modes: *Use orbit parameters’, ’Use Orbit Scenario File’, *Use Predicted / Restituted Orbit File’ and
"Use TLE’. The OSF or POF/ROF mode can be selected by the *Use Orbit Scenario File’, *Use Predicted / Restituted Orbit File’
or "Use TLE’ radiobuttons, respectively, at the top of the orbit section. In *Use orbit parameters’ mode (see Figure 5.3) the user
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can type in a value for the repeat cycle. Accordingly, the possible values for the cycle length will be given in a drop-down box.
These values are computed by the application, based on the values for Minimum/Maximum Orbits per Day, as specified in the
IDF file of the current spacecraft. If no valid cycle length exists for the given repeat cycle, the drop-down box will remain empty,
which will result in a validation error when the orbit settings are applied for swath computation (see Section 5.2.1.12). All other
parameters need to be typed in a simple text field, except for the date which can be chosen via a calendar which pops up when
the date text field is clicked.

AEOLUS - Orbit O — = E

@

i@ Use orbit parameters
Z) Use Orbit Scenario File
) Use Predicted / Restituted Orbit File [ ]

) Use TLE

Orbit

Repeat Cycle: 7 Cycle Length:

Abs. Reference Orbit: 19661 MLST: 17:66:08 Drift: 0.0

Longitude Anx.: 20 Offset: 0.0 Linear Term: |0.0

Date: 2022-01-13 : |

Info
Orbital Period [s]: 5448.65 Equatorial Separation [km]: 361.03
Orhits per day: 15.86 Altitude (max/min/avg) [km]: 340/316/320
Anx. Date: 2022-01-13T17:48:10.272398

Orbit /UTC Time Interval

@ Orbit

Start Orbit: 19661
# of Orbits: 1

) Dates

Graphical Settings

Points per Orbit: [qpg | w Show Orbits: |py -

Apply

Figure 5.3: Orbit Toolwindow

5.2.1.3 OSF Selection

With the radiobutton *Use Orbit Scenario File’, the user can set the *Use Orbit Scenario File’ input mode of orbit parameters.
With the selection of this radiobutton, the Orbit panel for the Use orbit parameters input is replaced by the OSF File Selection
panel and, after the selection of an OSF file, the OSF Orbit Settings panel (see below).

5.2.1.4 OSF File Selection Panel

The OSF File Selection Panel consists of a non-editable text field and a ’Select OSF File’ button. When this button is clicked, an
’Open OSF File’ dialog appears. Its current directory is the Esov application directory. If an OSF file is selected and opened by
clicking ’Open’ in the ’Open OSF File’ dialog, the *OSF Orbit Settings Panel’ is displayed below.
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5.2.1.5 OSF Orbit Settings Panel

The OSF Orbit Settings Panel consists of a table listing the orbit changes which were read from the selected OSF file. The
parameters are in particular: repeat cycle, cycle length, absolute reference orbit, longitude ascending node crossing, first orbit,
last orbit, and drift. With a radio button in the first column, a distinct set of these parameters can be chosen for the swath
computations.

5.2.1.6 POF/ROF Selection

With the radiobutton *Use Predicted / Restituted Orbit File’, the user can set the *Use Predicted / Restituted Orbit File’ input
mode of orbit parameters. With the selection of this radiobutton, the Orbit panel for the Use orbit parameters input is replaced by
the POF/ROF File Selection panel and, after the selection of a POF/ROF file, the Info and Graphical Settings panels (see below).

5.2.1.7 POF/ROF File Selection Panel

The POF/ROF File Selection Panel consists of a non-editable text field and a *Select POF/ROF File’ button. When this button is
clicked, an ’Open POF/ROF File’ dialog appears. Its current directory is the Esov application directory. When a POF/ROF file
has been successfully loaded, the graphical settings panel is adjusted to cover the complete validity defined in the file.

Loading of a ROF file may take some time, depending on the number of state vector entries stored in the file. During the loading
procedure, ESOV is blocked and will not react on user interaction. A progressbar visualizes this state.

5.2.1.8 TLE Selection

With the radiobutton *Use TLE’, the user can set the ’Use TLE’ input mode of orbit parameters. With the selection of this
radiobutton, the Orbit panel for the Use orbit parameters input is replaced by the TLE File Selection panel and, after the selection
of a TLE file, the Info and Graphical Settings panels (see below).

5.2.1.9 TLE File Selection Panel

The TLE File Selection Panel consists of a non-editable text field and a ’Select TLE File’ button. When this button is clicked, an
’Open TLE File’ dialog appears. Its current directory is the Esov application directory. When a TLE file has been successfully
loaded, the graphical settings panel is adjusted to cover the complete validity defined in the file.

5.2.1.10 Info Panel

The Info panel displays additional relevant parameters which depend on the orbit settings defined manually or from an OSF file.
The parameters are in particular: orbital period, equatorial separation, orbits per day, altitude (max., min., avg.), and date of
ascending node crossing. In case of relevant changes in the orbit settings (i.e., a selection of a different OSF orbit change), the
displayed parameters in the Info panel are updated accordingly.

When using ESOV with a POF/ROF file loaded, the info panel displays the validity range of the orbit definition loaded. The
parameters in this case are the valid orbit range (start and stop orbit) and the valid time range (start and stop UTC).

5.2.1.11 Graphical Settings Panel

In the Graphical Settings Panel, the parameters defining the range of orbits displayed in the map can be set. This range is basically
defined either by the start orbit and the number of orbits, or by the start and stop dates. With the selection of either the radio
button *Orbits’ or ’Dates’, the input fields for one of the choices are enables, and the other are disabled, respectively. Start orbit
and number of orbits are set in simple text fields, start and stop dates can be chosen via a calendar which pops up when the date
text field is clicked.

Changing the inputs of start orbit/number of orbits, or start/stop date will invoke an immediate update of all these settings to
keep consistency every time. E.g., if the number of orbits is increased by one, the corresponding stop date will be updated and
increased by one orbital period.
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Further options which can be set here are: ’Points per Orbit’ (which defines the temporal resolution), *Show Orbits’ (which
defines the parts of orbits to be displayed, i.e., full, ascending or descending mode), and finally *Show Orbit Numbers’. Selecting
this checkbox will result in additional labels in the map displaying the orbit numbers.

The graphical settings will be applied after a map update invoked by the *Apply’ gearwheel icon.

5.2.1.12 Orbit Validation

Before a swath calculation will be performed after clicking the *Apply’ gearwheel icon, a validation of the input values is
performed. The following rules are checked:

* None of the input fields in the Orbit toolwindow must be empty.

* All input fields (except date/time input) in the Orbit toolwindow must have number format.

e The MLST field must have time format hh:mm:ss and be within [00:00:00, 23:59:59].

* The Repeat Cycle must have integer format and be within [1,9999].

* A Cycle Length must exist for the given Repeat Cycle (i.e., the value must not remain empty after the Repeat Cycle was set).
* The Absolute Reference Orbit must have integer format and be within [1,99999].

* The Anx. Longitude must be within [0,360].

¢ The Start Orbit must have integer format and be within [1,99999].

¢ The Number of Orbits must have integer format and be within [1,99999].

¢ The Start Date must not be behind the Stop Date.

In POF/ROF mode, the settings in the dialog panel are validated against the validity range as defined in the POF/ROF file. The
application will not accept start or stop orbits beyond the scope of the POF/ROF file. The parameter validity range is displaced
in the Info Panel in this case.

Figure 5.4 shows an example for the violation of some rules listed above. In this case, a Validation Dialog appears after the
’Apply’ button was clicked, and the relevant input fields are highlighted in red.
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AEOLUS - Orbit [ = I
(@ Use orbit parameters
) Use Orbit Scenario File
) Use Predicted / Restituted Orbit File [ ] Swath Update Interval (orbits):
i Use TLE
Orbit
Repeat Cycle: V] Cycle Length:
Abs. Reference Orbit: 25 MLST: 56:08 Drift: 0.0
Longitude Anx.: Offset: 0.0 Linear Term: |0.0

Date: 20220113 :l

Info

Orbital Period [s]: 5448.65

Orbits per day: 15.86

Equatorial Separation [km]: 361.03

Altitude (maximinfavg) [km]: 340/316/320

Anx. Date: 2022-01-13T00:48:09.272398

Orbit / UTC Time Interval
@ Orbit

Start Orbit: 19661

# of Orbits: 2.5
) Dates

Start UTC Date:

Stop UTC Date:

Graphical Settings

Points per Orbit: |qgp | w

Start UTC Date:

Stop UTC Date:

Start Orbit:

# of Orbits:

Show Orbits: |pyp | -

Figure 5.4: Invalid orbit definitions

Orbit Settings Validation

Validation failed for:

".56:08" cannot be converted to a number.

'2.5" cannot be converted to a number.

Value for 'Repeat Cycle' is out of range '[1,9999]".
No value for 'Longitude Anx.' specified.

Figure 5.5: Orbit Settings Validation Dialog
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5.2.2 Instruments Toolwindow

The Instruments toolwindow (Figure 5.6) is the GUI component in which the instrument settings (i.e. the scope of the instruments
of the selected spacecraft) of a scenario can be defined.

AEOLUS - Instruments O R E

@

[] Use Mission Timelines File (SCF):
[] Apply SZA [deg.]:

[] Apply SC Eclipse [ | Apply SC Daylight

Id Scope
ALADIN (FF |w
ORBIT ON kS

Figure 5.6: Instruments Toolwindow

5.2.2.1 Toolbar Elements

In the Instruments Panel Toolbar, the user can find four elements:

 Help Button: Invokes the Online Help for this toolwindow.

5.2.2.2 SCF File Selection

With the checkbox *Use Mission Timelines File’, the user can decide if time segments from SCF files shall be considered for the
current scenario.

When the *Use Mission Timelines File’ checkbox is selected, a non-editable text field and a ’Select SCF File’ button appear
underneath the checkbox. When the *Select SCF File’ button is clicked, a directory chooser *Open Directory with SCF Files’
appears. Its current directory is the Esov application directory (see Section 2.5.2). If a directory is selected and *Open’ is clicked,
the directory chooser is closed, and the scope of all instruments for which SCF files exist in this directory is set to *’SCF’.

If the orbit settings in an SCF file are not consistent with the current orbit settings of the scenario, the former are adjusted, and
the user is warned about this in an info message dialog.

5.2.2.3 Instrument Scope Selection

Underneath the SCF selection elements, the Instruments toolwindow provides a table which lists all available instruments of
the selected spacecraft together with their current scope in the scenario. For each instrument, the scope can be selected from a
drop-down menu. It can take one of the following values:

OFF: The instrument is not considered for swath calculations.

* ON: The instrument is considered for swath calculations. No filters are applied.

ZONE: The instrument is considered for swath calculations. The computed swaths are filtered with regard to the zones defined
in the current scenario.

STATION: The instrument is considered for swath calculations. The computed swaths are filtered with regard to the stations
defined in the current scenario. (This filter can only be applied to instruments with point swaths.)
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* SCF: If an SCF directory was chosen and *Use Mission Timelines File’ is selected, an instrument with scope *SCF’ is consid-
ered for swath calculations if an SCF file exists for this instrument. In this case, the information stored in this file is used for
the swath computation. If no SCF file exists, the instrument is not considered for swath calculations. The name convention for
the SCF file is ’instrumentname.scf’, e.g. "MERIS.scf’.

* DRS: The instrument is considered for swath calculations. The computed swaths are filtered with regard to the visibility to a
DRS satellite. (This filter is only available when defined in the mission’s IDF file)

If the scope of an instrument has a value other than OFF, the corresponding table cell is highlighted in yellow.

5.2.2.4 Apply SZA

With the checkbox *Apply SZA’, the user can decide if Sun Zenith Angle shall be applied in time segments computation for the
selected instruments in the current scenario.

When the *Apply SZA’ checkbox is selected, an editable text field is enable next to the checkbox. The user can input a value in
degrees to consider as the Sun Zenith Angle. It should be noted that this functionality is available only for some mission. When
it is not available a warning message shall be displayed when computing segments.

5.2.2.5 Apply SC Eclipse or Apply SC Daylight

The user can apply a constraint to check if the spacecraft is in eclipse or in daylight in the time segments computation for the
selected instruments in the current scenario.

When the *Apply SC Eclipse’ checkbox is selected, only the time segments when the satellite is not illuminated by the Sun are
displayed, i.e. the Earth is in the path of the sunlight from the Sun to the satellite. When the *Apply SC Daylight’ checkbox
is selected, only the time segments when the satellite is illuminated by the Sun are displayed. Note that both checkboxes are
mutually exclusive.

5.2.3 Zones Toolwindow

The Zones toolwindow (Figure 5.7) is the GUI component in which zones can be added/removed to/from a scenario, and from
which zone list files can be saved/restored.

=
&3 +-@
© | Idd | Description
#* ZhUS Australia
#* ZSAM South America
# ZAFR_ Africa
# ZEUR_ Europe
# ZSCM_ Scandinavia
# ZGBR_ United Kingdom
# ZIRE_ Ireland
# ZFOT Facific Ocean Tropical
#* ZPOS Facific Ocean South

Figure 5.7: Zones Toolwindow

5.2.3.1 Toolbar Elements

In the Zones Toolwindow Toolbar (see Figure 5.8.) the user can find five elements:
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* ’Open Zone List’ Button: If this button is clicked, an ’Open Zone List File’ dialog appears. Its current directory is the Esov
application directory. If a file is selected and *Open’ is clicked, the file chooser is closed, and the zones from the selected zone
list file are loaded in the scenario and properly displayed in the zone list (see below).

* ’Save Zone List’ Button: If this button is clicked, a *Save Zone List File’ dialog appears. Its current directory is the Esov
application directory. If a file name is set and ’Save’ is clicked, the file chooser is closed, and the zones from the zone list (see
below) are saved in the specified file.

* '+’ Button (" Add Zone(s) to Scenario): If this button is clicked, the Add Zones’ dialog (see in detail Section 5.2.4) appears.

e -’ Button ("Remove Zone(s) from Scenario): If this button is clicked and a zone was selected before, this zone is removed
from the scenario and is not listed in the zone list (see below) any more. The map is updated accordingly.

» Help Button: Invokes the Online Help for this toolwindow.
Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

&3 + -0
Figure 5.8: Zones Toolwindow Toolbar

5.2.3.2 Zone List

The zone list is a tabular display of the zones which are defined in the current scenario. This table consists of four columns:

» Zone Computation: A gearwheel icon is displayed for each zone in the table. If the icon is clicked, it will accordingly disappear
in the table cell. This means that the zone is not considered for swath computations and is ommited in scenario. The map is
updated accordingly, zone filtering for this zone will not take place. To consider the zone again for swath computations and
draw the zone in scenario, you need to click in the gearwheel icon. Then it re-appears, and the map is updated accordingly,
now taking into account zone filtering for this zone again.

e Zone ID: The zone ID (unique identifier) is displayed in this column.

* Zone Description: The zone description is displayed in this column.

5.2.4 ’Add Zones’ Dialog

The Add Zones Dialog (see Figure 5.9) is a GUI component which zones can be selected to either add them to the current
scenario, or to a user database This dialog consists of a toolbar, a list for the selection of zones, and a button panel.
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Add Zones
T | Id Description |
= ZAMA Antarctic |~
= ZAMB_ Antarctic
= ZAMC_ Antarctic
= ZAMD_ Antarctic
= ZGMA_ Greenland
= ZMAM_ Horth America
] ZAUS_ Australia
= ZICE__ lceland
= zagl Asia
] ZEAM___ South America
] ZAFR___ Africa
] ZEUR__ Europe 3
] ZSCM__ Scandinavia I
] ZGBR___ United Kingdom
] ZIRE___ Ireland
= ZA0A Atlantic Ocean
= ZROM___ Pacific Ocean (Morth)
] ZROT__ Pacific Ocean Tropical
] ZPOS__ Pacific Ocean South
= ZIoT__ Indian Ocean Tropical
= ZIos_ Indian Ocean South
= ZARC_ Arctic
= ZAMT Antarctic b |
= ZRTOL Blackforest (example circle) hd
| Add H Close

Figure 5.9: Add Zones Dialog

5.2.4.1 Toolbar Elements
In the Add Zones DialogToolbar (see Figure 5.10) the user can find three elements:

* "Copy system-defined zone into user database’ button: If this button is clicked, the zone database editor appears which is
needed to copy a system-defined zone into a user database. Only ’system-defined’ zones can be copied into a user database,
the copy is then per definition a "user-defined’ zone. To avoid confusion, it is not possible to copy a ’scenario-defined’ zone (a
zone which had been added to the scenario) since a scenario-defined zone might have been a system-defined or a user-defined
zone before. Consequently, this button is only enabled when a ’system-defined’ zone (see below) was selected in the zone list.

* ’Hide system-defined zones’ button: If this toggle button is clicked, ’system-defined’ zones (which are all the zones coming
with the application) are shown/hidden in the zone list (see below).

* "Help’ button: Invokes the Online Help for this dialog.

[ © &

Figure 5.10: Add Zones Dialog Toolbar

5.2.4.2 Zone List
The zone list is a tabular display of the zones which are defined in the current scenario. This table consists of three columns:

» Type: An icon representing the zone type is displayed for each zone in the table. The three different types are:

— ’system-defined’ - a zone which comes with the application (within in a jar file)
— ’user-defined’ - a zone which was defined by the user with the zone database editor
— ’scenario-defined’ - a zone which is defined in the current scenario (therefore, listed in the Zones toolwindow)

The meaning is also illustrated by a tooltip if the mouse is moved onto an icon.
e Zone ID: The zone ID (unique identifier) is displayed in this column.

* Zone Description: The zone description is displayed in this column.

Copyright © 2008 - 2025 ESA



Esov Software User Manual 30/ 145

5.2.4.3 Buttons

In the Add Zones Dialog Button Panel the user can find two buttons:

e *Add’ button: If this button is clicked after one or zones in the list were selected, these zones are added to the scenario. The
map is updated accordingly, and these zones are now listed in the Zones toolwindow.

* ’Close’ button: Invokes the Online Help for this dialog.
5.2.5 Stations Toolwindow

The Stations toolwindow (Figure 5.11) is the GUI component in which stations can be added/removed to/from a scenario, and
from which station list files can be saved/restored.

==
=3 +-@
€ | Id | Description
# GCOTOPHX Cotopaxi (ECUADOR)
# GEUMANHK Kurnamoto (JAPAN)
# GPRALBBX Prince aAlbert (CANADAY
¥ GWFRGHHY west Freugh (LK)
# GOHIGGH O'Higgins (ANTARCTIC, FR...
#GHATOJHX Hatoyarna (JAPan)
O GEVOMOAH Syowa LAMTARCTIC, JAPAN)
¥ GPARIPH Pari-Pari (INDONESIA)

Figure 5.11: Stations Toolwindow

5.2.5.1 Toolbar Elements
In the Stations Toolwindow Toolbar (see Figure 5.12.) the user can find five elements:

* ’Open Station List’ Button: If this button is clicked, an ’Open Station List File’ dialog appears. Its current directory is the Esov
application directory. If a file is selected and *Open’ is clicked, the file chooser is closed, and the stations from the selected
station list file are loaded in the scenario and properly displayed in the station list (see below).

’Save Station List” Button: If this button is clicked, a *Save Station List File’ dialog appears. Its current directory is the Esov
application directory. If a file name is set and ’Save’ is clicked, the file chooser is closed, and the stations from the station list
(see below) are saved in the specified file.

* ’+’ Button (" Add Station(s) to Scenario): If this button is clicked, the *Add Stations’ dialog (see in detail Section 5.2.6) appears.

>~ Button ("Remove Station(s) from Scenario): If this button is clicked and a station was selected before, this station is removed
from the scenario and is not listed in the station list (see below) any more. The map is updated accordingly.

» Help Button: Invokes the Online Help for this toolwindow.

Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

&3+ -0

Figure 5.12: Stations Toolwindow Toolbar
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5.2.5.2 Station List

The station list is a tabular display of the stations which are defined in the current scenario. This table consists of four columns:

 Station Computation: A gearwheel icon is displayed for each station in the table. If the icon is clicked, it will accordingly
disappear in the table cell. This means that the station is not considered for swath computations and is ommited in scenario.
The map is updated accordingly, station filtering for this station will not take place. To consider the station again for swath
computations and draw the station in scenario, you need to click in the gearwheel icon. Then it re-appears, and the map is
updated accordingly, now taking into account station filtering for this station again.

« Station ID: The station ID (unique identifier) is displayed in this column.

* Station Description: The station description is displayed in this column.

5.2.6 ’Add Stations’ Dialog

The Add Stations Dialog (see Figure 5.13.) is a GUI component which stations can be selected to either add them to the current
scenario, or to a user database This dialog consists of a toolbar, a list for the selection of stations, and a button panel.

Add Stations

D@

T Id | Description |
| GFUCINEX Fucino {ITALY) |=|
| GRIRUMNEX Kiruna (SWEDEM)
| GMASFPAHK Maspalomas [SPAIN)
| GFAIREHX Fairbanks (ALASKA)

] GCOTOPHX Cotopaxi (ECUADOR)

| GGATIMEX Gatineau {CANADA)

| GTROMSHX Tromsoe (NORWAY)

| GALICEHX Alice Spring (AUSTRALIA)

| GHYDERHX Hyderabad (INDLA)

@ GRUMANH Kumamoto {JARPAN)

] GPRALEEX Frince Albert (CAMADA) T

] GWFRGHHX West Freugh (UK)

] GOHIGGHX O'Higgins (AMTARCTIC, FRG)

@ GHATOHX Hatoyama (JAPARN])

] GEYOMAH Syowa (ANTARCTIC, JAPAN)

] GPARIPHX Fari-Pari (INDOMESIA)

| GRHYADHX Fhyad (SAUDI ARAEIAD

| GBAMNGKHX Bangkok (THAILAMD)

= GAUSSAHK Aussaguel (FRAMCE)

| GHOBRTHX Hobart (AUSTRALIA) .

| GCUIABHX Cuiaba (ERAZIL)

- GBEIIHX Beijing {CHINA)

| GLIBREHX Libreville, Mohile (GAEON)

| GATLAMHY Atlanta (UNITED STATES)

| GTANAHY Taiwan (TANAN)

| GISRAEHX Israel (ISRAEL)

= GIOHAMHX lohannesburg (SOUTH AFRICA)

| GMCMURHX McMurdo (UNITED STATES)

| GSINGAHY Singapore (SINGAPORE) =
| Add | | Close ‘

Figure 5.13: Add Stations Dialog

5.2.6.1 Toolbar Elements

In the Add Stations DialogToolbar (see Figure 5.14.) the user can find three elements:

* ’Copy system-defined station into user database’ button: If this button is clicked, the station database editor appears which is
needed to copy a system-defined station into a user database. Only ’system-defined’ stations can be copied into a user database,
the copy is then per definition a "user-defined’ station. To avoid confusion, it is not possible to copy a ’scenario-defined’ station
(a station which had been added to the scenario) since a scenario-defined station might have been a system-defined or a user-
defined station before. Consequently, this button is only enabled when a ’system-defined’ station (see below) was selected in
the station list.
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* "Hide system-defined stations’ button: If this toggle button is clicked, ’system-defined’ stations (which are all the stations
coming with the application) are shown/hidden in the station list (see below).

* ’Help’ button: Invokes the Online Help for this dialog.
[ © =1

Figure 5.14: Add Stations Dialog Toolbar

5.2.6.2 Station List
The station list is a tabular display of the stations which are defined in the current scenario. This table consists of three columns:

» Type: An icon representing the station type is displayed for each station in the table. The three different types are:

— ’system-defined’ - a station which comes with the application (within in a jar file)
— ’user-defined’ - a station which was defined by the user with the station database editor

— ’scenario-defined’ - a station which is defined in the current scenario (therefore, listed in the Stations toolwindow)
The meaning is also illustrated by a tooltip if the mouse is moved onto an icon.
» Station ID: The station ID (unique identifier) is displayed in this column.

» Station Description: The station description is displayed in this column.

5.2.6.3 Buttons
In the Add Stations Dialog Button Panel the user can find two buttons:

¢ Add’ button: If this button is clicked after one or stations in the list were selected, these stations are added to the scenario.
The map is updated accordingly, and these stations are now listed in the Stations toolwindow.

* ’Close’ button: Invokes the Online Help for this dialog.

5.2.7 Sub-Satellite Point Toolwindow

The Sub-Satellite Point toolwindow (Figure 5.15) is the GUI component in which the user can configure the visualization of the
satellite position at a given time.

@

[¥] SSP Position ' . 1 [2000-01-01T02:38:59 |

Figure 5.15: SSP Toolwindow

5.2.7.1 Toolbar Elements
In the SSP Panel Toolbar, the user can find one element:

» Help Button: Invokes the Online Help for this toolwindow.
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5.2.7.2 SSP Selection

With the checkbox ’SSP Position’, the user can decide if the map showns the satellite position (marked with a satellite icon and
labelled with the corresponding date and time).

5.2.7.3 SSP Time Selection

When the ’SSP Position’ checkbox is selected the editable date/time field and the slider bar become active. Through these widgets
the user can select the epoch at which to display the satellite position. The acceptable values range between the orbit current time
interval. The display is automatically updated whenever the user edits the date filed or releases the slider after moving it.

5.3 Opening a Scenario

To open an existing scenario, click ’Open’ in the File menu, or the button ’Open Scenario’ in the main toolbar. A file choose
dialog ’Open a Scenario’ appears (Figure 5.16). Select the scenario you want to open, and click ’Open’. The dialog *Open a
Scenario’ is closed, and the scenario is opened in the main frame. Its name is given with full path in the frame title (Figure 5.17).

== Open a Scenario E|
Laok in: |E olafd w | 5 ,—"’|| =
u:ﬂ ) .beam |5 Druckumgebung [C5) Mews Falder
[C0) .esovE-200705E01 (£ Eigene Dateien ) old
verz:zflsfate [C5) .imagine850 | esov_ng [C5) osf_testdir
Dokumente [C0) .install4j4 | esav_old ) phey
- () -jprofilers Si¢ Favoriten [C2) Projekte
[ ) .m2 | globcower [ 2uletat verwendste D
Deskhop [C7) .org.esa.beam. esay ) gluegen [C5) scenario_testdir
[C5) -poseidon 1) Installamywhere [C5) sef_teskdir
=, [5) albedomap |5) JawaProjects ) SendTo
____/" () Anwendungsdaten |5) Lokale Einstellungen [C5) software
Eigene Dateien | (2) CalVal_portal |) marcoast [C5) Startmeni
() CloudStructures |5) meris-op ) temp
- () Contacts |) mosaic_est.data ) tina
3113 [5) Conkies [ My Documents [C7) UserData
Arbeitsplatz [C7) Desktop |5 Metzwerkumgebung [C5) varlagen
R < | >
.ﬁ File name: | | | [ Open ]
Metzwerlumgeby moo o bype: |Scenarin File " | Cancel

Figure 5.16: Open scenario dialog
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Eile Edit Win, ols Help

D@

= L]

290 z

o~ ® Geographical Layers °

o ® AEOLUS

o~ ® UserShapes (1]

& ® UserBackground Images K
»

= ]
»
:

<no layer selected> E
g
2
]

=2

[Juse Mission

[]Apply S5ZA [d:

[E] I Scope
[ALADIN 13 ~
ORBIT lon —— Tv

it: 1 (2000-01-01T18:00:02) / Last Orbit: 1 (2000-01-01T19:32:

Apply

Ready 238M of 617M o

Figure 5.17: Opened scenario ’AEOLUS’

5.4 Saving a Scenario

To save a scenario, there are two entries in the File menu: *Save’ and ’Save as...”. For the latter, there is an equivalent button in
the toolbar (see Section 4.2.3).

e Save As...: If the *Save As...” functionality is invoked, a save dialog ’Save Scenario’ appears (Figure 5.18). In this dialog,
type a filename and click *Save’. If this file does not already exist, the ’Save’ dialog disappears, and the scenario is saved
in a scenario file with extension ’.xml’. If this scenario file already exists, you will be informed by a confirmation dialog
(Figure 5.19). In case you want to overwrite the existing scenario file, click "OK’.

» Save: If the scenario has already been saved earlier, it will just be saved again under the existing item. If the scenario has not
yet been saved, a ’Save’ dialog appears, and the scenario can be saved as described above.
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=) w2 |5 glabcover [ zulstzt verwendste D
[5) .org.esa.beam . esoy |5 gluegen [C5) scenario_teskdir

[5) -poseidon |5 Installamywhere 5 scf _testdir

|5 albedomap |5) JawaProjects [ SendTa

=) Anwendungsdaten |5 Lokale Einstellungen |5 software

[5) Calval_partal |5 marcoast [C5) Startmend

|5 CloudStructures |5 metis-op ) temp

[C5) Cantacts |5 masaic_est.data () tina

[5) Caokies |5 My Documents [C5) UserData

=) Deskiop |5 Metzwerkumgebung =) vorlagen

4 >
File name: | | | [ Save ]

Files of type: |Scenario File

- | Zancel

Figure 5.18: Save scenario dialog

Confirmation

\_g/. Scenario File 'C:\Dokumente und Einstellungeniolafdiscenario_testdiribla’ already exists - overvrite?

Figure 5.19: Save scenario confirmation dialog

5.5 Closing a Scenario

To close a scenario, click *Close’ in the File menu. A confirmation dialog appears asking if the scenario shall be saved before
closing. (Figure 5.20). If "Yes’ is clicked, the scenario will be saved as described in Section 5.4. If "No’ is clicked, the scenario
will be closed immediately, and an empty main frame will remain. *Cancel’ cancels the *Close’ action.

Confirmation

\g/ Save scenario before closing?

[ Wes H ] ][Cancel]

Figure 5.20: Close scenario confirmation dialog
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5.6 Merging scenarios

It is now possible in Esov to merge several single scenarios to a *multi-satellite’ scenario and to display this in a separate frame.
This functionality is described in detail in the *Tools’ chapter (Section 8.2).

5.7 SCF Logical operations

It is now possible in Esov to perform logical operations over SCF files (and, or, not). The operations are allowed for instrument
files of the same mission. This functionality is described in detail in the *Tools’ chapter (Section 8.3).

5.8 Shapefile to Zones

It is now possible in Esov to create a zone database definition file from a shapefile. This functionality is described in detail in the
"Tools” chapter (Section 8.4).
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Chapter 6

Maps

All geographic information for a chosen Scenario such as satellite orbits, instrument swaths and station perimeters are presented
on a Map. When a Scenario is opened or newly created a new Map is created automatically. The automatically created Map can
be changed manually and be printed.

6.1 Changing a Map

A Map can be changed and customised by means of the Map Toolwindow and the Map Tools of the Main Toolbar.

6.1.1 Map Toolwindow

The Map Toolwindow can be accessed by selecting the Map from the Window menu item in theMain Menu. In the default
Toolwindow Layout the Map Toolwindow is also available from the Toolwindow Bar on the right side of the Main Window
frame. A typical instance of the Map Toolwindow is shown in the screenshot below.
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Projection Settings

Projection: |Rectangu|ar |v|

North Latitude:

— 00—

West Longitude: East Longitude:

- -180.0 180.0|

South Latitude:

e T —

Map Legend Settings
o=

Figure 6.1: Map Toolwindow

The Toolwindow consists of basically three components: the Toolbar Elements, the Projection Settings Panel, and the Map
Legend Settings Panel.

6.1.1.1 Toolbar Elements
Selecting the @ toolbar element opens this Section of the Software User Manual.

6.1.1.2 Rectangular Projection
The rectangular projection is the default projection used and displayed when a new scenario has been set up (e.g., as shown in
Figure 5.2). For this projection, there is a corresponding projection panel in the Map Toolwindow as shown in Figure 6.2. It

contains the following elements to define the settings for this projection:

* ’Projection’ drop-down box: The projection (rectangular, azimuthal or gnomonic) can be selected.

"North Latitude’ text field: Defines the latitude of the upper map boundary.
* *South Latitude’ text field: Defines the latitude of the lower map boundary.

* *West Longitude’ text field: Defines the longitude of the left map boundary.
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 ’East Longitude’ text field: Defines the longitude of the right map boundary.

* "World’ button: Resets the map boundaries to the default values (+90N, -90S, +180E, -180W), which is the same functionality
as for the *World’ button in the main toolbar (Section 4.2.3).

Projection Settings

Projection; |[gElEe i Ele

Morth Latitude:
Q0,000

WWest Longitude: East Longitude:
1 1
-130.000 150,000

South Latitude:
-90,000

Figure 6.2: Rectangular Projection Panel in the Map Toolwindow

6.1.1.3 Azimuthal Projection

The Azimuthal Projection is a projection on which the azimuths of all points are shown correctly with respect to the center.

As of version 1.6, changes to the projection are reflected in the map only when you select “apply’ instead of immediately as in
earlier versions. With the default settings, a map in azimuthal projection looks as shown in Figure 6.3. For this projection, there
is a corresponding projection panel in the Map Toolwindow as shown in Figure 6.4. It contains the following elements to define
the settings for this projection:

* ’Center Longitude’ text field: Defines the center longitude value used in the projection formulas. This is also the longitude in
the center of the map display.

 ’Center Latitude’ text field: Defines the center latitude value used in the projection formulas. This is also the latitude in the
center of the map display.

* ’View Angle’ text field: Defines the latitude difference from the center of the map display to the upper/lower boundary (at zero
rotation angle). Projection parameters are not changed, i.e. no recomputation of the projection is required.

* ’Rotation Angle’ text field: The map is simply rotated by the given degree value. Projection parameters are not changed, i.e.
no recomputation of the projection is required.

* "North Pole’ button: Resets the map parameters to the default values (Center Latitude +90deg., Center Longitude Odeg.,
View Angle 45deg., Rotation Angle Odeg.), which is the same functionality as for the *World’ button in the main toolbar
(Section 4.2.3).

* ’South Pole’ button: Sets the map parameters to the default values, except that -90deg. instead of +90deg. is set for the Center
Latitude.
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Figure 6.3: Azimuthal Projection with default settings

Projection Settings

Vieww Angle:
LY

Center I:Dng|tude: 45.000

0.000

90,000

1 H '
Center Latitude: Rotation Angle:

0.000

Marth Pole ] [ South Pole

Figure 6.4: Azimuthal and Gnomonic Projection Panel in the Map Toolwindow

6.1.1.4 Gnomonic Projection

The Gnomonic Projection is a projection in which great circles are mapped to straight lines. Since this projection sends two
antipodal points P_1 and P_2 to the same point P in the projection plane, it can only be used to project one hemisphere at a time.

As of version 1.6, changes to the projection are reflected in the map only when you select ’apply’ instead of immediately as
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in earlier versions. With the default settings, a map in gnomonic projection looks as in Figure 6.5. For this projection, the
corresponding projection panel looks the same as for the azimuthal projection (Figure 6.4).

Figure 6.5: Gnomonic Projection with default settings

6.1.1.5 Map Settings Validation

Map settings are only accepted by the application when they could be correctly validated. Validation is performed immediately
upon input. Failed validation leads to a red input field that cannot loose focus, so that you have to provide valid input in order to
apply these settings.

The following validation rules are checked:

* None of the input fields in the map toolwindow must be empty.
* All input fields must have number format.

¢ North and South Latitude must be within [-90, 90].

* North Latitude must be greater than South Latitude.

* West and East Longitude must be within [-180, 180].

* West and East Longitude must not be equal. (Note that it is possible to set the West Longitude > East Longitude, i.e. West
Longitude being positive and East Longitude being negative. In this case, the ’date line’ at +/- 180deg. will be included in the
map.)

¢ Center Latitude must be within [-90, 90].

* Center Longitude must be within [-180, 180].
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* View Angle must be within [0, 90] for Azimuthal Projection, and within [0, 90) for Gnomonic Projection.

* Rotation Angle must be within [-180, 180].

Figure 6.6 shows an example for the violation of some rules listed above.

Projection Settings
Projection; | Rectangular w

Morth Latitude:
AR

west Longitude: East Longitude:
1 1
-300 78.621

South Latitude:
-ABC123|

Figure 6.6: Invalid map definitions

6.1.1.6 Map Legend Settings Panel
The Map Legend Settings Panel (Figure 6.7) provides the opportunity to

 Set a map background colour.
* Set a title for the map.
* Show or hide the map title.

» Show or hide a horizontal or vertical scale indicator. The indicator gives a rough estimate of the dimensions in the center of
the displayed image.

» Choose colours for the title and info text displayed on the map.

» Show or hide the title at the top and the info subtitle at the bottom of the map.

To apply these settings, the *Apply’ gearwheel icon needs to be clicked.

Note that for the title and info colour, white/black/light gray/dark gray values work best, because the text is rendered with a glow
in the inverse colour in order to get a good contrast even on top of a background image. If you choose a very colourful display
this can lead to very ugly effects.

Map Legend Settings

=2

Map Title Map 1

Shiow title ket Yes

Show info ket Yes

Shows horizontal scale Yes

Show wertical scale Yes

Title bext colour W 255, 0,0
Info text colour 0, 255, 0

Background colour

Figure 6.7: Map Legend Settings Panel
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6.1.2 Map Tools

Esov provides several tools to optimize the map view onto the current scenario (e.g., region of interest, swath details etc.). These
are:

e Zoom Tool

¢ Rotation

World Display

* Distance Computation

which will be described in the following subsections. All the map tools are accessible from the main toolbar.

6.1.2.1 Zoom Tool

The zoom tool is generally invoked with the buttons:

|{_\|
« "ZoomIn’: T

|{_\|
e 'Zoom Out’: ~ ®

The way how the zoom mechanism is applied to the map depends on the current projection. To help aiming you can activate a
crosshair cursor for zooming in the user preferences dialog. (Section 12.4)

6.1.2.1.1 Rectangular Projection

* Zoom In: The zoom-in mechanism is enabled/disabled with the ’Zoom in’ toggle button If enabled, the mouse pointer symbol
is changed to a crosshair if moved over the map. The mechanism works then in two ways:

— "Click": If the user clicks into the map, it is zoomed in by a factor of two. The clicked point is taken as new center point of
the map. Also, the map is expanded on the map panel as far as possible (Figure 6.8).

— "Drag": If the user clicks into the map and moves the mouse with mouse button pressed, a rectangular area to be zoomed in
will be spawned and highlighted in dark green shade (Figure 6.9). The zoom will be performed when the mouse is released.
In the zoomed map, this rectangular area will be displayed as large as possible, i.e. fill the total horizontal or vertical range
of the map panel (depending on its current aspect ratio). In the other direction, the map map is again expanded on the map
panel as far as possible. An example is shown in Figure 6.10.

e Zoom Out: If the *Zoom out’ button, the current map is zoomed out by a factor of two (inverse action to the *Click’ zoom
in). If the maximum latitude/longitude ranges are already shown (as in the initial map or after clicking *World Display’, see
below), this button has no effect.
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B Map 1 4 ¢ &

Figure 6.9: Dragged area to be zoomed in.
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Figure 6.10: Zoomed map after the drag shown in the figure above.

6.1.2.1.2 Azimuthal/Gnomonic Projection

e Zoom In: The zoom-in mechanism is also enabled/disabled with the *Zoom in’ toggle button If enabled, the mouse pointer
symbol is changed to a crosshair if moved over the map. The mechanism works with the same approach as for Rectangular
projection.

e Zoom Out: If the Zoom out’ button is clicked, the current map is zoomed out in a way that the view angle is increased by a
value of 10 deg.. All other values remain unchanged. The maximum view angle is 90 deg..

* The crosshair cursor, configurable in the user preferences, is especially useful for zooming in azimuthal and gnomonic projec-
tion. (Section 12.4)

6.1.2.2 Rotation

The rotation tool is generally invoked with the buttons:

« ’Rotate Clockwise’: TV

)]
y

 ’Rotate Counterclockwise’:

The rotation tool can only be used for the Azimuthal and Gnomonic projection. Each time a rotation button is clicked, a rotation
by an absolute value of 30deg. will be performed. Note that the ’Rotate Clockwise’ mechanism changes accordingly the *Rotation
Angle’ value in the Map Settings Panel. An example for a clockwise rotation by 60 deg. in the Azimuthal projection is shown in
Figure 6.11.
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Figure 6.11: Azimuthal projection after clockwise rotation by 60 deg.

6.1.2.3 Center

The Center tool is generally invoked with the button:

e ’Center’: i'

The Center tool can be used for all projections. If clicked in the Rectangular projection, the map is centered with regard to the
longitude corresponding to the clicked point. If a zoom had been performed before, or if the tool is applied in the Azimuthal or
Gnomonic projection, the map is centered with regard to both longitude and latitude corresponding to the clicked point.

6.1.2.4 World Display

The World Display tool is generally invoked with the button:

, .
e *Show world’:

The World Display tool can be used for all projections. If clicked, the default map parameters (as described in Section 6.1.1) will

be set and applied for the current projection. However, note that the *whole world’ can never be shown for the Azimuthal and
Gnomonic projection, since this is not possible for these projections.

6.1.2.5 Compute Distance

The Distance between two points tool is generally invoked with the button:
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e "Compute distance’: 9

Selecting this tool activates the distance calculator. To compute the geodetic distance between two point first double click on the
initial point (marked by a pin) then click on the second point (marked by a different coloured pin). The distance label is shown
next to the target point.

6.2 Opening Multiple Maps

As of version 1.6 you can open multiple maps at the same time within one scenario. When you are working on a scenario, you
can either choose "New Map" from the "File" menu or right-click the title-tab of the current map and choose "New Map". This
will create a new map tab with the same settings as the current map, but a different title. Figure 6.12.

The name of the current map is also displayed in the title of the Map View, as you can now change the projection or the selected
region on each map separately. Figure 6.13

Many of the other settings of the application apply to all maps currently available, e.g. you will always see the same layers on all
maps. This feature is intended to provide multiple views for the same scenario, so all styles, layers, instruments etc. are always
available on all maps.

By dragging the maps title tab you can position maps so that multiple maps are shown at the same time. Be aware that this
results in longer rendering time (as each visible map has to be updated at the same time) and higher memory requirements. Also,
the orientation of maps is not reproduced when saving/opening a scenario. All maps are always stacked when a new scenario is
loaded, so that only one map is visible after loading a scenario.

Eile Edit Window Help
O@® [aase
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@ @ @ New Map
= I Close
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% (1) Background Image Close Al
& < Shore Lines / Political B Previous
B < Grid New Horizontal Group
S < ISEA 4Hx Raster New Vertical Group
B O Zones [T
B @ Sations flung
o W ENVISAT 7

& UserShapes

Figure 6.12: Create a new map within the same scenario

ave =
Projection Settings
Projection: [Rectangular

West Lonait

Figure 6.13: The currently active map is shown in the Map View ("Map 2" in this example)

6.3 Printing a Map

The current map can be printed using the ’Print...” menu entry in the File’ menu. A native printing standard dialog will then
displayed, guiding the user through the printing process. Note that only the map display itself will be printed, not the whole
application frame. Also note that on Mac OS X the printer driver may not allow to change the orientation so that, depending on
the map aspect ratio, not the whole space on the paper might be used. In this case, the user should export the map as GIF, PNG
or PDF file (see Section 11.2) and use printing capabilities of external applications.
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Chapter 7

Layer Management

7.1 The Layer Manager Toolwindow

The Layer Manager toolwindow (Figure 7.1) is the GUI component in which the visibility of the layers which can be displayed
in the Esov map is controlled.

711

In the Layer Manager Toolwindow Toolbar (see Figure 7.2) the user can find three elements:

Toolbar Elements

4+ 9@

¢ @ Geographical Layers
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& { Zones

® @ Stations
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= ORBIT
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User Shapes

User Background Images
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2 (1) Chlorophyll
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= (1) Ozone 03

2 (2) World Bluemarble Bathy

Figure 7.1: Layer Manager Toolwindow
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* Button "Move up’: When this button is clicked, a selected layer in the layer manager tree will be moved up by one position.

* Button "Move down’: When this button is clicked, a selected layer in the layer manager tree will be moved down by one
position.

* Help Button: Invokes the Online Help for this toolwindow.

Note that no *Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

+ 9@

Figure 7.2: Layer Manager Toolwindow Toolbar

7.1.2 Layer Manager Tree

The Layer Manager Tree contains all layers which can basically be displayed in Esov. The tree is divided into three main
branches, the Geographical Layers Tree, Instruments Tree of the selected spacecraft the User Shapes Tree and the User Back-
ground Images. Each layer in the tree has an "eye’ icon which serves as toggle button to show/hide the layer in the map. The tree
and its subtrees can be expanded (as inFigure 7.1) or collapsed (Figure 7.3).

=
4+ 9@

o- @ Geographical Layers

& AEOLUS

@ User Shapes

@ User Background Images

e

Figure 7.3: Layer Manager Toolwindow with collapsed Layer Manager Tree

7.1.2.1 Geographical Layers Tree

The Geographical Layers Tree contains the following layers available in Esov:

* Background Image: NASA BlueMarble Bathymetry image of the world, providing a high-contrast view of continents, oceans
and polar regions for a better geographic orientation (Figure 7.4)

 Shore Lines / Political Borders: Layer providing polygons of shore lines and political borders for the globe. (Figure 7.5)
 Grid: Layer providing latitude/longitude grid lines. (Figure 7.6)

e Zones: Layer providing polygons of the zones defined in the current scenario. (Figure 7.7)

* Stations: Layer providing point symbols of the stations defined in the current scenario. (Figure 7.8)

* POIs: Layer providing Points of interest loaded in the current scenario. POI layer files can be imported through the menu "File
->Import...” (see Section 11.3.2 and Section 11.3.3)
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Figure 7.4: Esov map with *Background Image’ layer shown, all other layers hidden.

Figure 7.5: As first figure, but Shore Lines / Political Borders’ layer also shown.
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Figure 7.7: As previous figure, but *Zones’ layer also shown (" Africa’ as example).
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Figure 7.8: As previous figure, but *Stations’ layer also shown ("Hyderabad’ as example).

7.1.2.2 Instruments Tree

The Instruments Tree contains the spacecraft-specific layers available in Esov:

* ORBIT: The orbit layer of the selected spacecraft, represented by a line ("point swath’ type for every spacecraft, see below).

« Station Perimeters: The layer providing polygons of the perimeters of the stations defined in the current scenario. (Note that
these perimeters are spacecraft-dependent. Therefore, they are listed in the instrument tree and not handled as geographical
layer.)

* Instruments Subtree: The Instruments Tree contains the single layers representing the swaths of the different instruments as
computed for the current scenario. The swaths are represented either by a line (for *point swath type’ instruments whose trace
on the ground is a one-dimensional line), or by a polygon (for ’line swath type’ and ’asar swath type’ instruments whose trace
on the ground is a two-dimensional area).

Figure 7.9 shows an example of all layers visible in an Esov map. For the ENVISAT spacecraft, a range of five orbits is shown
for the orbit layer and for the instruments MERIS (’line swath’ type with zone filter applied) and MWR (’point swath’ type with
station filter applied).
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Figure 7.9: Esov map with all layers shown. See text for details.

7.1.2.3 User Shapes Tree

The User Shapes tree contains user supplied overly shapes.

ESRI shape files can be imported through the menu ’File->Import...->Shapefile...” (see Section 11.3.1). Shapes can also be added
to ESOV by simply copying ESRI Shape File format conformant files into a dedicated user shapes directory. This directory is
located in the Esov application directory ("user_shape_files’). ESOV detects and displays shapefiles that consist at least of:

 *.shp: contains the geometry data
 *.dbf: contains the attribute data
» *.shx: contains the connection between attributes and geometries

* *.prj: contains the projection information of the data

The ’user_shape_files’ directory is scanned once during the ESOV startup phase.

Initially, all User Shapes detected are set to ’invisible’; a User Shape can be switched to the visible state by clicking on the
‘eye’-icon.

User Shape files are displayed in the User Shapes tree by using

* the type name(s) stored in the shape files or

* the shape file name without the file extension when no type names are available from the shape file.

7.1.2.4 User Background Images Tree

The User Background Images tree contains user supplied background images.

Specific background images are supplied ESOV by simply copying ESRI Shape File format in a dedicated user background
images directory. This directory is located in the Esov application directory (’user_background_images’). ESOV detects and
displays images that consist at least of:
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* *jpg: contains the image itself
 *.prj: contains the projection information of the data

* * wld: contains the location information of the data

The "user_background_images’ directory is scanned once during the ESOV startup phase.

Initially, all User Background images detected are set to ’invisible’; a User Background Image can be switched to the visible
state by clicking on the ’eye’-icon.

User Background Images files are displayed in the User Background tree by using

* the image file name without the file extension

7.2 The Segments Toolwindow

The Segments Toolwindow Figure 7.11 is an informative toolwindow which lists the single segments computed for a certain
instrument for the current scenario. This toolwindow contains information only if an instrument (or the spacecraft’s orbit) has
been selected in the Layer Manager Tree, otherwise just a message 'no instrument selected’ is displayed (Figure 7.10)

<please select an instrument in the layer manager =

Figure 7.10: Segments Toolwindow. No instrument selected.

Copyright © 2008 - 2025 ESA



Esov Software User Manual 55/145

=
* ¥ @
#- @ Geographical Layers
= @ ENVISAT
[ OREIT (OFF)
-] Station Perimeters
S @ Instrumerts
B i G MERIS (ZONE)

=
W d Colar Start Orbit Start Sec Start UTC Stop Orhit Stop Sec Stop UTC
:0 1 583 2000-01-01
= ||| — 27582 2000-01-02707:08:52 & 3588 2000-01-02T07;22:18
= C———]F 2468 [2000-01-02TOG:44: 14 7 3467 [2000-01-02T09:00:53
= o] | S— 2374 [2000-01-02T10:23:16 B 2937 [2000-01-02T10:32:39

Figure 7.11: Segments Toolwindow with filled table (instrument MERIS selected).

7.2.1 Segments Table
The segments of the selected instrument are displayed in a table wth the following columns:

* Visibility: ’Eye’ icon serving as toggle button to show/hide a single segment in the map.
* Id: Segment index, starting with 0.

* Colour: Segment colour in the map.

» Start orbit: Start orbit of the segment

* Start second: Start time of the segment (relative time within the orbit, given in seconds)
e Start UTC: UTC start time of the segment

* Stop orbit: Stop orbit of the segment

» Stop second: Stop time of the segment (relative time within the orbit, given in seconds)
e Stop UTC: UTC stop time of the segment

* Zone: Identifier of the zone (if scope ZONE/MULTIZONE is applied to the instrument)
* Station: Identifier of the ground station (if scope STATION/MULTISATION is applied to the instrument)

* Geo: Longitude of the GEO satellite (if scope DRS is applied to the ORBIT, being DRS visibility enabled in IDF)
The Segments Table provides the following functionalities:

 Single segments can be shown/hidden with the ’Visibility’ toggle button ('eye’ icon) (Figure 7.12).

» Single segments can be selected to set their specific style in the style toolwindow (see Section 7.3). Multiple selection is also
possible.
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[ "AcoLus /orarr - seq
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Figure 7.12: Segments Toolwindow: Visibility toggle - second segment hidden.

7.3 The Style Toolwindow

The management of layer style properties is handled by a ’Style’ toolwindow (Figure 7.13). In this toolwindow, properties for
distinct layers are listed in a table, together with suitable editors to change each property. Furthermore, it provides a description
area providing a brief description of a selected property.

7.3.1 Toolbar Elements

The Style Toolwindow Toolbar contains some special elements which are useful in particular for the property editors. In the
Style Toolwindow Toolbar (see Figure 7.14) the user can find the following elements:

 ’Categorized’: When this toggle button is selected, the style properties are displayed in a categorzed tree. (Note that currently
only one category, ’Style Info’, is used.)

* ’Alphabetic’:When this toggle button is selected, the style properties are displayed alphabetically.

» Show/Hide Description Area: When this toggle button is selected/deselected, the description area underneath the style info is
shown/hidden.

* Expand: When this toggle button is selected, the tree in the *Categorized’ view is expanded.
* Collapse: When this toggle button is selected, the tree in the *Categorized’ view is collapsed.

* Help Button: Invokes the Online Help for this toolwindow.

Note that no *Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

%4 (=] =2t @
=

Opacity 100 %%
{Name)
(Description;

Figure 7.13: Style Toolwindow

28 (=] =2 @

Figure 7.14: Style Toolwindow Toolbar
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7.3.2 Style Editors

The styles of the different layers used in Esov are controlled with specific editors which provide a user-friendly way to set the
single layer properties. If a layer is selected in the layer manager, the corresponding editor is displayed in the Style Toolwindow.

7.3.2.1 Default Style Editor

A ’default style editor’ (Figure 7.13) is displayed when a root or subroot node is selected in the Layer Manager (’Geographical
Layers’, spacecraft name or ’Instruments’). It consists of one single property ’opacity’. This editor is usable in principle,
however, changes have no effect. The opacity needs to be set separately for each single layer. The ’default style editor’ is also
displayed for the background image layer. This layer has a fix opacity of 100 percent.

7.3.2.2 Shoreline Style Editor

When the layer *Shorelines / Political Borders’ is selected, the Shoreline Style Editor is displayed (Figure 7.17. With this editor,
the following properties can be configured:

* Opacity: The opacity of the polygons can be set on a scale from O to 100 percent. (Figure 7.17) The default value is *50°.

Note that the appearance of the slider bar is a bit platform-dependent, i.e. the percentage scale might not be fully visible on
every platform. In this case, the user can (as for all table rows in the Style Toolwindow) manually change row height by
left-click with the mouse on the horizontal row boundaries, and drag them up/down.

* Color: The color of the polygons can be set manually by typing the hexadecimal value of the color (if known) in the right
table cell of the *Color’ row, or with a separate color editor which is invoked by left-click in the table cell. This color editor
provides a variety of predefined colors, and, by clicking "More Colors’, also options to define new colors ( Figure 7.15 and
(Figure 7.16). The default value is *green’ (#00FF00).

If the color was set by its hexadecimal value, the user needs to click into the left table column to finally set the value. A color
choice from the color editor will be automatically applied, and the map is updated accordingly.

[ JrooFroolli
More
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Maore Colars

Color

Figure 7.15: Style Toolwindow: Color Editor
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Figure 7.16: Style Toolwindow: Color Editor with option to define more colors
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Figure 7.17: Style Editor for Shorelines / Political Borders

7.3.2.3 Grid Style Editor

When the layer *Grid’ is selected, the Grid Style Editor is displayed (Figure 7.21. With this editor, the following properties can
be configured:

* Opacity: as described for ’Shorelines / Political Borders’.

* Resolution: The resolution of the latitude/longitude grid lines can be selected from a drop-down list in the Resolution’ table
row, (Figure 7.18) which becomes visible by clicking into the right table cell of the "Resolution’ row. Possible values are 30,
15,10, 5, 1, 0.1 and 0.01 degrees. After selection of the value, the map is updated accordingly. The default value is *30’.
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Style

Axis Labels

Figure 7.18: Grid Style Editor: Resolution Selection

¢ Color: as described for *Shorelines / Political Borders’. The default value is *white’ (#FFFFFF).

 Style: The line style of the latitude/longitude grid lines can be selected from a drop-down list in the *Style’ table row, which
becomes visible by clicking into the right table cell of the *Style’ row (Figure 7.19). Possible values are ’Solid’, ’Dashed’ and
"Dotted’. After selection of the value, the map is updated accordingly. The default value is ’Solid’.

Cyle Solid g
s Lo
Dashed
Dokted

Figure 7.19: Grid Style Editor: Style Selection

» Axis Labels: The option if axis labels should be shown with the grid can be selected from a drop-down list in the * Axis Labels’
table row, which becomes visible by clicking into the right table cell of the *Axis Labels’ row (Figure 7.20). Possible values
are "Yes’ and 'No’. After selection of the value, the map is updated accordingly. The default value is *Yes’.

Axis Labels

Opaciky 100 %

Resaolution 15 deq.
Calor [ |wrrrrer
Skyle Solid
Axis Labels es
Style Info

Figure 7.21: Grid Style Editor

7.3.2.4 Zone Style Editor

When the layer *Zone’ is selected, the Zone Style Editor is displayed (Figure 7.22. With this editor, the following properties can
be configured:
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* Opacity: as described for ’Shorelines / Political Borders’.
¢ Color: as described for *Shorelines / Political Borders’. The default value is "red’ (#FF0000).
* Style: as described for *Grid’.

* Filled: The option if the zone area should be filled with the chosen color can be selected from a drop-down list in the ’Filled’
table row, which becomes visible by clicking into the right table cell of the ’Filled’ row. Possible values are ’Yes’ and ’No’.
Note that the zone can only be filled if ’Solid” was chosen as line style before. After selection of the value, the map is updated
accordingly. The default value is "No’.

* Show Labels: The option if a label should be shown for the zone can be selected from a drop-down list in the "Label’ table
row, which becomes visible by clicking into the right table cell of the *Show Labels’ row. Possible values are *Yes’ and 'No’.
After selection of the value, the map is updated accordingly. The default value is No’.

» Label Size: The font size of the zone labels must be set manually in the the right table cell of the ’Size’ row. Valid numbers
are positive integers. Floats will be truncated, negative values be interpreted as their absolute value. The *zero’ is accepted, the
labels will disappear in this case. Invalid input (such as characters) will be ignored. After setting a valid number, the map is
updated accordingly. The default value is *12°.
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Figure 7.22: Zone Style Editor

7.3.2.5 Station Style Editor

When the layer *Station’ is selected, the Station Style Editor is displayed (Figure 7.24. With this editor, the following properties
can be configured:

* Opacity: as described for ’Shorelines / Political Borders’.

* Color: as described for ’Shorelines / Political Borders’. The selected color is applied to the station point symbol in this case.
The default value is "'magenta’ (#FFOOFF).

 Style: The style of the station symbols can be selected from a drop-down list in the ’Style’ table row, which becomes visible by
clicking into the right table cell of the *Style’ row. Possible values are ’Circular’, ’Quadratic’ , *Triangular’ , ’Arrow’ , ’Cross’
, "Star’ and "X’ (Figure 7.23). After selection of the value, the map is updated accordingly. The default value is ’Circular’.
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atyle

Figure 7.23: Station Style Editor: Style Selection

 Size: The size of the station symbols must be set manually in the the right table cell of the ’Size’ row. Valid numbers are
positive integers. Floats will be truncated, negative values be interpreted as their absolute value. The ’zero’ is accepted, the
symbols will disappear in this case. Invalid input (such as characters) will be ignored. After setting a valid number, the map is
updated accordingly. The default value is *7°. Note that also the font size of the station labels (if displayed, see below) will be
adjusted proportionally to this size.

» Show Labels: The option if a label should be shown with the station symbols can be selected from a drop-down list in the
’Show Labels’ table row, which becomes visible by clicking into the right table cell of the ’Show Labels’ row. Possible values
are Yes’ and *No’. After selection of the value, the map is updated accordingly. The default value is "No’.
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Figure 7.24: Station Style Editor

7.3.2.6 Station Perimeter Style Editor

When the layer *Station Perimeter’ is selected, the Station Perimeter Style Editor is displayed (Figure 7.25. A station perimeter
can in principle regarded as a geographical area. Therefore, with this editor, the same properties as for zones can be configured:

* Opacity: as described for ’Shorelines / Political Borders’.
 Color: as described for *Shorelines / Political Borders’. The default value is a dark yellow (#FFC800).
* Style: as described for *Grid’.

* Filled: as described for "Zones’. (Note that the filled area for stations close to a pole (e.g., Svalbard) may appear incomplete
in the Rectangular projection. In this case, the user should switch to the Azimuthal or Gnomonic projection to obtain a proper
image.)

» Show Topocentric: show topocentric elevation contour lines for all stations. (Figure 7.26)

* Elev. Angle: Elevation angle steps for the topocentric contour lines. (Figure 7.26)
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Figure 7.26: Showing a station’s topocentric elevation in steps of 30 deg.

7.3.2.7 Swath Style Editor
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Figure 7.25: Station Perimeter Style Editor
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When a specific instrument layer or ’'ORBIT’ is selected, the Swath Style Editor is displayed (Figure 7.29. With this editor, the

following properties can be configured:

* Opacity: as described for ’Shorelines / Political Borders’.

* Color: as described for ’Shorelines / Political Borders’. The default value for ORBIT is "white’ (#FFFFFF). The single
instruments of the different spacecrafts have their own default values.

* Style (for a "point swath’): The style of the swath can be selected from a drop-down list in the ’Style’ table row, which becomes
visible by clicking into the right table cell of the *Style’ row. Possible values for a point swath are ’Solid’, 'Dashed’ , ’Dotted’ ,
and 'Timeline’ (Figure 7.27). The *Timeline’ style is a special solid style containing tickmarks showing the temporal resolution
(’points per orbit’) used for the swath computation. After selection of the value, the map is updated accordingly. The default

value is *Solid’.
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Figure 7.27: Station Style Editor: Style Selection

 Style (for ’line swath’ and ’asar’ swath): The style of the swath can be selected from a drop-down list in the ’Style’ table
row, which becomes visible by clicking into the right table cell of the ’Style’ row. Possible values for a line swath or an asar
swath are ’Solid’ and *Hollow’ (Figure 7.28). After selection of the value, the map is updated accordingly. The default value
is "Hollow’.
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Figure 7.29: Swath Style Editor

It is also possible to set the swath style not only for a whole instrument layer by selection of the layer in the Layer Manager, but
also for single segments by (multi-)selecting specific segments in the Segments Toolwindow ( Figure 7.30 and Figure 7.31).
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Figure 7.30: Segments Toolwindow: Individual Color Selection
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Figure 7.31: MERIS Swaths with individual colors

Note that single segments are always set back to the instrument’s default style if a new swath calculation is performed.

Copyright © 2008 - 2025 ESA



Esov Software User Manual 65/ 145

Chapter 8

Tools

The latest version of Esov offers two new key functionalities which are provided as distinct tools and which are available from
the Tools menu of the main menu bar. These functionalities are the Azimuth / Elevation 2D Plot, the merge of several single
scenarios to a “'multi-satellite’ scenario, logical operations over SCF files and transformation of shapefiles to Zone files.

8.1 Azimuth / Elevation 2D Plot

For a given single location (center of system-defined zone or user-defined point) and time range, the UTC time (the x axis),
topocentric azimuth and elevation towards the satellite are computed and can be displayed for each segment in a 2D graph.

To select the location, click *Azimuth / Elevation 2D Plot...” in the *Tools’ menu. (Figure 8.1). A dialog ’Azimuth / Elevation 2D
Plot... appears (Figure 8.2), in which the location coordinates must be selected. After selection, the dialog *Azimuth / Elevation
2D Plot...” is closed, and the computed azimuth/elevation plot is opened in a separate window (Figure 8.6).

Tools | Help
=8 Azimuth | Elevation 2D Flat ... Chrl+a
= Merge Scenarios ... Chrl4m

Figure 8.1: *Azimuth / Elevation 2D Plot...” entry in *Tools’ menu

8.1.1 The Location Selection dialog

The LocationSelection dialog (Figure 8.2) is the GUI component in which the location for the azimuth/elevation plot must be
selected.
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Figure 8.2: Selection dialog for the location for azimuth/elevation plot

8.1.1.1 Toolbar Elements

In the Selection dialog for the location, the user can find two elements:

* Help Button: Invokes the Online Help for this toolwindow.

* ’Apply’ gearwheel icon: Invokes a validation of format and consistence of the toolwindow input elements. If the input is valid,
the plot computation based on this input is performed.

8.1.1.2 Location Selection Panel

With the radio buttons ’Select Station Location’ or *Select Point’, the user can decide if he wants to use the location of a system-
defined groundstation, or if he wants to define an own location.

If the radio button ’Select Station Location’ is selected: From the drop down list *Select Station Location’, the user can select
one of the system-defined stations. The center coordinates of this groundstation are considered for the plot computation.

If the radio button ’Select Point’ is selected: In the 'Point Definition’ subpanel, the user can set the coordinates of an own
location. These coordinates (longitude, latitude, altitude) can be set either manually by typing into the corresponding textfields,
or in ’graphical editing’ mode from direct selection in the current map.

For usage of the *graphical editing’ mode (see Figure 8.3), the following functionalities are provided by buttons:

* ’Paint brush’ button: A toggle button which, if activated, invokes the ’graphical editing’ mode, and vice versa. In ’graphical
editing” mode, the location selection dialog is set to 'unmodal’, and the user can set a location in the map by clicking with the
mouse, indicated by a crosshair symbol. The coordinates of this point will automatically be set in the text fields of the Point
Definition subpanel.

* ’Hand brush’ button: resets location in the textfields (i.e. sets all to 0.0). This button is enabled only if ’graphical editing’
mode is not active.

* ’'Refresh’ button: synchronizes the point definition in the textfields with the drawing in the map (i.e. applies changes made in
non-graphical editing mode) This button is enabled only if ’graphical editing’ mode is not active.

Copyright © 2008 - 2025 ESA



Esov Software User Manual

67 /145

Figure 8.3: Selection dialog for the location for azimuth/elevation plot: graphical editing mode active
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If the coordinates defined by the user are valid, they are considered for the plot computation after clicking the gearwheel icon.

Otherwise, the user is notified that the validation was not successful (see Figure 8.4 and Figure 8.5). Otherwise

With the text field *Time Step’, the user defines the temporal resolution to be used for the azimuth/elevation time series compu-

tation.

Figure 8.4: Selection dialog for the location for azimuth/elevation plot: Invalid longitude coordinate
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Figure 8.5: Selection for the location for azimuth/elevation plot: Validation Info dialog

8.1.2 The Azimuth / Elevation 2D Plot dialog

The Azimuth / Elevation 2D Plot dialog (Figure 8.6) is the GUI component in which the result of the azimuth/elevation time
series computation is displayed. Besides the graphical display, a navigation panel with buttons to switch between the plots for

the different segments, and a tabular results overview are provided in this dialog.
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Figure 8.6: Azimuth / Elevation 2D Plot dialog
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8.1.2.1 Toolbar Elements

The functionalities of this dialog do not require any toolbar elements.

8.1.2.2 Graphics Panel

In the graphics panel, the result of the azimuth/elevation time series computation is displayed for the selected segment. The
segment selection can be changed from the navigation panel (see below). There are two y-axes: azimuth (left) with default range
0-360 deg., and elevation (right) with default ragne 0-90 deg.

Various options to customize the graphics are provided:

* It is possible to zoom into a plot area of interest by dragging a zoom rectangle with the left mouse button pressed ( Figure 8.8
andFigure 8.9).

* Plot settings menu: This menu is invoked by right-clicking with the mouse into the graphics (Figure 8.7). The menu provides
the following entries:

"Properties...”: If this entry is selected, a separate *Chart Properties’ dialog is opened (Figure 8.10). From this dialog, various
plot settings (such as labels, fonts, colours etc.) can be adjusted. (A full description of all these settings is beyond the scope of
this SUM. For more details, please refer to the documentation of the original JFreeChart software (www.jfree.org/jfreechart)
which is used by Esov as 3rd party technology. However, most of the settings are rather self-explaining and easy to use.)

’Copy’: This option is unclear and seems to have no effect.

’Save as...”: It is possible to save the graphics as png file. If this entry is selected, a standard file save dialog is opened, and
the user can select a location to save the graphics.

"Print...>: It is possible to print the graphics. If this entry is selected, a standard file save dialog is opened, and the user can
select a location to save the graphics.

’Zoom In’: With this option it is possible to zoom into the center of the plot by a factor of two. With the options from the
submenu (Figure 8.11), it can be chosen if range axis, domain axis, or both axes shall be considered.

’Zoom Out’: With this option it is possible to zoom out from the center of the plot by a factor of two. With the options from
the submenu, it can be chosen if range axis, domain axis, or both axes shall be considered.

’Auto Range’: With this option, the range of the plot can be adjusted to the minima/maxima of the data sets. by a factor of
two. With the options from the submenu, it can be chosen if range axis, domain axis, or both axes shall be considered.

Properties. ..

Copy

Save as...

Prink...

Zoor In [

Zoam 2k L
1717 1 Auko Range ]

uTc

Azirmuth Elevation

Figure 8.7: Plot customize menu
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Figure 8.10: *Chart Properties’ dialog
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Figure 8.11: Zoom options submenu in Plot settings menu

8.1.2.3 Navigation Panel

With the four buttons in the subpanel ’Segments navigation’, the user can navigate through the result segments to the particular

segment he wants to see in the graphics. The buttons are self-explaining from their icons:

* “First’ button: if clicked, the first segment of the result set is displayed

» ’Backward’ button: if clicked, the segment with the previous index in the result set is displayed

* Forward’ button: if clicked, the segment with the next index in the result set is displayed

 ’Last’ button: if clicked, the last segment of the result set is displayed

If a segment is marked as “invisible’ in the Segments results table (see below), it is skipped and will not be displayed.
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8.1.2.4 Segments results table

The segment results table gives an overview of the segments for which the azimuth/elevation computation results can be dis-
played. This table is similar to the one in the segments toolwindow (see Section 7.2). The following columns are displayed:

* Segment index, starting with zero

* Visibility: ’Eye’ icon serving as toggle button to show/hide a single segment in the map.
* Colour Az: Azimuth colour in the graphics.

* Colour El: Elevation colour in the graphics.

* Colour M: Elevation Mask colour in the graphics.

* Start orbit: Start orbit of the segment

« Start second: Start time of the segment (relative time within the orbit, given in seconds)

 Start UTC: UTC start time of the segment

* Stop orbit: Stop orbit of the segment

 Stop second: Stop time of the segment (relative time within the orbit, given in seconds)

e Stop UTC: UTC stop time of the segment
The segments results table provides the following functionalities:
* Single segments can be shown/hidden with the ’Visibility’ toggle button.

* The colour of azimuth or elevation curve can be selected with a colour editor (Figure 8.12)

Seqgrnents

*
0

¥ Color Az Color El Skark O
T | |
T | | —
® [ [

—

| D

o

— Mone 10

AEEEENENN
EEEEEEN ¥
EEEEEEN|S

More Colors

Figure 8.12: Colour editor for azimuth/elevation curves

If there are no segments to be displayed, the graphics and the results table remain empty, and an appropriate message is displayed
instead (Figure 8.13)
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Figure 8.13: No segments to be displayed in Azimuth / Elevation 2D Plot

8.1.2.5 Export Segments

The Azimuth / Elevation 2D Plot Dialog allows exporting the computed segments to file. Pressing the *Export’ button (Figure 8.6)
the user is presented with a dialog requesting a file where to save the segment exportation.

8.2 Merging scenarios

To merge two or more scenarios, click ’"Merge Scenarios...” in the Tools’ menu (Figure 8.14). A dialog 'Merge Scenarios’
appears (Figure 8.15), in which the scenarios to be merged and the map settings to be used must be selected. After selection, the
dialog "Merge Scenarios...” is closed, and the resulting merged scenario is opened in a separate frame (Figure 8.17). This frame
basically looks like the one for a single scenario but has the following important differences:

* A merged scenario is meant to be a pure *graphical’ result and cannot be saved/reloaded. Therefore, in the ’Files’ menu, only
the following functionalities are available/enabled:

— Print...

— Export Image...

Also, the main toolbar does not contain the symbols for "New scenario’, ’Open scenario’ and *Save scenario’.

¢ There are no 'Edit’ and ’Tools’ menus
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* The "Window’ menu has an additional entry for the *Time Control’ toolwindow
 The subtitle consists of one line for each of the single scenarios being merged

* The Layer Manager toolwindow also contains tree nodes for each of the single scenarios being merged. Also note that the
zones and stations are scenario dependent and therefore appear under the distinct scenario tree nodes.

Tools | Help
B azimuth { Elevation 20 Plot .. Chrl+a
= Merge Scenatios ... Chrl4+M

Figure 8.14: "Merge Scenarios’ in Tools menu

8.2.1 The Scenario Selection dialog

The Scenario Selection dialog (Figure 8.15) is the GUI component in which the scenarios to be merged can be selected.

Merge Scenarios ... gl

@

A0
Select Scenario EMYISAT
CRYOSAT

Impork Map Settings

(%) Default

() From Scenatio

o4 ] [ Zancel

Figure 8.15: Selection dialog for merging scenarios

8.2.1.1 Toolbar Elements

In the Selection dialog for merging scenario, the user can find as only element:

* Help Button: Invokes the Online Help for this toolwindow.

8.2.1.2 Scenario Selection Panel

From the drop down list ’Select Scenario’, the user can (by multiple selection) define the scenarios to be merged. The list contains
the spacecrafts corresponding to the currently open scenarios. At least two scenarios (spacecrafts) must be selected, otherwise
the user will be warned by an info dialog (Figure 8.16).

With the "Import Map Settings’ radio buttons, the map settings to use for the merged scenario can be selected as either the default
ones, or the ones from one of the single scenarios, also represented by a drop-down list with the corresponding spacecrafts.
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Figure 8.17: Window displaying a merged scenario for the spacecrafts ENVISAT, CRYOSAT and ADM

8.2.2 The Time Control Toolwindow

The Time Control toolwindow (Figure 8.18) is the GUI component in which the time intervals for the merged scenario can be
defined. It is possible to define a common time interval for all single scenarios being merged, or different time intervals for each

of the single scenarios.
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Figure 8.18: Time Control Toolwindow

8.2.2.1 Toolbar Elements
In the Time Control Toolwindow Main Toolbar, the user can find two elements:

* Help Button: Invokes the Online Help for this toolwindow.

* "Apply’ gearwheel icon: An update of the merged scenario display is performed according to the changes of the time intervals.

8.2.2.2 Time Interval Settings Panel

With the radio buttons ’Set Time Interval For Each Scenario’ or ’Set Common Time Interval’, the user can decide whether he
wants to define a common time interval for all single scenarios being merged, or different time intervals for each of the single
scenarios.

With the ’Select Scenario’ drop-down list, the user can select one of the single scenarios and set a distinct time interval from the
calendar combo box (see Section 5.2.1.11). The ’Select Scenario’ drop-down list and the the calendar combo boxes below are
enabled only if the radio button ’Set Time Interval For Each Scenario’ is selected.

In the same way, the user can select a common time interval if the radio button ’Set Common Time Interval’ is selected.

8.3 SCF Logical Operations

To perform logical operations over SCF files click *SCF Logical Operations...” in the *Tools’ menu. A dialog ’SCF Logical
Operations’ appears (Figure 8.19), in which the files to be operated on and the operation to perform must be selected.
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= Scf Logical Operations...
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= scfFile 1

Select the second Scf File:

= scfFile 2

Output Scf File:

‘ Output Scf file ‘

Or operation | ‘ And operation |

‘ Mot operation ‘

Close |

Figure 8.19: SCF logical operations dialog

With the buttons in the dialog, the user can indicate:

* ’Scf File 1’ button: if clicked, an open file dialog is opened to select the first SCF file

» ’Scf File 2’ button: if clicked, an open file dialog is opened to select the second SCF file

* ’Output Scf File’ button: if clicked, an open file dialog is opened to select the folder where the resulting SCF file(s) shall be

stored

* ’Or operation’ button: if clicked, the OR logical operation shall be performed over the two selected files

* ’And operation’ button: if clicked, the AND logical operation shall be performed over the two selected files

* ’Not operation’ button: if clicked, the NOT logical operation shall be performed over the first selected file.

8.4 Shapefile to Zone transformation

b}

To convert a shapefile to a zone database definition file click *Shapefile to Zone...
Zones’ appears (Figure 8.20), in which the conversion operation shall be configured.

ﬂ Shapefile to Zones...

Select the Shapefile:

Output Zone File:

Coordinates Step (nr. of points): [10 |

'EJ Shapefile

‘ Output Zone file

\ Apply |

Close

Figure 8.20: Shapefile to Zones tool dialog

With the buttons in the dialog, the user can indicate:

in the *Tools’ menu. A dialog ’Shapefile to
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* ’Shapefile’ button: if clicked, an open file dialog is opened to select the shapefile to convert

* ’Output Zone File’ button: if clicked, an open file dialog is opened to select the folder where the resulting zone database file
shall be stored

* ’Coordinates step’ text field: if filled, shall contain the number of points defining the step to iterate on the shapefile points to
convert.

* ’Apply’ button: if clicked, the conversion shall occur.
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Chapter 9

Zone Databases

9.1 What is a Zone Database?

A zone database is basically a xml-formatted file containing relevant information on zones which can be considered for an Esov
scenario. Zone databases are divided into

» System-defined zone database: In Esov, there is exactly one system-defined zone database. The zones in this database cannot
be changed or deleted, nor can new zones be added. The system-defined zone database is also an xml-formatted file, but it is
’hidden’ in a jar archive which comes with the application. For the Esov user, there is no need to access this file directly. The
zones stored in this database become visible as ’system-defined’ zones in the *Add Zones’ toolwindow. These zones can be
copied into a user-defined database (see Section 5.2.4).

» User-defined zone database: In Esov, there is a default user-defined zone database (’defaultzones.dbf”) in the Esov application
directory. If not existing, this file is created when Esov is started. Zones in this database can be edited or deleted, and new
zones can be added with the ESOV Zone Database Editor (see below). Also, any other valid zone database file can be set as
user-defined zone database. However, a zone database file other than the default file must have been created externally. It is
not possible to create an ’empty’ user-defined zone database from Esov.

9.2 Zone Database Editor

The ESOV Zone Database Editor can be activated by selecting Zone Database...’ in the Edit menu of the main menu bar.
A modal dialog *Zone Database Editor’ appears (Figure 9.1). This window basically allows the user to define a database of
’user-defined’ zones, view the zones, and create, edit or delete zones.
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Figure 9.1: Zone Database Editor

selection when the Zone Database Editor is initially opened), and the definition of an ’Other User Database’.

In the Database Selection Panel (see Figure 9.2), the user can switch between the default user-defined zone database (default

e *Other User Database’: If this button is selected, a non-editable text field and a ’Select User Database...” button appear
on its right. When this button is clicked, an ’Open Database’ dialog appears. Its current directory is the Esov application
directory. The files available in this folder are database files with the extension *.dbf’. (Note that also station database files (see
Chapter 10) which have the same extension are listed here. If the user accidentally selects a station database instead of a zone
database, an error dialog appears that this file could not be read (Figure 9.3)).
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Figure 9.2: Zone Database Selection Panel
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Figure 9.3: Error dialog: Wrong database type

9.2.2 Zone List Panel

In the Zone List (Figure 9.4), the zones included in the selected user database are listed with their ID and Description. If a zone
is selected in this table, it can be changed or deleted (see Section 9.2.4).

Zone List
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testpaly
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besk zone

test create polygon zone

+ (=)&)

Figure 9.4: Zone List Panel
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9.2.3 Zone Definition Panel

In the Zone Definition Panel (Figure 9.5), the user can define new zones or edit existing zone.
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Figure 9.5: Zone Definition Panel

This panel consists of three subpanels:

* Header: In this subpanel, the zone header information is defined. The parameters are:

Zone ID (entry required)

Zone Description (entry required)

Zone Surface (entry optional)

Zone Creator (entry optional)

Zone Type (Polygon/Circular toggle button)

* Circular: If the zone type has been set to *Circular’ in the header panel, the specification for a circular zone is defined in this

subpanel. The parameters are:

— Center Longitude (entry required)

— Center Latitude (entry required)
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— Diameter (entry required)
— Functionalities provided by buttons:

+ ’Paint brush’ button: A toggle button to activate ’graphical editing’” mode (same as for ’Polygon’ panel). - Clicking in the
map will create a new center point of a circular zone and display its coordinated in the (disabled) text fields. - Clicking
into the square symbol of the center point and dragging it with the mouse button kept pressed will define the diameter.
For convenience, a green "radius line", together with the current value of the radius dragged, are displayed in the map.
(Figure 9.6) If the mouse is released, the circular zone will be drawn (Figure 9.7), and the diameter value in the text field
is updated.

* “Hand brush’ button: resets all text fields to 0.0 while in ’text field editing” mode

* ’Refresh’ button: synchronizes the text fields with the drawing in the map (i.e. applies changes made in ’text field editing’
mode)

If the zone type has been set to "Polygon’ in the header panel, the ’Circular’ subpanel is disabled.

Zone Definition

Header
Circular
i
r
Palygon

Figure 9.6: Creating a circular zone in ’graphical editing’ mode.
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Zone Definition

Header
Circular
&
&
Palygon

Figure 9.7: Circular zone created in ’graphical editing” mode.

* Polygon: If the zone type has been set to "Polygon’ in the header panel, the specification for a polygon zone is defined in this
subpanel. A zone polygon is defined by its points (latitude/longitude) which are set in the Point List. New points (0.0, 0.0) can
be added with the ’+’ button or in the graphical editing mode (as further explained below). Points can be edited by clicking
into the specific table cell. (Note that you have to click once again into another, arbitrary table cell to complete cell editing and
apply the changed value.)

The following functionalities are provided by buttons:

’Paint brush’ button: A toggle button (like for the zoom tool). If activated, the ’graphical editing’ mode is invoked. In this
mode, the zone database dialog is set to "'unmodal’, and you can create a polygon in the map with the mouse, indicated by a
crosshair symbol. (To avoid bringing the application into a weird state while editing in this mode, all other components of
the zone database editor (except help/close buttons) as well as of the map settings frame are disabled). - Clicking in the map
will create a new point and add it to the polygon point list, which is automatically updated. - An existing point can be moved
by clicking into its square symbol and dragging it with the mouse button kept pressed. The point is continuously updated in
the point list. - To delete an existing point, you have to leave the graphical mode (click toggle button) and to remove it from
the point list Cminus’ button). For convenience, the point indices in the table are also displayed in the map (Figure 9.8).

— ’Circular’button: flip point list while in ’tabular editing’ mode. It reverses the order of the zone points list to define the
interior of a given zone instead of the exterior (or the other way around)

— ’Plus’ and "Pinus’ button: add/remove points from the list while in ’tabular editing” mode.
— ’Hand brush’ button: remove all points from the list while in "tabular editing’ mode
— ’Refresh’ button: synchronizes the point list table with the drawing in the map (i.e. applies changes made in ’tabular editing’

mode)

If the zone type has been set to ’Circular’ in the header panel, the ’Polygon’ subpanel is disabled.
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Figure 9.8: Polygon zone created in ’graphical editing’ mode.

9.2.4 Editor Elements

Underneath the Zone List and the Zone Definition Panel, there are several elements which allow the user to control the editing of
zones (Figure 9.10, Figure 9.11):

Button ’Insert New Zone’: This button is enabled if the Zone Definition Panel is disabled (i.e., no zone is currently edited).
Clicking this button disables the button itself and enables the Zone Definition Panel to specify the new zone.

Button 'Delete Selected Zone’: This button is enabled if a table row in the Zone List is selected and the Zone Definition Panel is
disabled (i.e., no zone is currently edited). If this button is clicked, a confirmation dialog *Deleting zone’ appears (Figure 9.9),
asking if this zone shall really be deleted from the user database. If *Yes’ is clicked, the zone is removed from the Zone List.

Button "Edit Selected Zone’: This button is enabled if a table row in the Zone List is selected and the Zone Definition Panel is
disabled (i.e., no zone is currently edited). If this button is clicked, the 'Insert...’, "Delete...” and "Edit...” buttons are disabled,
and the Zone Definition Panel together with the remaining editor elements (see below) are enabled.

Button *Clear Zone Fields’: This button is enabled together with the Zone Definition Panel. If this button is clicked, the Zone
Definition Panel is cleared:

The text fields in the Header subpanel are set blank.

The zone type is set to "Polygon’.

The ’Circular’ subpanel is disabled, the values in its text fields are set to 0.0.

The Polygon Point List is enables and contains a point (0.0, 0.0) as only entry.

Button ’Save Zone Changes’: This button is enabled together with the Zone Definition Panel. If this button is clicked, a
validation of the entries in the Zone Definition Panel will be performed (see below). If the validation is successful, the zone
definition will be saved:
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— The Zone Definition Panel together with the editor elements below it will be disabled .

— The Zone List and the 'Insert New Zone’ button will be enabled.

— None of the zones in the Zone List is selected, the *Delete Selected Zone’ button and the Edit Selected Zone’ button remain
disabled.

* Button ’Cancel Zone Changes’: This button is enabled together with the Zone Definition Panel. If this button is clicked, the
changes in the zone definition made after the last "Insert New Zone’ or ’Delete Selected Zone’ are discarded. The panels and
their elements are set back to the state just before 'Insert New Zone’ or ’Delete Selected Zone’ was clicked.

Deleting Zone

9
\-“J-j Do you really wank to delete the Zone "occ"y

Figure 9.9: Delete Zone Confirmation Dialog

[+ ) =][=]

Figure 9.10: Buttons ’Insert New Zone’, ’Delete Selected Zone’ and ’Edit Selected Zone’ (from left to right)

(& (& ]

Figure 9.11: Buttons ’Clear Zone Fields’, ’Save Zone Changes’ and ’Cancel Zone Changes’ (from left to right)

9.2.5 Zone Validation

Before the definition for a new or an edited zone is saved, a validation of the input values is performed. The following rules are
checked:

* The Zone ID string must not be empty.

* The Zone ID must be unique with regard to the current user database and the system-defined stations.
* The Zone Description string must not be empty.

* The Center Longitude, Center Latitude and Diameter for a circular zone must not be empty.

* All Latitudes/Longitudes must have number format.

* All Longitudes must be in range [-180.0, 180.0].

 All Latitudes must be in range [-90.0, 90.0].

* The Diameter for a circular zone must have number format.

* The Diameter for a circular zone must be in range (0.0, 10000.0].

* A polygon zone must be formed by at least 3 points.

* A polygon zone must not be self-intersecting.
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Figure 9.12 to Figure 9.19 show several examples for the violation of the rules listed above. In each case, a Validation Dialog
appears after the button *Save Zone Changes’ was clicked, and the relevant input fields are highlighted in red. (Note that in case
of an invalid point in the polygon list, a special ’Invalid Degree Value Dialog’ appears immediately when the user clicks into
another table cell to finish editing. This dialog allows either editing the invalid value, or going back to the last valid value in the
cell.)

Zone Definition

Header

Zone ID: |

Description: |

Surface: |

|
|
Projection: | RECTANGLLAR |
|
|

Creatar: |

Zone Type: () Cireular (%) Palygon

Circular

i

Palygon

Paint List: K] Lon[dedq] Lat[deq]

Figure 9.12: Invalid zone definition: ID and Description missing, polygon has less than 3 points

Zone Validation Dialog gl

‘alidation Failed For:

--= Polygon needs & Minirmum of 3 Points,
--= Mo Description For the Zone was entered,
-- Mo ID For the Zone was entered,

Figure 9.13: Zone validation dialog

Copyright © 2008 - 2025 ESA



Esov Software User Manual

88/145

Circular

Center Longitude: 500, 000000 [dea]
Cenker Latitude: 0, 000000 [deq]
Diarneter: SO000, 000 [krn]

Figure 9.14: Invalid circular zone definition: Center Longitude and Diameter out of range

Zone Validation Dialog gl

‘alidation Failed For:

--= Value of "Center Longitude' is out of range "[-1580.0,180.07.
--= Value of 'Diameter’ is out of range "[0.1,10000.07.

Figure 9.15: Zone validation dialog

Lat[deq]
500

Figure 9.16: Polygon point invalid (out of range)

Invalid Degree Value gl

@ The edited walue must have degree format and have bo lay bebween -90.0 and 90.0,
‘fou can either continue editing or revert to the last valid value,

Figure 9.17: Invalid degree value dialog
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Palygon
Paink List: Mo Lon[deg] Lat[deq] /
1 0, 000000 0, 000000
2 0, 000000 10,000000 aF
3 10,000000 10,000000 E]
4 10,000000 0, 000000
5 5. 000000 20,000000
|« I 0l E]

Figure 9.18: Invalid polygon (self-intersecting due to the latitude value in point 4)

Zone Validation Dialog gl

‘alidation failed For:

--= The actual Points forms a Polygon with inkersection lines,

Figure 9.19: Zone validation dialog

9.2.6 Button Panel
The buttons in the button panel (Figure 9.20.) give access to further functionalities of the Zone Database Editor.

* With the "Help’ button, the online help for this component is opened.

* If the "Close’ button is clicked, the Zone Database Editor is closed. Its status is kept and will reappear any time the dialog is
reopened.

I Help ] [ Close l

Figure 9.20: Zone Database Editor Button Panel
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Chapter 10

Station Databases

10.1 What is a Station Database?

A station database is basically a xml-formatted file containing relevant information on stations which can be considered for an
Esov scenario. Station databases are divided into

» System-defined station database: In Esov, there is exactly one system-defined station database. The stations in this database
cannot be changed or deleted, nor can new stations be added. They do not contain specific AOS/LOS information, but only a
default elevation value which is, in combination with the station mask, used for the station perimeter computation. The system-
defined station database is also an xml-formatted file, but it is "hidden’ in a jar archive which comes with the application. For
the Esov user, there is no need to access this file directly. The stations stored in this database become visible as ’system-defined’
stations in the *Add stations’ toolwindow. These stations can be copied into a user-defined database (see Section 5.2.6). For
these station copies, the use can define own AOS/LOS parameters (see below).

¢ User-defined station database: In Esov, there is a default user-defined station database (’defaultstations.dbf’) in the Esov
application directory. If not existing, this file is created when Esov is started. Stations in this database can be edited or deleted
with the ESOV Station Database Editor, but, in opposite to Zones, it is not possible to define new stations with Esov. Also,
any other valid station database file can be set as user-defined station database. However, a station database file other than the
default file must have been created externally. It is not possible to create an ’empty’ user-defined station database from Esov.

10.2 Station Database Editor

The ESOV Station Database Editor can be activated by selecting ’Station Database...” in the Edit menu of the main menu bar.
A modal dialog ’Station Database Editor’ appears (Figure 10.1). This window basically allows the user to define a database of
’user-defined’ stations, view the stations, and edit or delete stations.
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ﬂ Station Database Editor - AEOLUS - =unnamed scenario= - Esov NG 2.3
Current Database
® Default User Database

) Other User Database |:|

Station Definition

Station List
D Description Hea.der
GMATERHX_ __ Matera (ITALIA) Station ID: [GMATERHX | |
Description: [Matera (TALIA) |

® AOS/LOS with...
) AOS/LOS

) Mask only

AOS elevation: |0.000000
LOS elevation: |(0.000000

Location

Longitude: |15.421000
Latitude: 10.385200
Altitude: 527.000

[% ]

‘ Help || Close ‘

Figure 10.1: Station Database Editor

10.2.1 Database Selection Panel

In the Database Selection Panel (see Figure 10.2), the user can switch between the default user-defined station database (default
selection when the Station Database Editor is initially opened), and the definition of an ’Other User Database’.

* ’Other User Database’: If this button is selected, a non-editable text field and a ’Select User Database..” button appear
on its right. When this button is clicked, an ’Open Database’ dialog appears. Its current directory is the Esov application
directory. The files available in this folder are database files with the extension *.dbf’. (Note that also station database files
(see Chapter 10) which have the same extension are listed here. If the user accidentally selects a station database instead of a

station database, an error dialog appears that this file could not be read (Figure 10.3)).

Current Database

() Default User Database

() Other User Database | =]

Figure 10.2: Station Database Selection Panel
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@ The file defaultzones. dbf could not be read - wrong Format or nok a station database!

Figure 10.3: Error dialog: Wrong database type

10.2.2 Station List Panel

In the Station List (Figure 10.4), the stations included in the selected user database are listed with their ID and Description. If a
station is selected in this table, it can be changed or deleted (see Section 10.2.4).

Skation List
(] Drescripkion

GIMWIL ¥ VillaFranca (SPAIN) A
Swalbard (PLATABERGET)

GFLUICIME Fucino (ITALY)

GRIRLIME Kiruna (SWEDEM)

GMASPAHY Maspalomas (SPAIN)

GFAIRBHX Fairbanks (ALASKA)

GCOTOPHY Cotopaxi (ECUADOR)

GEATIMEX Gatineau (CAMADA)

GTROMSHE Tromsoe (MORMAY)

GALICEHY, flice Spring (AUSTRALLA)

GHYDERH: Hyderabad (IMNDIA)

=K LIRS R Viraaramke C1AD AR W

(= (=]

Figure 10.4: Station List Panel

10.2.3 Station Definition Panel

In the Station Definition Panel (Figure 10.7), the user can edit existing stations. This panel consists of the following input
elements:

e Text fields for

Station ID (entry required)

Station Description (entry required)

AOS elevation (entry required, default value 0.0 deg.)

LOS elevation (entry required, default value 0.0 deg.)
Altitude (entry required, default value 0.0 km.)

Longitude (entry required, default value 0.0 deg.)

Latitude (entry required, default value 0.0 deg.)

* A radio button panel to select one of the following options for the computation of station perimeters:

Consider AOS/LOS with mask (the default option)
Consider AOS/LOS only

Consider mask only
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Figure 10.5 and Figure 10.6 show an example for station perimeters computed for *AOS/LOS with Mask’ and *Mask only’,
respectively. If mask only is set, the AOS/LOS perimeters are neither considered for swath computation nor drawn in the map.

Figure 10.5: Station Perimeters: Example for setting ’AOS/LOS with Mask’

Figure 10.6: Station Perimeters: Example for setting ’Mask only’
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Station Definition

Header
Station ID: [GMATERHX |
Description: [Matera (TALIA) |

® AOS/LOS with...
) AOS/LOS
) Mask only

AOS elevation: |0.000000
LOS elevation: |(0.000000

Location

Longitude: |15.421000
Latitude: 10.385200
Altitude: 527.000

> [(Ela

Figure 10.7: Station Definition Panel

10.2.4 Editor Elements

Underneath the Station List and the Station Definition Panel, there are several elements which allow the user to control the editing
of stations (Figure 10.9, Figure 10.10):

* Button 'Delete Selected Station’: This button is enabled if a table row in the Station List is selected and the Station Definition
Panel is disabled (i.e., no station is currently edited). If this button is clicked, a confirmation dialog *Deleting station’ appears
(Figure 10.8), asking if this station shall really be deleted from the user database. If *Yes’ is clicked, the station is removed
from the Station List.

¢ Button ’Edit Selected Station’: This button is enabled if a table row in the Station List is selected and the Station Definition
Panel is disabled (i.e., no station is currently edited). If this button is clicked, the "Delete...” and "Edit...” buttons are disabled,
and the Station Definition Panel together with the remaining editor elements (see below) are enabled.

* Button ’Clear Station Fields’: This button is enabled together with the Station Definition Panel. If this button is clicked, the
Station Definition Panel is cleared:

— The text fields *Station ID’ and ’Station Description’ are set blank.
— The radio button AOS/LOS with mask’ is selected.
— The values of AOS and LOS elevation are set to 0.0.

* Button ’Save Station Changes’: This button is enabled together with the Station Definition Panel. If this button is clicked, a
validation of the entries in the Station Definition Panel will be performed (see below). If the validation is successful, the station
definition will be saved:

— The Station Definition Panel together with the editor elements below it will be disabled .
— The Station List will be enabled.

— None of the stations in the Station List is selected, the *Delete Selected Station’ button and the "Edit Selected Station’ button
remain disabled.
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* Button ’Cancel Station Changes’: This button is enabled together with the Station Definition Panel. If this button is clicked,
the changes in the station definition made after the last *Insert New Station’ or 'Delete Selected Station’ are discarded. The
panels and their elements are set back to the state just before 'Insert New Station’ or *Delete Selected Station’ was clicked.

Deleting Station

9
\-“(/ Do you really want bo delete the Station "edzlalalalalala™?

Figure 10.8: Delete Station Confirmation Dialog

(=& ]

Figure 10.9: Buttons ’Delete Selected Station’ and "Edit Selected Station’ (from left to right)

(]  [(=]la&]

Figure 10.10: Buttons *Clear Station Fields’, Save Station Changes’ and ’Cancel Station Changes’ (from left to right)

10.2.5 Station Validation

Before the definition for an edited station is saved, a validation of the input values is performed. The following rules are checked:

* The Station ID string must not be empty.

* The Station ID must be unique with regard to the current user database and the system-defined stations.
 The Station Description string must not be empty.

* The values *AOS elevation’ and "LOS elevation’ must not be empty.

* The values *AOS elevation’ and *LOS elevation’ must have number format.

* The values *AOS elevation’ and *LOS elevation’ must be in the range [0.0,90.0].

* The value of "LOS elevation’ must not be greater than the value of *AOS elevation’.

Figure 10.11 to Figure 10.16 show several examples for the violation of the rules listed above. In each case, a Validation Dialog
appears after the button *Save Station Changes’ was clicked, and the relevant input fields are highlighted in red.

Skation I

Description:

Figure 10.11: Invalid station definition: ID and Description missing
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x]

Station Validation Dialog

‘alidation Failed For:

--= Mo ID For the Skation was entered.
--= Mo Description For the Skation was entered.

Figure 10.12: Station validation dialog

A03 elevation: 100, Qooo00
Li05 elewvation: I:I

Figure 10.13: Invalid AOS/LOS definitions: AOS > 90 deg., LOS empty

Station Validation Dialog gl

‘alidation Failed For:

--= Value of 'LOS elevation' is missing ar has wrong Farmat,
--= Value of "A03 elevation' is out of range "[0.0,90.07.

Figure 10.14: Station validation dialog

#4075 elevation: 10, 000000
Li05 elewvation: 200, Q00000

Figure 10.15: Invalid: LOS > AOS
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x]

Station Validation Dialog

‘alidation Failed For:

--= Value of 'LOS elevation’ rusk not be greater than "A05 elevation',

Figure 10.16: Station validation dialog

10.2.6 Button Panel

The buttons in the button panel (Figure 10.17.) give access to further functionalities of the Station Database Editor.

* With the "Help’ button, the online help for this component is opened.

* If the Close’ button is clicked, the Station Database Editor is closed. Its status is kept and will reappear any time the dialog is
reopened.

I Help ] [ Close ]

Figure 10.17: Station Database Editor Button Panel
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Chapter 11

Data Export/Iimport

11.1 Export of Segments

11.1.1 SCF Export

To save computed segments in a swath control file (SCF)), there is an entry in the File menu: ’Export Segments...” --> *SCE...".
An SCF file can be saved in XML format only. Therefore, if this menu entry is selected, another submenu with the only entry
"XML is opened. If the XML’ entry in this submenu is selected, a directory chooser dialog ’Save Swath Control Files to
Directory’ is opened (Figure 11.1). The selected directory is the Esov application directory. In this dialog, select a directory or
create a new one by clicking the upper right icon ’Create a new folder under the selected folder’. Then click ’Save’. For each
instrument of the current Scenario whose scope is not set to OFF, an SCF file will be written to the selected directory. The name
convention for the file is

¢ ’{instrument_name }.SCF’ (XML format)

If an SCF file already exists under this name, the user will be informed by a confirmation dialog (Figure 11.2). In case you want
to overwrite the existing SCF file, click *OK’.
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== Save Swath Control Files to Directory E]

Recent: |

@28 xa

[#-{25) Morman o
=105 olafd

E} Eigerie Dateien
@ beam

[#-/07) .esovE-20070301
@ Jimagineg50
{07 installj4

@ Jjprofilers

- m2

@ .org.esa.beam.esav
{07 .poseidon

@ albedomap

=105 Anwendungsdaten
B0 clamnwin

®) ATI
@ Blue Marble Geographics
i#{3) Dev-Cpp

RSz e O

l Save l [ Cancel

Confirmation

Figure 11.1: Save SCF Dialog

\?/ SCF File ' \Dokumente und EinstellungeniolafdiAnwendungsdatentEsoy MElscfdiriMERIS, scf' already exists - ovenwritey

Figure 11.2: Save SCF Confirmation Dialog

11.1.2 LLF Export

To save computed segments in a latitude/longitude file (LLF), there is an entry in the File menu: *Export Segments...” --> LLF...".
If this menu entry is selected, another submenu with the entries "XML’, ’CSV’ and *ASCII’ is opened, providing the choice to
save in either XML, CSV or ASCII format. If one of the entries in this submenu entry is selected, a directory chooser dialog
’Save LLF Files to Directory’ is opened (Figure 11.3). The selected directory is the Esov application directory. In this dialog,
select a directory or create a new one by clicking the upper right icon *Create a new folder under the selected folder’. Then click
’Save’. For each instrument of the current Scenario whose scope is not set to OFF, an LLF file will be written to the selected

directory. The name convention for the file is

* ’{instrument_name}.lIf* for XML format

 ’{instrument_name}_LLF.csv’ for CSV format

 ’{instrument_name}_LLF.txt’ for ASC format

If an LLF file already exists under this name, the user will be informed by a confirmation dialog (Figure 11.4). In case you want

to overwrite the existing LLF file, click ’OK’.
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1% Save LLF Files to Directory @

Recent:| v| B5 x2
= oda ~
{jD My Documents
{h beam

[+ .barland

-7 .esovE-20070301
f—]@ Application Data
-7 Adobe
) Adobelm
-7 Arcsoft
E| BearShare
[#-{C5) Canan
E| Cuttermaran
-7 dvdess
E}@ Esov MG
B IFdi
{5 sef

AT sefdir

-1 user_instrument_swath w

[ Save ] [ Zancel

Figure 11.3: Save LLF Dialog

Confirmation gl

\?/ LLF File "C:\Documents and Settingsiodalapplication DatalEsoy MGHIFirMwWRLIF already exists - overvirite?

Figure 11.4: Save LLF Confirmation Dialog

Note that the time step used in the ata export is set through the parameter "Time Step” in User Preferences, Section Section 12.3.

11.1.3 UTF Export

To save computed segments in a UTF file, there is an entry in the File menu: ’Export Segments...” --> UTFE.... If this menu
entry is selected, another submenu with the entries "XML’, ’CSV’ and *ASCII’ is opened, providing the choice to save in either
XML, CSV or ASCII format. If one of the entries in this submenu entry is selected, a directory chooser dialog *Save UTF Files
to Directory’ is opened (Figure 11.5). The selected directory is the Esov application directory. In this dialog, select a directory
or create a new one by clicking the upper right icon ’Create a new folder under the selected folder’. Then click *Save’. For each
instrument of the current Scenario whose scope is not set to OFF, an UTF file will be written to the selected directory. The name
convention for the file is

* ’{instrument_name}.utf’ for XML format
* ’{instrument_name}_UTF.csv’ for CSV format

 ’{instrument_name}_UTFE.txt’ for ASC format
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If an UTF file already exists under this name, the user will be informed by a confirmation dialog (Figure 11.6). In case you want
to overwrite the existing UTF file, click "OK’.

| R
[1-%g2
-5
]
o
0
0
06
]
0
0
0
=

| £

Figure 11.5: Save UTF Dialog

Confirmation

\?/ UITF File ' \Documents and SettingsodalApplication DatatEsoy MEukFdiriMWE, utf already exists - overwrite?

Figure 11.6: Save UTF Confirmation Dialog

11.1.4 KML Export

To save computed segments in a KML file, there is an entry in the File menu: *Export Segments...” -->KML...”. A KML file can
be saved in XML format only. Therefore, if this menu entry is selected, another submenu with the only entry XML’ is opened.
If the "’XML’ entry in this submenu is selected, a directory chooser dialog ’Save KML to Directory’ is opened (Figure 11.7). The
selected directory is the Esov application directory. In this dialog, select a directory or create a new one by clicking the upper
right icon *Create a new folder under the selected folder’. Then click ’Save’. For each instrument of the current Scenario whose
scope is not set to OFF, a KML file will be written to the selected directory. The name convention for the file is

* ’{instrument_name}.KML’ (XML format)

If a KML file already exists under this name, the user will be informed by a confirmation dialog In case you want to overwrite
the existing KML file, click OK”.
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Save KML Files to Directory + X

Recent:‘

MEIEIEIE]

=/

s

o= ] kin

o ] boot
o [ dev

o [ etc
o[ home
o= ]lib

o ] lib54
o ] lost+found
o I media
o= ] mnt
o[ opt
o] proc
o Jroot

o= Jrun

o= ] shin

o= ] selinux
o [ srv
o] sys

1]

¢ Cfmp]

Save || Cancel

Figure 11.7: Save KML Dialog

11.1.5 Importing CSV data to Excel

To import the generated CSV-Files to Excel, please use the following steps:

* Launch the Text Import Wizard (Excel/Data/Get External Data/Import Text file...) every time to be able to select the separation

character.

¢ Select ’semicolon’ as delimiter.

¢ Column style of the 2nd part of UTC time: Format cells as "Custom: hh:mm:ss.000".

11.2 Export of Map Images

11.2.1 PDF Export

To save the current map in a PDF file, there is an entry in the File menu: *Export Image...” --> 'PDF...’. If this menu entry is
selected, a file chooser dialog *Export View to PDF File’ is opened (Figure 11.8). The current directory is the Esov application
directory. In this dialog, type a filename and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and
the PDF is saved in a file with extension ’.PDF’. If this PDF file already exists, you will be informed by a confirmation dialog
(Figure 11.9). In case you want to overwrite the existing PDF file, click "OK’.
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== Export View to PDF File 3
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Figure 11.8: Save PDF File Dialog

Confirmation

\?/I' Graphics file 'C:\Dokumente und Einstellungeniolafditest, PDF' already exists - overwrite?

11.2.2 GIF Export

Figure 11.9: Save PDF File Confirmation Dialog

To save the current map in a GIF file, there is an entry in the File menu: Export Image...” --> *GIF...”. If this menu entry is
selected, a file chooser dialog *Export View to GIF File’ is opened (Figure 11.10). The current directory is the Esov application
directory. In this dialog, type a filename and click ’Save’. If this file does not already exist, the *Save’ dialog disappears, and
the GIF is saved in a file with extension *.GIF’. If this GIF file already exists, you will be informed by a confirmation dialog
(Figure 11.11). In case you want to overwrite the existing GIF file, click *OK’.
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== Export View to GIF File
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\_g/. Graphics Ffile 'C:\Dokumente und EinstellungeniolafdiAmyendungsdateniEsoy MG test, GIF' already exists - overwrite?

Figure 11.10: Save GIF File Dialog

Figure 11.11: Save GIF File Confirmation Dialog

11.2.3 PNG Export

To save the current map in a PNG file, there is an entry in the File menu: "Export Image...” --> PNG...’. If this menu entry is
selected, a file chooser dialog *Export View to PNG File’ is opened (Figure 11.12). The current directory is the Esov application
directory. In this dialog, type a filename and click ’Save’. If this file does not already exist, the *Save’ dialog disappears, and
the PNG is saved in a file with extension ’.png’. If this PNG file already exists, you will be informed by a confirmation dialog
(Figure 11.13). In case you want to overwrite the existing PNG file, click *OK".
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= Export View to PNG File X
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Figure 11.12: Save PNG File Dialog

Confirmation

\:‘p Graphics file "CiiDokumente und EinstellungentolafdlanwendungsdateniEsov NGikest . PNG' already exists - overwrite?

Figure 11.13: Save PNG File Confirmation Dialog

11.3 Import of data files

11.3.1 Shapefiles Import

To import shapefiles into the user defined shapefiles folder, there is an entry in the File menu: *Import ... -->’Shapefile...’. If this
option is is selected, a file chooser dialog *Import shapefile’ is opened. (Figure 11.14). The selected shapefile (.shp extension)
shall be copied to the user shapes directory. This directory is located in the Esov application directory (‘user_shape_files’).
ESOV copies shapefiles that consist at least of:

 *.shp: contains the geometry data
 *.dbf: contains the attribute data
» *.shx: contains the connection between attributes and geometries

 *.prj: contains the projection information of the data
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Import Shapefile 1+ X
Look In: |ﬁ .esovng ‘V| E
I AN_221 CItmp
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Jauxdata [Juser_background_images
JESOVNG_NOTE_009_1_0 files[J user_instrument_swath
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JNewFolder
] SENTINEL3
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File Name: | |
Files of Type: |Shapefile '~

Open || Cancel |

Figure 11.14: Import Shapefile chooser Dialog

11.3.2 Points of Interest Files Import

To import files specifiying points of interest, there is an entry in the File menu: "Import ... --> ’Point of Interest...”. If this option
is is selected, a file chooser dialog *Import shapefile’ is opened. (Figure 11.15). The selected file (.csv extension) shall be a
Comma separated values format where each line shall have three entries:

* longitude: the longitude of the point (degrees)
* latitude: the latitude of the point (degrees)

* label: a text to identify the point

Load POIs + X
Look In: |ﬁ .esovng ‘V| E
[CJ SENTINEL3 [Juser _shape files
CIshp
CJtmp [y 55P.csv

1 0 files[Juganda
[Juser background images
[Juser_instrument_swath

< | I IC

File Name: |F'Ol.csv |

Files of Type: |POI5 |'|
Open | | Cancel |

Figure 11.15: Import Points of Interest chooser Dialog
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11.3.3 Sub Satellite Points File Import

To import files specifiying sub-satellite points to display, there is an entry in the File menu: *Import ...” -->’Sub-Satellite Point...".
If this option is is selected, a file chooser dialog 'Load SSPs’ is opened. (Figure 11.16). The selected file (.csv extension) shall
be a list of UTC times in the format YYYY-MM-DDTHH:MM:SS one in each line.

To visualise the imported file follow the next two steps:

* Make sure that the orbit / time interval in the orbit tool window contains the UTC times in the Sub-Satellite Points File

¢ Tick the SSP checkbox in the the ’SSP’ tool window

= Load SSPs + X
Look In: |ﬁ .esovng ‘v| E
[J SENTINEL3 [Juser_shape_files
[Jshp [}y POlL.csv

S tmp

1_0 files[Juganda
[Juser_background_images

[Juser_instrument_swath

4] | Il [»
File Name: [ssP.csv |
Files of Type: |SSP5 |v|

Open | | Cancel |

Figure 11.16: Sub-Satellite Points File chooser Dialog
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Chapter 12

User Preferences

The User Preferences Dialog (Figure 12.1) is the GUI component in which user preferences can be set.

@ Set User Prefe
Scenario File Settings

] Store spatial segment coordinates in scenario file

Swath Export Settings
[] Calculate intermediate points in exported files

Time Step (seconds):
Zoom Settings

[] Display crosshair cursor

0K Cancel

Figure 12.1: User Preferences Dialog

12.1 Toolbar Elements

In the User Preferences Dialog Toolbar the user can find as only element:
 Help Button: Invokes the Online Help for this toolwindow.

Note that no *Apply’ icon is provided here since relevant changes related to this toolwindow are applied if the ’OK’ button is
clicked.

12.2 Scenario File Settings

The Scenario File Settings panel has as only element:
* Checkbox: ’Store spatial segment coordinates in scenario file’

If this checkbox is selected, spatial segment coordinates will be stored additionally to the time segments in a scenario file (see
Section 5.4). There will be as many spatial coordinates stored as ’Points per orbit’ are set in the Orbit Settings panel.
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12.3 Swath Export Settings

The Swath Export Settings panel has as elements:

* Checkbox: ’Calculate intermediate points in exported files’. If this checkbox is selected, intermediate swath coordinates will
be computed according to a user-defined time step (set in the text field below). These intermediate coordinates are written only
into an ’enhanced’ LLF file and do not appear in the current scenario.

 Text field: *Time Step (seconds)’ Set the user-defined time step here.

12.4 Zoom Settings

The Zoom Settings panel has one element:

* Checkbox: 'Display crosshair cursor’. If this checkbox is selected, zooming will utilize a crosshair cursor (Figure 12.2) giving
visual feedback of what will be contained in a map when a zoom operation has been completed. As zoom in the azimuthal and
gnomonic projection follows latitude/longitude boundaries, this can help determining where to start zooming.

Figure 12.2: Zoom with crosshair cursor: purple lines are the crosshair cursor
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Chapter 13

An Example for a’Common Use Case’

The following section shall illustrate the use of Esov for a ’common use case’ which in this way is needed very often.

Suppose you want to set up a scenario as defined in the following steps. For each step, the distinct user action to be performed
will be given. The actions are described in brief here, they can be looked up in detail in the relevant sections of this manual if
needed.

¢ Swaths of the instruments "MERIS’ and *ATSR_N’ onboard the ENVISAT spacecraft shall be investigated.
--> Start Esov. Select "New scenario’. Select ’'ENVISAT’.

* Regions of interest are the zone *Africa’ and the area of station *Gatineau’.
--> In the *Add Zones’ dialog , add zone ’Africa’ to the scenario. In the *Add Stations’ dialog , add station ’Gatineau’ to the
scenario.

* For ATSR_N, you are only interested in swaths relevant for *Gatineau’.

--> In the Instruments Toolwindow, set the scope of instrument *ATSR_N’ to ’STATION’.

» For MERIS, you want to look at swaths over Africa.
--> In the Instruments Toolwindow, set the scope of instrument "MERIS’ to ’ZONE’.

* You want to consider just the first 10 orbits of the first orbit change, starting on 2000-01-01. Then you want to compute the
swaths.

--> In the Orbit Settings Toolwindow, set the number of orbits to 10. Click *Apply’.

* You would like a doubled resolution of the latitude/longutide grid lines.
--> In the Layer Manager, select the node *Grid’. With the Grid Style Editor in the Style Toolwindow, set the resolution to 15
deg.

* You would like the zone polygon to be shown as dashed line.

--> In the Layer Manager, select the node *Zones’. With the Zone Editor in the Style Toolwindow, set the style to "Dashed’.

* You would like to see the station label. You prefer triangular station symbols.
--> In the Layer Manager, select the node ’Stations’. With the Station Editor in the Style Toolwindow, set ’Style’ to *Triangular’
and 'Label’ to *Yes’.

* You would like to have a filled station perimeter with an opacity of 20 percent.
--> In the Layer Manager, select the node ’Station Perimeters’. With the Station Perimeter Editor in the Style Toolwindow, set
’Opacity’ to 20 percent and "Filled’ to " Yes’.

* You want to know which orbit numbers belong to the computed segments.

--> In the Orbit Settings Toolwindow, set checkbox *Show Orbit Numbers’. Click *Apply’.
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* You do not want to see the full ENVISAT orbit in the map.
--> In the Layer Manager, set the visibility of ORBIT to OFF.

* You want to have a closer look to the regions of interest.

--> With the Zoom Tool, perform a ’Drag’ zoom which just includes all the swaths displayed.

* You are especially interested in the ATSR_N swath within orbit *10’, and the MERIS swaths within orbits ’1” and *7’. There-
fore, you want to give them individual styles:
— ATSR_N: Opacity 60 percent, Color *’Cyan’ (OOFFFF), and the swath area shown as *Solid’.
— MERIS: Opacity 80 percent, Color "Magenta’ (FFOOFF), and the swath area shown as ’Solid’.
--> In the Instruments Tree of the Layer Manager, select ’ATSR_N’. In the Segments Toolwindow, select the swath with start
orbit *10’. With the Swath Style Editor in the Style Toolwindow, set ’Opacity’ to 60 percent, Color to ’00FFFF’ and ’Style’ to
’Solid’. The do the equivalent steps for MERIS.

* For a better orientation, you want to see the background image.

--> In the Geographical Layers Tree of the Layer Manager, set the visibility of "Background’ to ’ON’.

Now your application frame and your map should look about like in Figure 13.1. This is a result you may want to show around
and to be able to continue work with at a later time. Therefore, you want to save your data:

* You want to print this nice map.

--> In the "File’ menu, select "Print...” and do the printing.

* You want to save the map as GIF file.

--> In the "File’ menu, select "Export Image...” -->"GIF...” and save the file at a desired location.

¢ You want to save the swath data in an SCF file.

--> In the ’File’ menu, select "Export Segments...” -->"SCF..."” and save the file at a desired location.

¢ You want to save the whole scenario.

--> In the ’File’ menu, select Save As...” and save the scenario at a desired location.
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Figure 13.1: ’Common Use Case’ scenario. See text for details.
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Chapter 14

Application Layout

14.1 Toolwindow Arrangement

Esov offers a highly flexible layout arrangement (i.e., positioning and appearance of toolwindows), which is provided by the
JIDE Docking Framework. In general, this allows the user to perform operations like

* Open and close distinct toolwindows
» Show and hide distinct toolwindows

¢ Dock and undock (’float’) toolwindows

These operations with toolwindows are based on different modes a window can have. This is explained in more detail in the
following subsections.

14.1.1 Toolwindow Modes

A toolwindow can have one of the following modes:

e ’Autohide’
e 'Docked’
e ’Floated’

¢ ’Closed’

14.1.1.1 Autohide Mode

In ’Autohide’ mode, the toolwindow is hidden in general (shown as a tab on the main frame edge only), but shown if the mouse
is moved onto the distinct tab. It will stay visible as long as the mouse cursor remains on the tab or is moved into the window
itself.

Figure 14.1 shows the toolwindows ’Style’ and ’LayerManager’ in autohide mode on the left edge of the main frame. In
Figure 14.2, the Layer Manager is shown in this mode after the mouse was moved onto the distinct tab.
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Figure 14.1: Toolwindows in Autohide mode on left main frame edge.
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Figure 14.2: Layer Manager Toolwindow shown in Autohide mode.

The title bar of a toolwindow which is displayed in autohide mode contains of three buttons (Figure 14.3):

¢ ’Hide active auto-hide window’ (left): If clicked, the toolwindow will be hidden.
* *Toggle auto-hide’ (middle): If clicked, the toolwindow will be set into docked’ mode.

* ’Close’ (right): If clicked, the toolwindow will be set into ’closed’ mode and closed.

Figure 14.3: Title bar buttons of a toolwindow shown in autohide mode.

14.1.1.2 Docked Mode

In *Docked’ mode, the toolwindow is connected with a distinct edge of the main frame. It is always visible as long as the mode
is not changed.

In Figure 14.4, the Layer Manager is shown in docked mode on the left edge of the main frame.
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Figure 14.4: Layer Manager Toolwindow shown in docked mode.

The title bar of a toolwindow which is displayed in docked mode contains of three buttons (Figure 14.5):

* "Toggle floating’ (left): If clicked, the toolwindow will be set into *floating’” mode.
* *Toggle auto-hide’ (middle): If clicked, the toolwindow will be set into auto-hide’ mode.

* ’"Close’ (right): If clicked, the toolwindow will be set into ’closed’ mode and closed.

Figure 14.5: Title bar buttons of a toolwindow shown in docked mode.

14.1.1.3 Floating Mode

In Floating’ mode, the toolwindow is ’free’ and not connected to the main frame. A floated toolwindow can be docked to the
main frame by clicking its upper edge and moving it (with mouse key kept pressed) to one of the edges of the main frame. To
avoid accidental docking which is not desired, hold the *Ctrl” key pressed while moving the window. The docking mechanism is
then suppressed. The toolwindow is always visible as long as the mode is not changed.

In Figure 14.6, the Layer Manager is shown in floating mode overlaying the main frame.
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Figure 14.6: Layer Manager Toolwindow shown in floating mode.

The title bar of a toolwindow which is displayed in floating mode contains of three buttons (Figure 14.7):
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* ’Toggle floating” (left): If clicked, the toolwindow will be set into *docked’ mode.

* ’Close’ (right): If clicked, the toolwindow will be set into ’closed’ mode and closed.
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o= @ UserShapes

suawbas (g

MaAQ depy (Ee

Figure 14.7: Title bar buttons of a toolwindow shown in floating mode.

14.1.1.4 Closed Mode

In *Closed’ mode, the toolwindow is not visible at all. It can be reopened by selecting the corresponding entry in the *Windows’
menu in the main menu bar or typing the related shortcut letter. The mode of a reopened window will be the same as it was when

being closed.

14.2 Loading and saving Layouts

The overall state of the toolwindows is referred as Layout’. Distinct layouts can be saved and reloeaded. Also, a default layout
is provided which comes with a new Esov installation and can be reset any time. The corresponding layout operations can be
invoked from the "Windows’ menu in the main menu bar.

14.2.1 Default Layout

When the installation has been installed and started the first time, the layout after creating a new (default) scenario looks as
in Figure 14.8. The ’Layer Manager’ and the ’Instruments’ toolwindows are shown in docked mode on the left edge of the
main frame, all other toolwindows are located in ’Autohide’ mode on the right edge of the main frame (see explanation in
Section 14.1.1).

At any time, the application can be reset to this default layout by clicking *Reset Layout’ in the Windows menu.
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Figure 14.8: Esov with default layout

14.2.2 Saving a Layout

To save a layout which has been defined by arranging the toolwindows as desired, click *Save Layout’ in the Windows menu. A
file save dialog ’Save a Layout’ appears (Figure 14.9), showing files with extension ’.layout’. Select the layout you want to save,
and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and the layout is saved in a JIDE layout file with
extension ’.layout’. If this layout file already exists, you will be informed by a confirmation dialog (Figure 14.10). In case you
want to overwrite the existing layout file, click "OK’.
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Figure 14.9: Save layout dialog

Confirmation

3/ Layout file ‘olaf already exists - overwrite?

Figure 14.10: Save layout confirmation dialog

14.2.3 Loading a Layout

To open an existing layout, click 'Load Layout’ in the File menu. A file choose dialog ’Open a Layout’ appears (Figure 14.11),
showing files with extension ’.layout’. Select the layout you want to open, and click ’Open’. The dialog Open a Layout’ is

closed, and the application layout is updated accordingly.
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Figure 14.11: Open scenario dialog

14.3 Look and Feel

Esov also offers the opportunity to choose between different ’Look and Feels’ for the application. To set a different Look and
Feel, select the menu item 'Look and Feel’ in the Windows menu (Figure 14.12). Note that the *Aqua’ Look and Feel is only

available for Mac OS X.
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Figure 14.12: Look and Feel Submenu
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Chapter 15

Help System

15.1 Online Help

Esov gives the user the option to display online help through a separate window (Figure 15.1). The online help is triggered by
the several help buttons in the toolwindows and from the "Help...” entry in the "Help’ menu.

Help in Esov is window sensitive’. This means that when pressing the help button on a toolwindow, the help window opens
with the distinct section on this toolwindow shown. This *window sensitive’ mechanism is also invoked if the *F1’ key is pressed
while the mouse cursor is located in the toolwindow area. Furthermore, links are added to the help documents to easily navigate
through all the help subjects.

£ ESOV NG Software User Manual |Z||E|rg|

P Chapter 1. Introduction

& Esov NG Overview Table of Contents
“o- @ Reader Level

B J Acronyms and Momen 1.1. SCDEE

S # Acronyms 1.2 Fsov NG Overview
Lo Momenclature

"..# bpplicable Documents | | 13- Feader Level
#- (] Software Installation 1.4, Acronyme and Momenclature
[ ] Starting ESCY MG
|| Basic Concepts L4l Acronyms
(£ ] Scenarios 1.4.3. Nomenclature
=4 Maps

...... # Creating a new Map uﬂw
=4 Changing a Map -
© @4 Map Tookwindow 1.1. Scope
% Toolbar Eleme
@ Projection Sel
: @ Map Legend = Thiz document is the software user manual (SUND for the ESOWV NG
(-] Map Toaols software.

# Exporting a Map
“-- 4 Printing a Map
[#- ] Layer Managemenk

2. 7% Fana Makshacae —

< | >

Figure 15.1: Esov Online Help
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15.2 ’About’ Dialog

If the *About...” entry in the Help’ menu is selected, an *About’ dialog appears (Figure 15.2) which shows some general

information about Esov. This includes the version number and relevant links.

esa

ESOV NG Esov NG Version 2.6.2

Visit hitp:/iwww.esa.int

Figure 15.2: > About’ Dialog

This software has been developed under contract to ESA (ESTEC).
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Chapter 16

Stopping Esov

Esov can be exited (stopped) in two ways:

* Click the 'Close’ cross in the upper right of the main frame.

¢ Select the ’Exit’ menu item in the File menu of the main menu bar.

If no scenario has been selected (empty main frame), the application will exit immediately.

If a scenario has been selected, a confirmation dialog (Figure 16.1) will appear. This dialog also contains a drop-down list in
which you have to select if you want to be asked to confirm exit in future, or not to be asked again. After you made your selection,
click ’OK’. Now you are asked to save the current scenario (as described in Section 5.4). After saving (or cancellation of saving),
the application will exit.

b Exit Esov NG?

-
- Always ask For confirmation w

Always ask For confirmation
DD nok ask again

Figure 16.1: Exit confirmation dialog

If you selected *Do not ask again’ in the confirmation dialog, you will not be asked for confirmation in future. If you want to
reactivate the confirmation mechanism in this case, go to the Esov application directory (see Section 2.5.2) on the file system and
remove the file *notAskForExitConfirm’.
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Chapter 17

Updating Esov

17.1 Update Options

The Esov application can be updated to the most recent available version in two ways:

» Update by a version check at startup.

» Update by a version check from an entry in the Help menu of the main menu bar.

17.1.1 Updating when starting Esov

If the application is started, a confirmation dialog *Check for new versions of Esov...” (Figure 17.1) will appear. This dialog also
contains a drop-down list in which you have to select if you want to be asked for this version check in future, or not to be asked
again.

Check for, new versions of ESOV NG... @

b ] Check if & nes version of ESOV NG is available?
\“‘tl/ Always check at startup

Figure 17.1: Esov version check dialog

If you selected Do not ask again’ in the version check dialog, you will not be asked for a version check in future. If you want
to reactivate the version check mechanism in this case, go to the Esov application directory (see Section 2.5.2) on the file system
and remove the file "notAskForCheckForUpdates’.

After clicking OK’ in the version check dialog, the version check is invoked, and an information dialog with a progress bar
appears (Figure 17.2).
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Figure 17.2: Esov updater dialog
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Figure 17.3: Esov update: new version available

If there is a new version available, a confirmation dialog is shown which informs the user about the new version number and asks
if this version shall be downloaded. (Figure 17.3).

If the user decides to download the new version, an information dialog is shown which informs the user about the status of the

current download (Figure 17.4).
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g
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[------------------------- ]

Zancel

Figure 17.4: Esov update: downloading new version

If the download is finished, another confirmation dialog is shown which asks the user if the new version shall be installed right

now. (Figure 17.5).

EIX)

e Updater - Esov NG

Download Finished

The update For Esov MG has been downloaded ko your
compukter,

Do you want ko launch the update installer now?

() Yes, execute the update installer naw

(") Mo, Twill execute the update installer later

Open containing folder

Figure 17.5: Esov update: download finished

If there is no new version available, the version check at startup will result in an information dialog which informs the user that

he is already using the latest version. (Figure 17.6).
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Figure 17.6: Esov update: latest version is used

17.1.2 Updating from Help menu

The update mechanism can also be invoked any time from the "Help’ menu (see Section 4.2.2.5). If the entry *Check for new
Esov versions...” is selected, the version check is invoked in the same way as described in Section 17.1.1

17.1.3 Updating from Help menu

The mission files update can be invoked any time from the "Help’ menu (see Section 4.2.2.5). If the entry *Check for new mission
files...’ is selected, a dialog will appear with the list of mission files to be update (see figure Figure 17.7).

Check for new mission files...

R T

SENTINELE: 0001 {2017-04-04T12:00:00}
SEOSAT: 0001 (2014-06-12T15:00:00)

[ Downioad || cancel |

Figure 17.7: List of missions to be updated.

Clicking in the download button will cause the download/update of the mission listed. If there is no mission to be update, the
dialog of figure Figure 17.8 will appear.

Check for new mission files...

@ The ESOV mission files are up-to-date.

Figure 17.8: List of missions to be updated.

Copyright © 2008 - 2025 ESA



Esov Software User Manual 128 /145

Chapter 18

Hints and Tips

18.1 General EsovNG Tips

One of the main principle the user has to consider when using EsovNG is that

* Esov performs a complete swath recomputation every time the current scenario was changed and the changes are applied
(automatically or manually).

* Esov only performs a map update (refresh) if graphical parameters are changed, toolwindows change their state from docked
to autohide, or the main window is resized.

Therefore, some basic tips to work effectively would be:

* Arrange your layout and Resize the main window to the size you want before doing anything else, i.e. adding lots of layers. If
a priori known, zoom also into the region of interest before you compute swaths. The more layers and the larger the region to
draw, the more time is needed for a map refresh.

* On the other hand, add the background image (if wanted) if everything is done. Map refreshes take more time if the background
image layer is visible.

* To save computation steps, do all your orbit settings at once, then apply.

* To save refresh steps, do all your map settings at once, then apply.
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Chapter 19

Appendix

19.1 Adding a new spacecraft to Esov

The user can easily add a new spacecraft to Esov. The procedure is as follows:

* On the file system, go to the subfolder ’user_instrument_swath’ in the Esov application folder (see section Section 2.5.2 ).
Here, make a copy of the folder "SAT_EXAMPLE" and rename it with the name of the new spacecraft (in capital letters, e.g.
NEWSAT).

* Go to the new subfolder. Rename the IDF file to the name of the new spacecraft (e.g., NEWSAT.idf).

« Edit this IDF file. Change the filename and the spacecraft name accordingly (e.g. to NEWSAT). Also, change the Eecfi_Id
to the ID which has been foreseen for this spacecraft, or to *200’ if no ID has been specified yet. The File_Extension is used
to associate the Swath Definition Files (SDF) to a spacecraft. The orbit parameters in the Default_Settings section need to
be updated according to the new mission.The minimum and maximum number of orbits per day ( fields Min_Orbits_Day and
Max_Orbit_Day) can be translated into minimum and maximum altitude range for the mission, so they need to be updated
consistently with the the repeat cycle and cycle length values.

* In the new IDF file, set all default settings in the ’Spacecraft’ block. Also, add all instruments of the new spacecraft to the
"List_of_Instruments’ or modify the example sensors (see example in Section 19.3.2)

* Add/modify the SDF files for all instruments of the new spacecraft to the new subfolder. The spacecraft name and instrument
names need to be set consistently in all the -files. SDF file format is described in EO CFI SW Data Handling User Manual
[CFI].

* Restart Esov and select ’File --> New’ in the file menu. The new spacecraft will appear in the drop-down list of spacecrafts
and can be selected for a new scenario.

19.2 Command Line Interface

Esov makes available an export functionality through its Command Line Interface. The input to this capability shall be an Esov
scenario file (XML). The output shall be any of the Export Segments formats.

Usage: <esovng_executable> -cli <scenario_file> <format> <output>

Where:

* esovng_executable -> the path to the EsovNG executable in the file system

* scenario_file -> the full path to the scenario file
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* format ->one of: SCF_XML, LLF_XML, LLF_CSV, LLF_ASCIIL, UTF_XML, UTF_CSV, UTF_ASCII, KML_XML, IMG_PDF,
IMG_PS, IMG_GIF, IMG_PNG

* output -> the path to the folder storing the exported files (if format other than IMG_PDF, IMG_PS, IMG_GIF, IMG_PNG) or
the filename including path of the exported image file (if format one of IMG_PDF, IMG_PS, IMG_GIF, IMG_PNG)

The application executable path depends on the Operating System

* Windows: <installation_folder>/esovng.exe (e.g. *C:\Program Files\Esov\esovng.exe’)

* Mac OS X: <installation_folder>/esovng.app/Contents/MacOS/JavaApplicationStub (e.g. */Applications/EsovNG/esovng.app/
Contents/MacOS/JavaApplicationStub’)

* Linux: <installation_folder>/esovng (e.g. ’/home/user/esovng/esovng’)

where <installation_folder> is the folder selected at installation time.

19.3 Examples of standard files used by Esov

19.3.1 Scenario File

The following listing shows an example for a Scenario File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_ File>
<Data_Block>
<Esov_Scenario>
<File_Name>C:\example_scenario.xml</File_Name>
<List_of_Maps count="1">
<Map>
<Name>Map 1</Name>
<Show_Title>true</Show_Title>
<Projection>RECTANGULAR</Projection>
<North_Latitude unit="deg">90.0</North_Latitude>
<South_Latitude unit="deg">-90.0</South_Latitude>
<West_Longitude unit="deg">-180.0</West_Longitude>
<East_Longitude unit="deg">180.0</East_Longitude>
<Center_Longitude unit="deg">0.0</Center_Longitude>
<Center_Latitude unit="deg">90.0</Center_Latitude>
<View_Angle unit="deg">45.0</View_Angle>
<Rotation_Angle unit="deg">0.0</Rotation_Angle>
</Map>
</List_of_Maps>
<List_of_Spacecraft_Settings count="1">
<Spacecraft_Settings>
<Orbit_Settings>
<Spacecraft_Id>ADM</Spacecraft_TId>
<Use_Osf>false</Use_Osf>
<0sf></0sf>
<List_of_Osf_Records count="1">
<Osf_Record>
<Abs_Orbit>1</Abs_Orbit>
<Rel_Orbit>0</Rel_Orbit>
<Cycle_Num>0</Cycle_Num>
<Phase_Num>0</Phase_Num>
<Repeat_Cycle>7</Repeat_Cycle>
<Cycle_Length>109</Cycle_Length>
<M1lst>18.0</Mlst>
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<Mlst_Drift>0.0</Mlst_Drift>
<Anx_Time>0.0</Anx_Time>
<Anx_Longitude unit="deg">0.0</Anx_Longitude>
<Date>2000-01-01T00:00:00</Date>
<Drift_Mode>0</Drift_Mode>
<Inclination>0.0</Inclination>
</0sf_Record>
</List_of_Osf_Records>
<Selected_Osf_Record>0</Selected_Osf_Record>
<Start_Orbit>1</Start_Orbit>
<Num_Orbits>1</Num_Orbits>
<Num_Points_per_Orbit>100</Num_Points_per_ Orbit>
<Show_Orbit_Numbers>false</Show_Orbit_Numbers>
<Visibility>FULL</Visibility>
</Orbit_Settings>
<Instrument_Settings>
<List_of_Instruments count="2">
<Instrument>
<Sensor_Name>ALADIN</Sensor_Name>
<Scope>0OFF</Scope>
<List_of_Segments count="0"/>
</Instrument>
<Instrument>
<Sensor_Name>ORBIT</Sensor_Name>
<Scope>0ON</Scope>
<List_of_Segments count="1">
<Segment>
<Name>#0</Name>
<Instruments_Layer_Style>
<Opacity>100</Opacity>
<Line_Color>FFFFFF</Line_Color>
<Swath_Style>SOLID</Swath_Style>
<Fill_Color>FFFFFF</Fill_Color>
<Fill_Style>HOLLOW</Fill_Style>
</Instruments_Layer_Style>
<List_of_Orbit_Timestamps count="2">
<Orbit_Timestamp>
<Orbit>1</Orbit>
<Seconds>0.0</Seconds>
</Orbit_Timestamp>
<Orbit_Timestamp>
<Orbit>1</Orbit>
<Seconds>54.93686983377237</Seconds>
</Orbit_Timestamp>
</List_of_Orbit_Timestamps>
</Segment>
</List_of_Segments>
</Instrument>
</List_of_Instruments>
</Instrument_Settings>
<Zone_Settings>
<Zones_Layer_Style>
<Opacity>1.0</Opacity>
<Zone_Color>FF0000</Zone_Color>
<Zone_Style>SOLID</Zone_Style>
</Zones_Layer_Style>
<Zones_Filled>false</Zones_Filled>
<List_of_Zones count="0"/>
</Zone_Settings>
<Station_Settings>
<Stations_Layer_Style>
<Opacity>1.0</Opacity>
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<Station_Color>FF00FF</Station_Color>
<Station_Style>CIRCULAR</Station_Style>
<Station_Symbol_Size>7</Station_Symbol_Size>
</Stations_Layer_Style>
<Stations_Id_Displayed>false</Stations_Id_Displayed>
<Station_Perimeters_Layer_Style>
<Opacity>1.0</Opacity>
<Perimeter Color>FFC800</Perimeter_Color>
<Perimeter_ Style>SOLID</Perimeter_Style>
</Station_Perimeters_Layer_Style>
<List_of_ Stations count="0"/>
</Station_Settings>
</Spacecraft_Settings>
</List_of_Spacecraft_Settings>
</Esov_Scenario>
</Data_Block>
</Earth_Explorer_File>

19.3.2 Satellite Identification File

The following listing shows an example for a Satellite Identification File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://eop-cfi.esa.int/CFI
http://eop-cfi.esa.int/CFI/EE_CFI_SCHEMAS/
EO_OPER_MPIL_ORBSCT_0100.XSD"
xmlns="http://eop-cfi.esa.int/CFI" schemaVersion="1.0">
<Earth_Explorer_ Header>
<Fixed_Header>
<File_Name>ADM.idf</File_Name>
<File_Description>Satellite Identification File
</File_Description>
<Notes></Notes>
<Mission></Mission>
<File_Class></File_Class>
<File_Type></File_Type>
<Validity_Period>
<Validity_Start></Validity_Start>
<Validity_Stop></Validity_Stop>
</Validity_Period>
<File_Version>1.0</File_Version>
<Source>
<System></System>
<Creator></Creator>
<Creator_Version></Creator_Version>
<Creation_Date></Creation_Date>
</Source>
</Fixed_Header>
<Variable_Header></Variable_Header>
</Earth_Explorer_Header>
<Data_Block type="xml">
<Idf>
<Spacecraft>
<Name>ADM< /Name>
<Eecfi_Id>51</Eecfi_Id>
<File_Extension>.ADM</File_Extension>
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<Min_Orbits_Day>15.47</Min_Orbits_Day>
<Max_Orbits_Day>15.67</Max_Orbits_Day>
<Uses_DRS>false</Uses_DRS>
<Default_Settings>
<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<ANX_TLongitude unit="deg">0.0</ANX_ Longitude>
<Date>2000-01-01T00:00:00</Date>

<Absolute_Reference_Orbit>1</Absolute_Reference_Orbit>

</Default_Settings>
<List_of_Instruments count="2">
<Instrument>
<Name>ORBIT</Name>
<Display_Name>Orbit</Display_Name>
<Swath_Type>POINT</Swath_Type>
<Appearance>
<Colour>FFFFFF</Colour>
<Draw>SOLID</Draw>
<Fil1>HOLLOW</Fill>
<Opacity>100</Opacity>
</Appearance>
</Instrument>
<Instrument>
<Name>ALADIN</Name>
<Display_Name>Aladin swath</Display_Name>
<Swath_Type>LINE</Swath_Type>
<Appearance>
<Colour>FF80FF</Colour>
<Draw>SOLID</Draw>
<Fil1>HOLLOW</Fill>
<Opacity>100</Opacity>
</Appearance>
</Instrument>
</List_of_Instruments>
</Spacecraft>
</Idf>
</Data_Block>
</Earth_Explorer_File>

19.3.3 Swath Control File

The following listing shows an example for a Swath Control File:

<?xml version = "1.0" encoding = "UTF-8"?>

<Earth_Explorer_File xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi: ¢
schemaLocation="http://eop-cfi.esa.int/esov http://eop-cfi.esa.int/esov/ <

ESOVNG_SCHEMAS/EO_ESOVNG_SCF_0100.XSD" xmlns="http://eop-cfi.esa.int/esov"

schemaVersion="1.0">
<Earth_Explorer_Header>
<Fixed_Header>
<File_ Name>ALADIN.scf</File_Name>

<File_Description>Swath Control File</File_Description>

<Notes>...</Notes>
<Mission>AEOLUS</Mission>
<File_Class>TEST</File_Class>
<File_Type>ESOVNG_SCF</File_Type>

<+
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<Validity_Period>
<Validity_Start>UTC=2000-01-01T18:00:02</Validity_Start>
<Validity_Stop>UTC=2000-01-01T21:04:59</Validity_Stop>
</Validity_Period>
<File_Version>0001</File_Version>
<Source>
<System>Esov</System>
<Creator>Esov</Creator>
<Creator_Version>2.2</Creator_Version>
<Creation_Date>UTC=2015-04-17T18:57:49</Creation_Date>
</Source>
</Fixed_Header>
<Variable_ Header>
<Init_Def_Data>
<Orbit>
<Absolute_Orbit>1</Absolute_Orbit>
</0Orbit>
<Cycle>
<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
<ANX_TLongitude unit="deg">0.0</ANX_ Longitude>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<Date>2000-01-01T18:00:02</Date>
</Cycle>
</Init_Def_Data>
</Variable_Header>
</Earth_Explorer_Header>
<Data_Block type="xml">
<Scf>
<Instrument>ALADIN</Instrument>
<List_of_Segments count="1">
<Segment>
<Start>
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ ANX unit="s">0.0</Time_From_ ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>
</Start>
<Stop>
<Absolute_ Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853211009</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>
</Stop>
<Zone>ZEUR___ </Zone>
<Station></Station>
<Geo></Geo>
<Appearance>
<Colour>FF80FF</Colour>
<Draw>SOLID</Draw>
<Fill>SOLID</Fill>
<Opacity>50.0</Opacity>
</Appearance>
</Segment>
</List_of_Segments>
</Scf>
</Data_Block>
</Earth_Explorer_File>
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19.3.4 Swath Definition File

SDF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.5 Orbit Scenario File

OSF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.6 Predicted Orbit File (POF)

POF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.7 Restituted Orbit File (ROF)

ROF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.8 Zone Database File

Zone database file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.9 Station Database File

Station DB file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.10 Zone List File

The following listing shows an example for a Zone List File:

<?xml version = "1.0" encoding = "UTF-8"7?>
<Earth_Explorer_File>
<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>C:\myzonelist.z1f</File_Name>
<File_Description>Zones List File</File_Description>
<Notes></Notes>
<Mission></Mission>
<File_Class></File_Class>
<File_Type></File_Type>
<Validity_Period>
<Validity_Start></Validity_Start>
<Validity_Stop></Validity_Stop>
</Validity_Period>
<File_Version>1.0</File_Version>
<Source>
<System></System>
<Creator></Creator>
<Creator_Version></Creator_Version>
<Creation_Date></Creation_Date>
</Source>
</Fixed_Header>
<Variable_ Header></Variable_ Header>
</Barth_Explorer_Header>
<Appearance>
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<Opacity>100</Opacity>
<Zone_Color>FF0000</Zone_Color>
<Zone_Style>SOLID</Zone_Style>
</Appearance>
<List_of_ Zones count="2">
<Zone>
<Name>ZAFR____ </Name>
</Zone>
<Zone>
<Name>ZNAM___ </Name>
</Zone>
</List_of_Zones>
</Earth_Explorer_File>

19.3.11 Station List File

The following listing shows an example for a Station List File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File>
<Earth_Explorer_ Header>
<Fixed_Header>
<File_Name>C:\mystationlist.slf</File_Name>
<File_Description>Stations List File</File_Description>
<Notes></Notes>
<Mission></Mission>
<File_Class></File_Class>
<File_Type></File_Type>
<Validity_Period>
<Validity_Start></Validity_Start>
<Validity_Stop></Validity_Stop>
</Validity_Period>
<File_Version>1.0</File_Version>
<Source>
<System></System>
<Creator></Creator>
<Creator_Version></Creator_Version>
<Creation_Date></Creation_Date>
</Source>
</Fixed_Header>
<Variable_Header></Variable_Header>
</Earth_Explorer_Header>
<Appearance>
<Station_Opacity>100</Station_Opacity>
<Station_Color>FF00FF</Station_Color>
<Station_Style>CIRCULAR</Station_Style>
<Station_Symbol_Size>7</Station_Symbol_Size>
<Perimeter_Opacity>100</Perimeter_Opacity>
<Perimeter_Color>FFC800</Perimeter_Color>
<Perimeter_Style>SOLID</Perimeter_Style>
</Appearance>
<List_of_Stations count="1">
<Station>
<Name>GHYDERHX</Name>
<Definition_Type>USER_DEFINED</Definition_Type>
<List_of_Spacecrafts count="1">
<Spacecraft>
<Name>ADM</Name>
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<Entry_E1>20.0</Entry_EI1>
<Exit_FE1>10.0</Exit_E1>
<Phys_Mask>MASK_ONLY</Phys_Mask>
</Spacecraft>
</List_of_Spacecrafts>
</Station>
</List_of Stations>
</Earth_Explorer_File>

19.3.12 LLF File

The following listing shows an example for an LLF File (snippet) in XML format:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi: <
schemalLocation="http://eop-cfi.esa.int/esov http://eop-cfi.esa.int/esov/ <«
ESOVNG_SCHEMAS/EO_ESOVNG_LLF_0100.XSD" xmlns="http://eop-cfi.esa.int/esov" <+
schemaVersion="1.0">
<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>ALADIN.1l1lf</File_Name>
<File_Description>LLF File</File_Description>
<Notes>...</Notes>
<Mission>AEOLUS</Mission>
<File_Class>TEST</File_Class>
<File_Type>ESOVNG_LLF</File_Type>
<Validity_Period>
<Validity_Start>UTC=2000-01-01T18:00:02</Validity_Start>
<Validity_Stop>UTC=2000-01-01T21:04:59</Validity_Stop>
</Validity_Period>
<File_Version>0001</File_Version>
<Source>
<System>Esov</System>
<Creator>Esov</Creator>
<Creator_Version>2.2</Creator_Version>
<Creation_Date>UTC=2015-04-17T19:02:17</Creation_Date>
</Source>
</Fixed_Header>
<Variable_Header>
<Init_Def_ Data>
<Orbit>
<Absolute_Orbit>1</Absolute_Orbit>
</Orbit>
<Cycle>
<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
<ANX_Longitude unit="deg">0.0</ANX_Longitude>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<Date>2000-01-01T18:00:02</Date>
</Cycle>
</Init_Def_Data>
</Variable_Header>
</Earth_Explorer_Header>
<Data_Block type="xml">
<L1lf>
<Instrument>ALADIN</Instrument>
<List_of_Segments count="1">
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<Segment>
<Start>
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ANX unit="s">0.000000</Time_From_ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>
<Long unit="deg">2.286361</Long>
<Lat unit="deg">0.427925</Lat>
</Swath_Pt>
<Swath_Pt>
<Long unit="deg">2.387212</Long>
<Lat unit="deg">0.446796</Lat>
</Swath_Pt>
<Swath_Pt>
<Long unit="deg">2.488678</Long>
<Lat unit="deg">0.465782</Lat>
</Swath_Pt>
</List_of_ Swath_ Pts>
</Start>
<Stop>
<Absolute_Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853</Time_From_ ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>
<Long unit="deg">-43.952172</Long>
<Lat unit="deg">0.427925</Lat>
</Swath_Pt>
<Swath_Pt>
<Long unit="deg">-43.851320</Long>
<Lat unit="deg">0.446796</Lat>
</Swath_Pt>
<Swath_Pt>
<Long unit="deg">-43.749855</Long>
<Lat unit="deg">0.465782</Lat>
</Swath_Pt>
</List_of_Swath_Pts>
</Stop>
<Station></Station>
<Zone>GHAWAIHX</Zone>
<GEO></GEO>
<Time_Step unit="s">11097.247706</Time_Step>
<List_of_Points count="2">
<Point index="0">
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ANX unit="s">0.000000</Time_From_ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>
<Long unit="deg">2.286361</Long>
<Lat unit="deg">0.427925</Lat>
</Swath_Pt>
<Swath_Pt>
<Long unit="deg">2.387212</Long>
<Lat unit="deg">0.446796</Lat>
</Swath_Pt>
<Swath_Pt>
<Long unit="deg">2.488678</Long>
<Lat unit="deg">0.465782</Lat>
</Swath_Pt>
</List_of_Swath_Pts>
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</Point>
<Point index="1">

<Absolute_Orbit>2</Absolute_Orbit>

<Time_From_ANX unit="s">5548.623853</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>

<List_of_Swath_Pts count="3">
<Swath_Pt>

<Long unit="deg">-43.952172</Long>

<Lat unit="deg">0.427925</Lat>
</Swath_Pt>
<Swath_ Pt>

<Long unit="deg">-43.851320</Long>

<Lat unit="deg">0.446796</Lat>
</Swath_Pt>
<Swath_Pt>

<Long unit="deg">-43.749855</Long>

<Lat unit="deg">0.465782</Lat>
</Swath_Pt>
</List_of_ Swath_Pts>

</Point>
</List_of_ Points>
</Segment>
</List_of_Segments>

</L1f>

</Data_Block>
</Earth_Explorer_File>

The following listing shows an example for an LLF File in CSV format:

Earth_Explorer_ Header

Fixed_Header
File_Name;OLCI.11f
File_Description;LLF File
Notes; ...

Mission; SENTINEL3
File_Class; TEST
File_Type;LLF
File_Version; 0002
Validity_Period

Validity_Start;2000-01-01;22:00:03
Validity_Stop;2000-01-01;23:41:02
Source

System; Esov

Creator;Esov

Creator_Version; 1.5

Creation_Date;UTC=2009-06-17;10:52:

Variable_Header

Orbit

Absolute_Orbit;1

Cycle
Repeat_Cycle;27;unit="day"
Cycle_Length; 385;unit="orbit"
ANX_Longitude;0.0;unit="deg"
MLST;22.0;unit="h"
MLST_Drift;0.0;unit="s/day"
Date;2000-01-01;22:00:03

Instrument; OLCI

09
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Segment

Index;Absolute_Orbit; Time_From_ANX;yyyy-mm-dd; hh:mm:ss.sss;Lon;Lat;Lon;Lat; <+
Lon; Lat; Zone; Station; Geo

0;1;49.952856;2000-01-01;22:00:52.544;-3.552418;2.322534;-0.654124;2.952541; <+

7.450526;4.664833;;;23.8
1;1;79.952856;2000-01-01;22:01:22.544;-3.950477;4.093101;-1.047972;4.725755; <

7.078453;6.421151;;;23.8
2;1;109.952856;2000-01-01;22:01:52.544;-4.352770;5.863304;-1.443202;6.498882; <

6.713059;8.178037;;;23.8
3;1;139.952856;2000-01-01;22:02:22.544;-4.759856;7.633050;-1.840341;8.271840; <

6.353968;9.935392;;;23.8
4;1;169.952856;2000-01-01;22:02:52.544;-5.172320;9.402243;-2.239930;10.044549; <«

6.000827;11.693121;;;23.8
5;1;199.952856;2000-01-01;22:03:22.544;-5.590780;11.170784;-2.642529;11.816924; <+

5.653304;13.451135;;;23.8
6;1;229.952856;2000-01-01;22:03:52.544;-6.015891;12.938570;-3.048723;13.588881; <«

5.311086;15.209347;;;23.8
7;1;259.952856;2000-01-01;22:04:22.544;-6.448351;14.705494;-3.459124;15.360336; <

4.973877;16.967676;;;23.8
8;1;289.952856;2000-01-01;22:04:52.544;-6.888907;16.471445;-3.874379;17.131200; <

4.641397;18.726044;;;23.8
9;1;319.952856;2000-01-01;22:05:22.544;-7.338364;18.236307;-4.295177;18.901386; <«

4.313379;20.484377;;;23.8
10;1;349.952856;2000-01-01;22:05:52.544;-7.797591;19.999956;-4.722251;20.670803; <

3.989569;22.242608;;;23.8
11;1;379.952856;2000-01-01;22:06:22.544;-8.267531;21.762266;-5.156391;22.439357; <

3.669725;24.000669;;;23.8
12;1;409.952856;2000-01-01;22:06:52.544;-8.749212;23.523098;-5.598452;24.206951; <

3.353615;25.758500;;;23.8
13;1;439.952856;2000-01-01;22:07:22.544;-9.243760;25.282308;-6.049361;25.973486; <

3.041015;27.516044;;;23.8
14;1;469.952856;2000-01-01;22:07:52.544;-9.752409;27.039742;-6.510131;27.738855; <

2.731711;29.273247;;;23.8
15;1;499.952856;2000-01-01;22:08:22.544;-10.276521;28.795232;-6.981869;29.502948; <

2.425514;31.030060;;;23.8
16;1;529.952856;2000-01-01;22:08:52.544;-10.817605;30.548598;-7.465807;31.265648; <«

2.122198;32.786438;;;23.8
17;1;559.952856;2000-01-01;22:09:22.544;-11.377336;32.299643;-7.963306;33.026829; <«

1.821563;34.542339;;;23.8
18;1;586.073893;2000-01-01;22:09:48.665;-11.881336;33.822225;-8.408714;34.558948; <«

1.561792;36.070787;;;23.8
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The following listing shows an example for an LLF File in ASCII format:

Earth_Explorer_ Header

File_Name: OLCI.11f
File_Description: LLF File

Mission: SENTINEL3

File_Class: TEST

File_Type: LLF

Validity_Start: 2000-01-01T22:00:03
Validity_Stop: 2000-01-01T23:41:02
File Version: 0002

System: Esov

Creator: Esov

Creator_Version: 1.5

Creation_Date: UTC=2009-06-17T10:52:27
Absolute_Orbit: 1

Repeat_Cycle: 27 [days]
Cycle_Length: 385 [orbits]
ANX_TLongitude: 0.000000 [deg]

MLST: 22.0 [h]

MLST_Drift: 0.0 [s/day]

Date: 2000-01-01T22:00:03

End Earth_Explorer_Header
Data_Block

Instrument: OLCI

1 Number of visibility segments | Number of points per instantaneous <

S o S S S o e o b S o e o 3 o b o o 3e o 3E o 2 o

swath

13

# 2 Index of visibility segment | Orbit number start | Seconds since ANX <
start | UTC time start | {Longitude [deg] Latitude [deg],..} | Orbit <
number stop | Seconds since ANX stop | UTC time stop | {Longitude [deg

] Latitude [deg],...} | Zone | Station | Geo

0 1 +49.952856 20000101_220052544131 -003.552418 +002.322534 -000.654124 <
+002.952541 +007.450526 +004.664833 1 +586.073893 20000101_220948665168 <
-011.881336 +033.822225 -008.408714 +034.558948 +001.561792 +036.070787 <+

23.8

# 3 Time step [s] | Number of intermediate points in visibility segment

+030.000000 19

# 4 Index of intermediate point | Orbit number | Seconds since ANX | UTC <=
time | {Longitude [deg] Latitude [deg],..}

0 1 +49.952856 20000101_220052544131 -003.552418 +002.322534 -000.654124 <
+002.952541 +007.450526 +004.664833

1 1 +79.952856 20000101_220122544131 -003.950477 +004.093101 -001.047972 <+
+004.725755 +007.078453 +006.421151

2 1 +109.952856 20000101_220152544131 -004.352770 +005.863304 -001.443202 <
+006.498882 +006.713059 +008.178037

3 1 +139.952856 20000101_220222544131 -004.759856 +007.633050 -001.840341 <+
+008.271840 +006.353968 +009.935392

4 1 +169.952856 20000101_220252544131 -005.172320 +009.402243 -002.239930 <+
+010.044549 +006.000827 +011.693121

51 +199.952856 20000101_220322544131 -005.590780 +011.170784 -002.642529 <+
+011.816924 +005.653304 +013.451135

6 1 +229.952856 20000101_220352544131 -006.015891 +012.938570 -003.048723 <+
+013.588881 +005.311086 +015.209347

7 1 +259.952856 20000101_220422544131 -006.448351 +014.705494 -003.459124 <+
+015.360336 +004.973877 +016.967676

8 1 +289.952856 20000101_220452544131 -006.888907 +016.471445 -003.874379 <+
+017.131200 +004.641397 +018.726044

9 1 +319.952856 20000101_220522544131 -007.338364 +018.236307 -004.295177 <+
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+018.901386 +004.313379 +020.484377

10 1 +349.952856 20000101_220552544131 -007.797591 +019.999956 -004.722251 <+
+020.670803 +003.989569 +022.242608

11 1 +379.952856 20000101_220622544131 -008.267531 +021.762266 -005.156391 <+
+022.439357 4+003.669725 +024.000669

12 1 +409.952856 20000101_220652544131 -008.749212 +023.523098 -005.598452 <+
+024.206951 +003.353615 +025.758500

13 1 +439.952856 20000101_220722544131 -009.243760 +025.282308 -006.049361 <+
+025.973486 +003.041015 +027.516044

14 1 +469.952856 20000101_220752544131 -009.752409 +027.039742 -006.510131 <+
+027.738855 +002.731711 +029.273247

15 1 +499.952856 20000101_220822544131 -010.276521 +028.795232 -006.981869 <+
+029.502948 +002.425514 +031.030060

16 1 +529.952856 20000101_220852544131 -010.817605 +030.548598 -007.465807 <
+031.265648 +002.122198 +032.786438

17 1 +559.952856 20000101_220922544131 -011.377336 +032.299643 -007.963306 <+
+033.026829 +001.821563 +034.542339

18 1 +586.073893 20000101_220948665168 -011.881336 +033.822225 -008.408714 <+
+034.558948 +001.561792 +036.070787

# End Data_Block

19.3.13 UTF File

The following listing shows an example for an UTF File in XML format:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi: <
schemalLocation="http://eop-cfi.esa.int/esov http://eop-cfi.esa.int/esov/ <
ESOVNG_SCHEMAS/EO_ESOVNG_UTF_0100.XSD" xmlns="http://eop-cfi.esa.int/esov" <«
schemaVersion="1.0">
<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>ALADIN.utf</File_Name>
<File_Description>UTF File</File_Description>
<Notes>...</Notes>
<Mission>AEOLUS</Mission>
<File_Class>TEST</File_Class>
<File_Type>ESOVNG_UTF</File_Type>
<Validity_Period>
<Validity_Start>UTC=2000-01-01T18:00:02</Validity_Start>
<Validity_Stop>UTC=2000-01-01T21:04:59</Validity_Stop>
</Validity_Period>
<File_Version>0001</File_Version>
<Source>
<System>Esov</System>
<Creator>Esov</Creator>
<Creator_Version>2.2</Creator_Version>
<Creation_Date>UTC=2015-04-17T19:02:22</Creation_Date>
</Source>
</Fixed_Header>
<Variable_Header>
<Init_Def Data>
<Orbit>
<Absolute_Orbit>1</Absolute_Orbit>
</Orbit>
<Cycle>
<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
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<ANX_TLongitude unit="deg">0.0</ANX_Longitude>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<Date>2000-01-01T18:00:02</Date>
</Cycle>
</Init_Def_Data>
</Variable_ Header>
</Earth_Explorer_Header>
<Data_Block type="xml">
<Utf>
<Instrument>ALADIN</Instrument>
<List_of_Segments count="1">
<Segment>
<Start>
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From ANX unit="s">0.000000</Time_From ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>
</Start>
<Stop>
<Absolute_Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>
</Stop>
<Station></Station>
<Zone>GHAWAIHX</Zone>
<GEO></GEO>
</Segment>
</List_of_Segments>
</Utf>
</Data_Block>
</Earth_Explorer_File>

The following listing shows an example for an UTF File in CSV format:

Earth_Explorer_Header

Fixed_Header

File_Name;OLCI.utf
File_Description;UTF File

Notes; ...

Mission; SENTINEL3

File_Class; TEST

File_Type; UTF

File_Version; 0001

Validity_Period
Validity_Start;2000-01-01;22:00:03
Validity_Stop;2000-01-01;23:41:02
Source

System; Esov

Creator;Esov

Creator_Version;1.5
Creation_Date;UTC=2009-06-17;10:53:26

Variable_Header

Orbit

Absolute_Orbit;1

Cycle

Repeat_Cycle; 27;unit="day"
Cycle_Length;385;unit="orbit"
ANX_Longitude; 0.0;unit="deg"
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MLST;22.0;unit="h"
MLST_Drift;0.0;unit="s/day"
Date;2000-01-01;22:00:03

Instrument; OLCI

Segment
Name; Absolute_Orbit; Time_From_ ANX;yyyy-mm-dd; hh:mm:ss.sss; Zone; Station; <

Start;1;49.952856;2000-01-01;22:00:52.544;;;23.

Geo

8

Stop;1;586.073893;2000-01-01;22:09:48.665;;;23.8

The following listing shows an example for an UTF File in ASCII format:

S b S S S S e S S S e e S S S S S S o e e S S 9k 3 3

Earth_Explorer_Header

File_Name: OLCI.utf
File_Description: UTF File
Mission: SENTINEL3

File_Class: TEST

File_Type: UTF

Validity_Start: 2000-01-01T22:00:03
Validity_Stop: 2000-01-01T23:41:02
File_Version: 0001

System: Esov

Creator: Esov

Creator_Version: 1.5
Creation_Date: UTC=2009-06-17T10:53:31
Absolute_Orbit: 1

Repeat_Cycle: 27 [days]
Cycle_Length: 385 [orbits]
ANX_Longitude: 0.000000 [deg]
MLST: 22.0 [h]

MLST_Drift: 0.0 [s/day]

Date: 2000-01-01T22:00:03

End Earth_Explorer_Header
Data_Block

Instrument: OLCI

101 Number of visibility segments

102 Index of visibility segment | Orbit number start

ANX start | UTC time start

Orbit number stop | Seconds since ANX stop

Station | Geo

1 +049.952856 20000101_220052544131 1 +586.073893 20000101 <

_ 220948665168 23.8
End Data_Block

19.4 Software used in ESOV-NG

This is a list of the most important 3rd party software used in ESOV-NG.

¢ Java Runtime environment, versions Java8, ORACLE free license

* JAI (Java Advanced Imaging), version 1.1.3, SUN free license

* JIDE Docking Framework Technology, version 3.6.7, JIDE commercial license, purchased by ESA

UTC time stop]|

Seconds since <>

<+
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* Geotools Library, version 28.5, GNU General Public License

e Earth Observation CFI, version 4.29, ESA license

¢ JFreeChart, version 1.5.5, GNU Lesser General Public Licence
¢ Install4], version 11.0.1 (frequently updated), EJ Technologies commercial license, purchased by ESA
e XStream, version 1.4.17, BSD free license

* XPP3, version 1.1.6, Apache free license

¢ Docbook, version 1.73.2, GNU free license

* JUnit, version 4.12, CPL (common public license)

* Apache Maven, version 3.1.1, Apache free license

e iText, version 5.5.13.4, AGPL free license

e JCommon, version 1.0.24, GNU free license

* CommonsLang3, version 3.17.0, Apache free license

* Orekit, version 12.2, Apache free license

* javahelp, version 2.0.05, Apache free license

e Ceres, version 0.9.2-SNAPSHOT, GNU free license

* install4j-runtime, version 11.0.1, GNU free license

e Jai, version 1.1.3, JDL free license

* Jai_imageio, version 1.1.1, BSD free license

e commons-math3, version 3.6.1, Apache free license

Copyright © 2008 - 2025 ESA



	Introduction
	Scope
	Acronyms and Nomenclature
	Acronyms
	Nomenclature

	Applicable Documents
	Reference Documents

	Software Installation
	Usage Requirements
	General Requirements
	Windows 7/8/10
	Mac OS X
	Linux

	How to get the Software
	Esov Installation / Uninstall Process
	Windows 7/8/10 Installation
	Mac OS X Installation
	Linux Installation

	Uninstalling the Installed Software
	Windows 7/8/10 Uninstall
	Mac OS X Uninstall
	Linux Uninstall

	Overview of Files and Folder Structure
	Installation Directory
	Application Directory
	Esov data file types
	Scenario Files
	Satellite Identification Files
	Swath Control Files
	Swath Definition Files
	Orbit Scenario Files
	Predicted/Restituted Orbit Files (POF/ROF)
	Zone Database Files
	Station Database Files
	Zone List Files
	Station List Files
	LLF Files
	UTF Files


	Getting Further Information

	Starting Esov
	Windows XP, Vista, 7, 8, 10
	Starting the Esov executable

	Mac OS X
	Starting the Esov application

	Linux
	Starting the Esov application


	Basic Concepts
	Scenario
	User Interface Overview
	Main Window
	Menus
	File Menu
	Edit Menu
	Tools Menu
	Window Menu
	Help Menu

	Main Toolbar
	Toolwindows
	Maps
	Layers


	Scenarios
	Creating a New Scenario
	Changing a Scenario
	Orbit Toolwindow
	Toolbar Elements
	Orbit Panel ('Use orbit parameters' input mode)
	OSF Selection
	OSF File Selection Panel
	OSF Orbit Settings Panel
	POF/ROF Selection
	POF/ROF File Selection Panel
	TLE Selection
	TLE File Selection Panel
	Info Panel
	Graphical Settings Panel
	Orbit Validation

	Instruments Toolwindow
	Toolbar Elements
	SCF File Selection
	Instrument Scope Selection
	Apply SZA
	Apply SC Eclipse or Apply SC Daylight

	Zones Toolwindow
	Toolbar Elements
	Zone List

	'Add Zones' Dialog
	Toolbar Elements
	Zone List
	Buttons

	Stations Toolwindow
	Toolbar Elements
	Station List

	'Add Stations' Dialog
	Toolbar Elements
	Station List
	Buttons

	Sub-Satellite Point Toolwindow
	Toolbar Elements
	SSP Selection
	SSP Time Selection


	Opening a Scenario
	Saving a Scenario
	Closing a Scenario
	Merging scenarios
	SCF Logical operations
	Shapefile to Zones

	Maps
	Changing a Map
	Map Toolwindow
	Toolbar Elements
	Rectangular Projection
	Azimuthal Projection
	Gnomonic Projection
	Map Settings Validation
	Map Legend Settings Panel

	Map Tools
	Zoom Tool
	Rectangular Projection
	Azimuthal/Gnomonic Projection

	Rotation
	Center
	World Display
	Compute Distance


	Opening Multiple Maps
	Printing a Map

	Layer Management
	The Layer Manager Toolwindow
	Toolbar Elements
	Layer Manager Tree
	Geographical Layers Tree
	Instruments Tree
	User Shapes Tree
	User Background Images Tree


	The Segments Toolwindow
	Segments Table

	The Style Toolwindow
	Toolbar Elements
	Style Editors
	Default Style Editor
	Shoreline Style Editor
	Grid Style Editor
	Zone Style Editor
	Station Style Editor
	Station Perimeter Style Editor
	Swath Style Editor



	Tools
	Azimuth / Elevation 2D Plot
	The Location Selection dialog
	Toolbar Elements
	Location Selection Panel

	The Azimuth / Elevation 2D Plot dialog
	Toolbar Elements
	Graphics Panel
	Navigation Panel
	Segments results table
	Export Segments


	Merging scenarios
	The Scenario Selection dialog
	Toolbar Elements
	Scenario Selection Panel

	The Time Control Toolwindow
	Toolbar Elements
	Time Interval Settings Panel


	SCF Logical Operations
	Shapefile to Zone transformation

	Zone Databases
	What is a Zone Database?
	Zone Database Editor
	Database Selection Panel
	Zone List Panel
	Zone Definition Panel
	Editor Elements
	Zone Validation
	Button Panel


	Station Databases
	What is a Station Database?
	Station Database Editor
	Database Selection Panel
	Station List Panel
	Station Definition Panel
	Editor Elements
	Station Validation
	Button Panel


	Data Export/Import
	Export of Segments
	SCF Export
	LLF Export
	UTF Export
	KML Export
	Importing CSV data to Excel

	Export of Map Images
	PDF Export
	GIF Export
	PNG Export

	Import of data files
	Shapefiles Import
	Points of Interest Files Import
	Sub Satellite Points File Import


	User Preferences
	Toolbar Elements
	Scenario File Settings
	Swath Export Settings
	Zoom Settings

	An Example for a 'Common Use Case'
	Application Layout
	Toolwindow Arrangement
	Toolwindow Modes
	Autohide Mode
	Docked Mode
	Floating Mode
	Closed Mode


	Loading and saving Layouts
	Default Layout
	Saving a Layout
	Loading a Layout

	Look and Feel

	Help System
	Online Help 
	'About' Dialog

	Stopping Esov
	Updating Esov
	Update Options
	Updating when starting Esov
	Updating from Help menu
	Updating from Help menu


	Hints and Tips
	General EsovNG Tips

	Appendix
	Adding a new spacecraft to Esov
	Command Line Interface
	Examples of standard files used by Esov
	Scenario File
	Satellite Identification File
	Swath Control File
	Swath Definition File
	Orbit Scenario File
	Predicted Orbit File (POF)
	Restituted Orbit File (ROF)
	Zone Database File
	Station Database File
	Zone List File
	Station List File
	LLF File
	UTF File

	Software used in ESOV-NG


